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Preface
 This guide describes how to install and configure Tivoli Identity Manager.
 Intended AudienceThis book is intended for system and security administrators who install, maintain,or administer software on their computer systems. Readers are expected tounderstand system and security administration concepts. Additionally, the readermust understand administration concepts for the following types of products:v Database serversv Directory serversv Application servers
 Publications and related informationRead the descriptions of the Tivoli Identity Manager library. To determine whichadditional publications you might find helpful, read the “Prerequisite productpublications” on page ix and the “Related publications” on page x. After youdetermine the publications you need, refer to the instructions in “Accessingpublications online” on page x.
 Tivoli Identity Manager libraryThe publications in the Tivoli Identity Manager technical documentation librarycan be found at the following URL:
 http://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/topic/com.ibm.itim.doc/welcome.htm
 The publications in the Tivoli Identity Manager technical documentation library areorganized into the following categories:v Release informationv Online user assistancev Server installation and configurationv Problem determinationv Technical supplementsv Adapter installation and configuration
 Release Information:
 v Tivoli Identity Manager Quick Start Guide
 Helps you install a base configuration of Tivoli Identity Manager.v Tivoli Identity Manager Information Center
 Provides software and hardware requirements for Tivoli Identity Manager andadditional fix, patch, and other support information. This publication alsoincludes known limitations, problems, and workarounds.
 Online user assistance:
 © Copyright IBM Corp. 2009 vii
 http://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/topic/com.ibm.itim.doc/welcome.htm
 http://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/topic/com.ibm.itim.doc/welcome.htm
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Tivoli Identity Manager Information Center provides online help topics and aninformation center for all Tivoli Identity Manager administrative tasks.
 Server installation and configuration:
 Tivoli Identity Manager Server Installation and Configuration Guide providesinstallation and configuration information for Tivoli Identity Manager.
 Tivoli Identity Manager Express Separate System Upgrade and Data Migration Guideprovides upgrade and data migration information for Tivoli Identity Manager.
 Problem determination:
 Tivoli Identity Manager Problem Determination Guide provides problem determination,and logging information for Tivoli Identity Manager.
 Tivoli Identity Manager Messages Guide provides message information for TivoliIdentity Manager.
 Database and schema information:
 Tivoli Identity Manager Database and Schema Reference describes some of the datastructures used by Tivoli Identity Manager.
 Technical supplements:
 The following technical supplements are provided by developers or by othergroups who are interested in this product:v Redbooks and white papers are available on the Web at:
 http://www.redbooks.ibm.com/v Technotes are available on the Web at:
 http://www.redbooks.ibm.com/redbooks.nsf/tips/v Field guides are available on the Web at:
 http://www.ibm.com/software/sysmgmt/products/support/Field_Guides.htmlv For an extended list of other Tivoli Identity Manager resources, search the
 following IBM developerWorks Web site:http://www.ibm.com/developerworks/
 Adapter installation and configuration:
 The Tivoli Identity Manager Server technical documentation library also includesan evolving set of platform-specific installation documents for the adaptercomponents of an IBM Tivoli Identity Manager implementation.
 Locate adapter documentation on the Web at:
 http://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/topic/com.ibm.itim.doc/welcome.htm
 Performance and tuning:
 IBM Tivoli Identity Manager Performance Tuning Guide provides information to helpyou optimize the use of resources for Tivoli Identity Manager.
 viii IBM Tivoli Identity Manager Server: Installation and Configuration Guide
 http://www.redbooks.ibm.com/
 http://www.redbooks.ibm.com/redbooks.nsf/tips/
 http://www.ibm.com/software/sysmgmt/products/support/Field_Guides.html
 http://www.ibm.com/developerworks/
 http://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/topic/com.ibm.itim.doc/welcome.htm
 http://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/topic/com.ibm.itim.doc/welcome.htm
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Skills and training:
 Additional skills and technical training information might be available at thefollowing Web sites:v IBM Professional Certification at:
 http://www.ibm.com/certify/Search on ″identity manager″ to locate available classes and certificationofferings.
 v Virtual Skills Center for Tivoli Software on the Web at:http://www.cgselearning.com/tivoliskills/
 v Tivoli Education Software Training road maps on the Web at:http://www-01.ibm.com/software/tivoli/education
 v Tivoli Technical Exchange on the Web at:http://www.ibm.com/software/sysmgmt/products/support/supp_tech_exch.html
 Prerequisite product publicationsTo use the information in this book effectively, you must know the products thatare prerequisites for Tivoli Identity Manager. Publications are available from thefollowing locations:v Operating systems
 – AIXhttp://publib.boulder.ibm.com/infocenter/pseries/v5r3/topic/com.ibm.aix.doc/doc/base/aixinformation.htm
 – Sun Solarishttp://docs.sun.com/app/docs/prod/solaris.10
 – Microsoft® Windows Server™ 2003- Support
 http://www.microsoft.com/windowsserver2003/support/default.mspx- Documentation
 http://www.microsoft.com/windowsserver2003/proddoc/default.mspx– Microsoft® Windows Server™ 2008
 - Supporthttp://www.microsoft.com/windowsserver2008/en/us/support.aspx
 - Documentationhttp://www.microsoft.com/windowsserver2008/en/us/product-documentation.aspx
 – Red Hat Linux™
 http://www.redhat.com/docs/– SUSE Linux™
 http://www.novell.com/documentation/suse.htmlv WebSphere Application Server
 – Hardware and software requirementshttp://www.ibm.com/support/docview.wss?rs=180&uid=swg27006921
 – Supporthttp://www.ibm.com/software/webservers/appserv/was/support/
 – Information center
 Preface ix
 http://www.ibm.com/certify/
 http://www.cgselearning.com/tivoliskills/
 http://www-01.ibm.com/software/tivoli/education
 http://www.ibm.com/software/sysmgmt/products/support/supp_tech_exch.html
 http://www.ibm.com/software/sysmgmt/products/support/supp_tech_exch.html
 http://publib.boulder.ibm.com/infocenter/pseries/v5r3/topic/com.ibm.aix.doc/doc/base/aixinformation.htm
 http://publib.boulder.ibm.com/infocenter/pseries/v5r3/topic/com.ibm.aix.doc/doc/base/aixinformation.htm
 http://docs.sun.com/app/docs/prod/solaris.10
 http://www.microsoft.com/windowsserver2003/support/default.mspx
 http://www.microsoft.com/windowsserver2003/proddoc/default.mspx
 http://www.microsoft.com/windowsserver2008/en/us/support.aspx
 http://www.microsoft.com/windowsserver2008/en/us/product-documentation.aspx
 http://www.microsoft.com/windowsserver2008/en/us/product-documentation.aspx
 http://www.redhat.com/docs/
 http://www.novell.com/documentation/suse.html
 http://wwwibm.com/support/docview.wss?rs=180&uid=swg27006921
 http://www.ibm.com/software/webservers/appserv/was/support/
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http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jspv IBM DB2 Database™
 – Support:http://www.ibm.com/software/data/db2/udb/support.html
 – Information center:http://publib.boulder.ibm.com/infocenter/db2help/index.jsp
 – Documentationhttp://www-306.ibm.com/software/data/db2/support/db2_9/http://www.ibm.com/software/data/db2/udb/support/manualsv9.html
 – DB2® product family:http://www.ibm.com/software/data/db2/
 – Fix packs by version:http://www-1.ibm.com/support/docview.wss?rs=71&uid=swg21255572
 – System requirements:http://www.ibm.com/software/data/db2/udb/sysreqs.html
 v IBM Tivoli Directory Server– Support
 http://www.ibm.com/software/sysmgmt/products/support/IBMDirectoryServer.html
 – Information centerhttp://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/topic/com.ibm.IBMDS.doc/welcome.htm
 v IBM Tivoli Directory Integrator– Support
 http://www.ibm.com/software/sysmgmt/products/support/IBMDirectoryIntegrator.html
 – Information centerhttp://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/index.jsp?toc=/com.ibm.IBMDI.doc/toc.xml
 Related publicationsInformation that is related to Tivoli Identity Manager Server is available in thefollowing publications:v The Tivoli Software Library provides various Tivoli publications such as white
 papers, data sheets, demonstrations, Redbooks, and announcement letters. TheTivoli Software Library is available on the Web at:http://www.ibm.com/software/tivoli/literature/
 v The Tivoli Software Glossary includes definitions for many of the technical termsrelated to Tivoli software. The Tivoli Software Glossary is available from theGlossary link of the Tivoli Software Library Web page at:http://publib.boulder.ibm.com/tividd/glossary/tivoliglossarymst.htm
 Accessing publications onlineIBM posts publications for this product and all other Tivoli products, as theybecome available and whenever they are updated, to the Tivoli softwareinformation center Web site. Access the Tivoli software information center at thefollowing Web address:
 x IBM Tivoli Identity Manager Server: Installation and Configuration Guide
 http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp
 http://www.ibm.com/software/data/db2/udb/support.html
 http://www.ibm.com/software/data/db2/support/db2_9/doc.html
 http://www.ibm.com/software/data/db2/support/db2_9/
 http://www.ibm.com/software/data/db2/udb/support/manualsv9.html
 http://www.ibm.com/software/data/db2/
 http://www.ibm.com/support/docview.wss?rs=71&uid=swg21255572
 http://www.ibm.com/software/data/db2/udb/sysreqs.html
 http://www.ibm.com/software/sysmgmt/products/support/IBMDirectoryServer.html
 http://www.ibm.com/software/sysmgmt/products/support/IBMDirectoryServer.html
 http://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/topic/com.ibm.IBMDS.doc/welcome.htm
 http://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/topic/com.ibm.IBMDS.doc/welcome.htm
 http://www.ibm.com/software/sysmgmt/products/support/IBMDirectoryIntegrator.html
 http://www.ibm.com/software/sysmgmt/products/support/IBMDirectoryIntegrator.html
 http://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/index.jsp?toc=/com.ibm.IBMDI.doc/toc.xml
 http://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/index.jsp?toc=/com.ibm.IBMDI.doc/toc.xml
 http://www.ibm.com/software/tivoli/literature/
 http://publib.boulder.ibm.com/tividd/glossary/tivoliglossarymst.htm
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http://publib.boulder.ibm.com/tividd/td/tdprodlist.html
 Click the I character in the A-Z list, and then click the Tivoli Identity Managerlink to access the product library.
 Note: If you print PDF documents on other than letter-sized paper, set the optionin the File → Print window that allows Adobe Reader to print letter-sizedpages on your local paper.
 AccessibilityThe product documentation includes the following features to aid accessibility:v Documentation is available in convertible PDF format to give the maximum
 opportunity for users to apply screen-reader software.v All images in the online documentation are provided with alternative text so
 that users with vision impairments can understand the contents of the images.
 Support for problem solvingIf you have a problem with your IBM software, you want to resolve it quickly. IBMprovides the following ways for you to obtain the support you need:
 OnlineGo to
 the IBM Software Support site at http://www.ibm.com/software/support/probsub.html and follow the instructions.
 IBM Support AssistantThe IBM Support Assistant (ISA) is a free local software serviceabilityworkbench that helps you resolve questions and problems with IBMsoftware products. The ISA provides quick access to support-relatedinformation and serviceability tools for problem determination. To installthe ISA software, go to http://www.ibm.com/software/support/isa.
 Troubleshooting informationFor more information about resolving problems, see Chapter 9, “Verifyingand troubleshooting the installation,” on page 93.
 Conventions used in this bookThis book uses several conventions for highlighting terms and actions and foroperating system-dependent commands and paths.
 Typeface conventionsThis book uses the following typeface conventions:
 Bold
 v Lowercase commands and mixed case commands that are otherwisedifficult to distinguish from surrounding text
 v Interface controls (check boxes, push buttons, radio buttons, spinbuttons, fields, folders, icons, list boxes, items inside list boxes,multicolumn lists, containers, menu choices, menu names, tabs, propertysheets), and labels (such as Tip:)
 v Keywords and parameters in text
 Italic
 Preface xi
 http://publib.boulder.ibm.com/tividd/td/tdprodlist.html
 http://www.ibm.com/software/support/probsub.html
 http://www.ibm.com/software/support/probsub.html
 http://www.ibm.com/software/support/isa
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v Words defined in textv Emphasis of words (words as words)v New terms in text (except in a definition list)v Variables and values that you must provide
 Monospace
 v Examples and code examplesv File names, programming keywords, and other elements that are difficult
 to distinguish from surrounding textv Message text and prompts addressed to the userv Text that the user must typev Values for arguments or command options
 Definitions for HOME and other directory variablesThe following table contains the default definitions that are used in this guide torepresent the HOME directory level for various product installation paths. You cancustomize the installation directory and HOME directory for your specificimplementation. If this is the case, you need to make the appropriate substitutionfor the definition of each variable represented in this table.
 The value of path varies for these operating systems.
 For Windows, the default path is drive:\Program Files.
 For UNIX/Linux, the default path is /opt
 Path Variable Default Definition Description
 DB_HOME Windows:
 path\IBM\SQLLIB
 UNIX/Linux:
 path/ibm/db2/V9.1
 path/ibm/db2/V9.5
 The directory thatcontains the DB2Database for TivoliIdentity Manager.
 DB_INSTANCE_HOME Windows:
 drive:\dbinstancename
 Solaris:
 /export/home/dbinstancename
 Other UNIX/Linux:
 /home/dbinstancename
 The directory thatcontains the DB2instance for TivoliIdentity Manager.
 xii IBM Tivoli Identity Manager Server: Installation and Configuration Guide
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Path Variable Default Definition Description
 ITDS_HOME Windows:
 v Version 6.1
 path\IBM\LDAP\V6.1
 v Version 6.2
 path\IBM\LDAP\V6.2
 UNIX/Linux:
 v Version 6.1
 path/ibm/ldap/V6.1
 v Version 6.2
 path/ibm/ldap/V6.2
 The directory thatcontains the IBMTivoli DirectoryServer code.
 ITDS_INSTANCE_HOME Windows:
 drive:\idsslapd-instance_owner_name
 The value of drive might be C:\ onWindows systems. An example ofinstance_owner_name might be ldapdb2.For example, the log file might beC:\idsslapd-ldapdb2\logs\ibmslapd.log.
 UNIX/Linux:
 /home/instance_owner_name/idsslapd-instance_owner_name
 Solaris:
 /export/home/instance_owner_name/idsslapd-instance_owner_name
 An example of instance_owner_namemight be ldapdb2. For example, the logfile might be /export/home/ldapdb2/idsslapd-ldapdb2/logs/ibmslapd.log
 The directory thatcontains the IBMTivoli DirectoryServer Version 6.0or Version 6.1instance.
 ITDI_HOME Windows:
 v Version 6.1.1
 path\IBM\TDI\V6.1.1
 v Version 7.0
 path\IBM\TDI\V7.0
 UNIX/Linux:
 v Version 6.1.1
 path/IBM/TDI/V6.1.1
 v Version 7.0
 path/IBM/TDI/V7.0
 The directory thatcontains the IBMTivoli DirectoryIntegrator Servercode. Also, whereadapters areinstalled.
 Preface xiii
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Path Variable Default Definition Description
 ITIM_HOME Windows:
 path\IBM\itim
 UNIX/Linux:
 path/IBM/itim
 The base directorythat contains theTivoli IdentityManager code,configuration, anddocumentation.
 TIVOLI_COMMON_DIRECTORY
 Windows:
 path\IBM\tivoli\common
 UNIX/Linux:
 path/IBM/tivoli/common
 The central locationfor allserviceability-related files, suchas logs andfirst-failure capturedata.
 WAS_HOME Windows:
 path\IBM\WebSphere\AppServer
 UNIX/Linux:
 path/IBM/WebSphere/AppServer
 The directory thatcontains theWebSphereApplication Servercode.
 WAS_PROFILE_HOME Windows:
 path\IBM\WebSphere\AppServer\profiles\profile_name
 UNIX/Linux:
 path/IBM/WebSphere/AppServer/profiles/profile_name
 The directory thatcontains theWebSphereApplication Servercustom profile.
 WAS_NDM_PROFILE_HOME
 Windows:
 path\IBM\WebSphere\AppServer\profiles\Dmgr01
 UNIX/Linux:
 path/IBM/WebSphere/AppServer/profiles/Dmgr01
 The directory thatcontains theWebSphereApplication ServerNetworkDeploymentManager profile.
 Operating system differencesThis guide uses the Windows convention for specifying environment variables andfor directory notation.
 When using the UNIX/Linux command line, replace %variable% with $variable forenvironment variables, and replace each backslash (\) with a forward slash (/) indirectory paths. The names of environment variables are not always the same inWindows and UNIX/Linux. For example, %TEMP% in the Windows operatingsystem is equivalent to /tmp in a UNIX/Linux operating system.
 Note: If you are using the bash shell on a Windows system, you can use theUNIX/Linux convention for specifying file path notation.
 xiv IBM Tivoli Identity Manager Server: Installation and Configuration Guide
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Chapter 1. Overview of the Tivoli Identity Managerenvironment
 This book focuses on the tasks that you must complete in order to install andconfigure Tivoli Identity Manager.
 To determine the supported release levels and fix pack specifications for thesupported UNIX, Linux and Windows operating systems, refer to the Tivoli IdentityManager Information Center, which takes precedence over this document.
 Tivoli Identity Manager componentsTivoli Identity Manager provides life cycle management of user accounts onremote resources, using adapters to provide communication. The Tivoli IdentityManager product:v Provides user accounts to authorized users on one or more resources to which
 Tivoli Identity Manager adapters are connectedv Runs in a WebSphere Application Server environment, either in a single-server
 or a cluster configurationv Stores historical and pending data in a database serverv Stores user account and organizational data in an LDAP directory serverv Stores Tivoli Identity Manager information used for auditing and reporting in
 the databasev Provides administration from a client interface in a Web browser that
 communicates through an HTTP server and WebSphere Web Server plug-in or aWebSphere Application Server embedded HTTP transport.
 Tivoli Identity Manager requires the installation and configuration of the followingcomponents:v A database serverv A directory serverv IBM Tivoli Directory Integrator (optional)v WebSphere Application Serverv An HTTP server (optional)v Tivoli Identity Manager Serverv Tivoli Identity Manager adapters
 Database server productsTivoli Identity Manager stores transactional and historical data in a databaseserver. For example, the Tivoli Identity Manager provisioning processes use arelational database to maintain their current state as well as their history.
 Computers that communicate with the database require a Java DatabaseConnectivity driver (JDBC driver). For example, a JDBC driver enables a TivoliIdentity Manager Server to communicate with the data source. Tivoli IdentityManager supports a JDBC type 4 driver to connect a Java-based application to adatabase.
 © Copyright IBM Corp. 2009 1
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The supported database products are IBM DB2 Database, Oracle DB, and MS SQLServer database. The following information is about the type 4 JDBC drivers foreach database product.
 IBM DB2 Database
 DB2 supports a Type 4 JDBC driver. The DB2 type 4 JDBC driver isbundled with the Tivoli Identity Manager installation program.
 Oracle database
 The Oracle database supports a Type 4 JDBC driver. The Tivoli IdentityManager installation program prompts for the location and name of thisJDBC driver.
 Before you install the Tivoli Identity Manager Server, obtain this JDBCdriver from your Oracle Database Server installation in theORACLE_HOME\jdbc\lib\ directory. Alternatively, you can download thedriver from this Web site:
 http://www.oracle.com/technology/software/tech/java/sqlj_jdbc/index.html
 For WebSphere Application Server version 6.1, the JDBC driver isojdbc5.jar.
 Microsoft SQL Server database
 The SQL Server database supports a Type 4 JDBC driver. The TivoliIdentity Manager installation program prompts for the location and nameof this JDBC driver.
 You can download the driver from this Web site:
 http://msdn.microsoft.com/en-us/data/aa937724.aspx
 For more information about supported database server products, refer to the TivoliIdentity Manager Information Center.
 Directory server productsTivoli Identity Manager stores the current state of managed identities in an LDAPdirectory, including user account and organizational data. Tivoli Identity Managersupports the following products:v IBM Tivoli Directory Serverv Sun Enterprise Directory Server
 For more information about supported directory server products, refer to the TivoliIdentity Manager Information Center.
 IBM Tivoli Directory IntegratorIBM Tivoli Directory Integrator is an optional installation component thatsynchronizes identity data residing in different directories, databases, andapplications. IBM Tivoli Directory Integrator synchronizes and managesinformation exchanges between applications or directory sources.
 For more information about IBM Tivoli Directory Integrator, refer to the TivoliIdentity Manager Information Center.
 2 IBM Tivoli Identity Manager Server: Installation and Configuration Guide
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WebSphere Application ServerThe WebSphere Application Server is the primary component of the WebSphereenvironment. The WebSphere Application Server runs a Java™ virtual machine,providing the runtime environment for the enterprise application code. Theapplication server provides containers that specialize in enabling the execution ofspecific Java application components.
 The Tivoli Identity Manager application can run on a single-server configurationwith the WebSphere Application Server base server. Tivoli Identity Manager canalso run in a larger cluster configuration that is composed of one or moreWebSphere Application Servers and a deployment manager that manages thecluster.
 For additional information about the WebSphere Application Server products, referto additional documentation cited in “Prerequisite product publications” on pageix.
 An HTTP server and WebSphere Web Server plug-inAn HTTP server is an optional component that provides administration of TivoliIdentity Manager through a client interface in a Web browser. Tivoli IdentityManager requires the installation of a WebSphere Web Server plug-in with theHTTP server. WebSphere Application Server provides separate installers to installthe IBM HTTP Server and WebSphere Web Server plug-in. You can install thesecomponents either with the WebSphere Application Server or on a separatecomputer.
 Note: If an HTTP server is used, you must use the WebSphere Application ServerAdministrative Console to map the Tivoli Identity Manager applications tothe HTTP Web server name. See Appendix A, “Mapping Tivoli IdentityManager application modules to IBM HTTP Server,” on page 125 for moreinformation about mapping the applications.
 Tivoli Identity Manager ServerThe Tivoli Identity Manager Server and its adapters enable you to provisionidentities to a set of heterogeneous resources, which might be operating systems,data stores, or other applications.
 Tivoli Identity Manager adaptersTivoli Identity Manager adapters enable you to connect the Tivoli Identity ManagerServer to a set of heterogeneous resources, which can be operating systems, datastores, or other applications, in order to provision identities.
 An adapter is a program that provides an interface between a managed resourceand the Tivoli Identity Manager Server. Adapters function as trusted virtualadministrators on the target platform for account management. For example,adapters perform such tasks as creating accounts, suspending accounts, andmodifying account attributes.
 A Tivoli Identity Manager adapter can be either agent-based or agentless:
 Agent-based adapterYou install adapter code directly onto the managed resource with which itis designed to communicate.
 Chapter 1. Overview of the Tivoli Identity Manager environment 3
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Agentless adapterDeploys its adapter code onto the Tivoli Identity Manager Server and thesystem hosting IBM Tivoli Directory Integrator. The adapter code isseparate from the managed resource with which it is designed tocommunicate.
 Note: For agentless adapters, the SSH process or daemon must be active on themanaged resource.
 Configuration optionsBefore you install Tivoli Identity Manager, you must determine how to configureWebSphere Application Server, either in a single-server or a cluster configuration.
 Single-server configurationA single-server configuration contains the WebSphere Application Server baseserver and Tivoli Identity Manager on one computer. Other required applicationscan run on the same computer or a different computer. You must ensure that thecomputer has the required memory, speed, and available disk space to meet theworkload.
 A single-server configuration requires the following components and products:v A database serverv A directory serverv IBM Tivoli Directory Integrator (optional)v WebSphere Application Server base serverv Tivoli Identity Manager Serverv Tivoli Identity Manager adapters
 Cluster configurationA cluster configuration contains WebSphere Application Server nodes, which arelogical groups of one or more application servers on computers. Nodes residewithin an administrative domain called a cell, which the deployment managermanages. A node agent manages all managed processes on the node bycommunicating with the deployment manager to coordinate and synchronize theconfiguration. The deployment manager is the administrative process that providesa centralized management view and control for all elements in the cell, includingthe management of clusters.
 Tivoli Identity Manager assumes that the operating system is the same for eachcluster member.
 For example, all Tivoli Identity Manager cluster members run on the IBM AIXoperating system. To avoid problems with identity feeds, do not use more than oneoperating system type within a Tivoli Identity Manager cluster.
 Tivoli Identity Manager does not support a vertical cluster configuration, whichhas more than one cluster member within a WebSphere Application Server node.
 For example, one cluster configuration might consist of one or more WebSphereApplication Server nodes, each node consisting of one computer, controlled by adeployment manager on a separate server. The remaining applications areconfigured on additional computers.
 4 IBM Tivoli Identity Manager Server: Installation and Configuration Guide
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This task is an example cluster configuration:v On the computer where you want to have the deployment manager, install the
 following components and products:– The WebSphere Application Server deployment manager– A JDBC driver, if required– The Tivoli Identity Manager Server
 v A cluster member is an instance of a WebSphere Application Server in a cluster.On each cluster member, install the following components and products:– WebSphere Application Server base server– Tivoli Identity Manager Server– A JDBC driver, if required
 v On one or more additional computers that can be in or out of the cluster, installthe following components and products:– A database server– A directory server– IBM Tivoli Directory Integrator (optional)– An IBM HTTP Server and WebSphere Web Server plug-in (optional)
 This task is an example configuration only. An alternative topology mightconfigure these components on computers that are all inside the cluster, and thedeployment manager might reside on the same computer as the WebSphereApplication Server base server. You must ensure that the computer has therequired memory, speed, and available space to meet the additional load.
 Overview of the installationThe installation consists of a collection of activities.
 The major steps to install and test Tivoli Identity Manager are:1. Determine the Tivoli Identity Manager Server topology. The information in this
 chapter describes the major configuration choices.2. Ensure that the operating system of each physical server is at the level that
 Tivoli Identity Manager requires. For more information about software andhardware requirements, refer to the Tivoli Identity Manager Information Center.
 3. Ensure that the database server is installed and preconfigured. See Chapter 2,“Installing and configuring a database,” on page 9 for steps to prepare thedatabase.
 4. Ensure that the directory server is installed and preconfigured. See Chapter 3,“Installing and configuring a directory server,” on page 27 for steps to preparethe directory server.
 5. Ensure that IBM Tivoli Directory Integrator is installed and preconfigured. SeeChapter 4, “Optionally installing IBM Tivoli Directory Integrator,” on page 39for steps to prepare IBM Tivoli Directory Integrator.
 6. Determine that the WebSphere Application Server is ready. See Chapter 5,“Installing and configuring WebSphere Application Server,” on page 41 forsteps to prepare the WebSphere Application Server in a single-cluster or clusterconfiguration.
 7. Install and configure Tivoli Identity Manager on one of these configurations:v Single-server. Tivoli Identity Manager supports both regular and silent
 installation. For more information about single-server install, see “InstallingTivoli Identity Manager in a single-server configuration” on page 49.
 Chapter 1. Overview of the Tivoli Identity Manager environment 5
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v Cluster. Tivoli Identity Manager supports both regular and silent installation.For more information about cluster install, see “Installing Tivoli IdentityManager in a cluster configuration” on page 58.
 For steps to upgrade from an existing installation of Tivoli Identity Manager,see Chapter 10, “Upgrading to Tivoli Identity Manager Version 5.1,” on page103.For steps to perform a silent installation of Tivoli Identity Manager, seeChapter 8, “Performing a silent installation and configuration of Tivoli IdentityManager,” on page 85.
 8. Verify the installation and troubleshoot to resolve any problems that happenedduring installation and startup. For more information, see Chapter 9, “Verifyingand troubleshooting the installation,” on page 93.
 Planning activities for deployments at large sitesIn large organizations, there are additional tasks that require planning before youdeploy Tivoli Identity Manager. For more information, refer to the Planning sectionof the Tivoli Identity Manager Information Center
 To prevent initial deployment problems, consider providing a variation of thefollowing planning activities that are appropriate for your site, in advance ofinstalling Tivoli Identity Manager, and also subsequent fix packs:v Establish a working practice that provides comprehensive and relevant Tivoli
 Identity Manager information to all the specialists who install middleware. Forexample, have the team meet regularly to enumerate their problems and sharetheir solutions.
 v To ensure coordination, designate one person as a focal point for concerns thatflow between your site and IBM customer support specialists.
 v If possible, reduce the number of specialists who install and configure theapplications. Encourage communication flow between specialists in the followingways.– Provide a comprehensive library or list of FTP and Web sites for prerequisite
 installation and configuration information.– Ensure that the specialists installing Tivoli Identity Manager have root or
 Administrator authority for the prerequisite middleware on the middlewareservers.
 – Ensure that all elements of the system or solution have sufficient privileges toprovide accounts.
 – Support a centralized problem and solution database that identifiestroubleshooting actions and assigns action owners.
 – Maintain a common library of scripts that automate start up.– Create a change control database that coordinates all customization activities.– Determine a working practice in which specialists provide a record of critical
 values of configuration parameters like the ones that this publicationprovides. Ensure that all specialists have access to and use a commonworksheet that centralizes the information.For example, each installation chapter in this manual provides a checklist ofprerequisites that must be installed, configured, and running before you begininstallation. Additionally, Appendix B, “Configuring security for TivoliIdentity Manager,” on page 127 provides a centralized collection point for
 6 IBM Tivoli Identity Manager Server: Installation and Configuration Guide
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critical values such as user IDs, passwords, and security settings. The IBMTivoli Identity Manager Information Center specifies prerequisite levels and fixpacks or patches.
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Chapter 2. Installing and configuring a database
 The Tivoli Identity Manager application stores transactional and historical data,including schedules, access control item definitions (ACIs), and audit data in adatabase. This chapter focuses on configuring a Tivoli Identity Manager databasebefore Tivoli Identity Manager installation. For more information about supporteddatabase releases and required fix packs, refer to the Tivoli Identity ManagerInformation Center.
 The information in this chapter is not a substitute for the more extensive,prerequisite documentation that is provided by the database product. For moreinformation that you must previously know, refer to these sources:v IBM DB2 Database
 http://www.ibm.com/software/data/db2/udb/support.htmlhttp://www.ibm.com/software/data/db2/support/db2_9/doc.html(Information centers and operating system prerequisites)http://www.ibm.com/software/data/db2
 v Oraclehttp://otn.oracle.com/documentation/index.htmlhttp://otn.oracle.com/tech/index.html
 v Microsoft SQL Server 2005http://www.microsoft.com/sql/http://www.msdn.com/library/
 Before you install the database productBefore you install the database product, complete these steps:v Read the installation information that the database product provides.v Ensure that your installation meets the product hardware and software
 requirements.v Verify that all required operating system patches are in place.v Ensure that kernel settings are correct for some operating systems, such as the
 Solaris operating system. Each database application specifies its ownrequirements, such as additional operating system values. Before installing theapplication, refer to its documentation for these additional settings. For example,these Web sites describe kernel settings that DB2 requires:– AIX
 None required.– Solaris
 http://publib.boulder.ibm.com/infocenter/db2luw/v9/topic/com.ibm.db2.udb.uprun.doc/doc/t0006476.htm
 – Linux (Red Hat and SUSE)http://publib.boulder.ibm.com/infocenter/db2luw/v9/topic/com.ibm.db2.udb.uprun.doc/doc/t0008238.htm
 – WindowsNone required.
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Installing and configuring IBM DB2 DatabaseThis section describes installing and configuring the IBM DB2 Universal Database(DB2). The configuration steps in this section create a database for later use by theTivoli Identity Manager Server installation program, which populates the databasewith data objects.
 You can install DB2 on the same computer with Tivoli Identity Manager or on aseparate computer. Installing DB2 on the same computer requires the installation ofa Java Database Connectivity driver (JDBC driver, type 4). A JDBC driver enablesTivoli Identity Manager to communicate with the data source. Installing DB2automatically installs the type 4 JDBC driver.
 Tivoli Identity Manager requires DB2 to run with a required level of the DB2 fixpack. For more information about installing DB2 and any fix packs, refer to theTivoli Identity Manager Information Center and to documentation that the databaseproduct provides. For example, access these Web sites:
 http://www.ibm.com/software/data/db2/udb/support.html
 http://www.ibm.com/software/data/db2/udb/support/downloadv9.html
 Recording user dataThe DB2 installation requires that you specify some system data, such as the DB2administrator user ID and password. The installation wizard provides both statusreports and an initial verification activity.
 Recording user names and passwords on UNIX and LinuxsystemsTable 1 shows the default values that are created on UNIX and Linux systems.Record this information, which is required to configure the DB2 database thatTivoli Identity Manager uses. If you choose not to use the middlewareconfiguration utility to create a DB2 instance, installing DB2 can create a defaultDB2 instance.
 Table 1. DB2 Database typical configuration parameters on UNIX and Linux systems
 UNIX and Linux systems Description Value
 DB2 administrator user ID andinstance name
 The user ID that is usedto connect to DB2 as theDB2 administrator andinstance owner.
 db2adminNote: If you do not usethe middlewareconfiguration utility, thisvalue is db2inst1 bydefault.
 DB2 instance password The password for theadministrator user ID.
 A user-defined value.
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Table 1. DB2 Database typical configuration parameters on UNIX and Linuxsystems (continued)
 UNIX and Linux systems Description Value
 DB2 instance home directory The home directory ofthe DB2 administratorand instance owner.
 v AIX:/home/db2admin
 v Linux:/home/db2admin
 v Linux for System p:/home/db2admin
 v Linux for System z:/home/db2admin
 v Solaris:/export/home/db2admin
 Note: If you do not usethe middlewareconfiguration utility, youmight need to replacedb2admin with db2inst1.
 Recording user names and passwords on Windows systemsTable 2 shows the default values that are created on Windows systems. If youchoose not to use the middleware configuration utility to create a DB2 instance,installing DB2 can also create the default DB2 instance. For more information aboutusing the middleware configuration utility, see “Running the middlewareconfiguration utility” on page 13.
 Table 2. Field values on Windows systems
 Windows systems Description Value
 DB2 instance name The name of the DB2instance.
 db2adminNote: DB2 defaults to aninstance value of DB2.
 Administrative user ID The user ID that is usedto connect to DB2 as theDB2 administrator andinstance owner.
 db2admin
 Password The password for theadministrator user ID.
 A user-defined value
 DB2 instance home directory The home directory ofthe DB2 administratorand instance owner.
 drive:
 For example, C:
 Verifying the installationThe installation wizard provides a status report when the installation is complete.Additionally, run the DB2 First Steps operation to verify that the installation issuccessful. To start the operation, complete these steps:v UNIX or Linux operating systems
 Enter this command:DB_INSTANCE_HOME/sqllib/bin/db2fs
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Note: For UNIX systems, the root user has to source the db2admin profile orswitch to the instance owner before running this command. You havealready created a DB2 instance.
 v Windows operating systemsClick Start > Programs > IBM DB2 > DB2 Copy Name > Set-up Tools > FirstSteps.
 For more information about verifying the DB2 installation, visit this Web site:
 http://publib.boulder.ibm.com/infocenter/db2luw/v9/index.jsp?topic=/com.ibm.db2.udb.uprun.doc/doc/t0006838.htm
 Installing the required fix packsIf your version of DB2 requires a fix pack, obtain and install the fixes that areavailable at these DB2 support Web sites:
 http://www.ibm.com/software/data/db2/udb/support.html
 Verify that the correct fix pack is installed on both the database server and thedatabase client computers.
 If you created a DB2 instance during installation, you can use the followingcommands:v On UNIX and Linux systems, log on as the DB2 instance user ID and enter the
 db2level command:su - DB2_instance_IDdb2level
 The value of DB2_instance_ID is the DB2 instance name such as db2admin.v On Windows, enter the db2level command from the DB2 command window:
 db2level
 If you did not create a DB2 instance during installation, use the followingcommands:v On UNIX and Linux systems, enter the db2ls command:
 DB_HOME/install/db2ls
 or/usr/local/bin/db2ls
 v On Windows, run the regedit command and look for the information in thefollowing location:HKEY_LOCAL_MACHINE\SOFTWARE\IBM\DB2\InstalledCopies\db2_name\CurrentVersion
 For more information about these steps, refer to the Tivoli Identity ManagerInformation Center and to documentation that the DB2 fix pack provides.
 Configuring IBM DB2 DatabaseThe Tivoli Identity Manager installation product includes a middlewareconfiguration utility that creates database instances and user IDs and configuresparameters for DB2 and IBM Tivoli Directory Server. Default values are suppliedfor many of the typical parameters and all the advanced parameters. If an enteredparameter, such as the DB2 instance ID, exists, the middleware configuration utilityskips the task of creation. You can choose to keep those values, or provide values
 12 IBM Tivoli Identity Manager Server: Installation and Configuration Guide
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of your own. Required fields are marked by an asterisk (*). You can revisit anypanel in the deployment wizard by clicking the Back button until you reach thepanel.
 Note: The middleware configuration utility stores by default any input youprovide in a response file called db2ldap.rsp located in the system tempdirectory; for example, the /tmp directory. This file is normally cleaned upafter the utility completes. If you cancel the utility before it completes, thisfile might not be erased.
 Running the middleware configuration utilityYou can run the middleware configuration utility to set DB2 parameters for laterTivoli Identity Manager deployment. The middleware configuration utility:v Creates user IDs if neededv Creates DB2 instances if neededv Creates databases if neededv Tunes DB2 (buffer pool, log tuning)v Configures some DB2 settings (DB2ENVLIST=EXTSHM, DB2COMM=tcpip)
 The middleware configuration utility can be run manually or silently. For moreinformation about silent configuration, see “Configuring DB2 silently” on page 15.
 Before you begin: On Windows operating systems, you must be an administratoror have administrative authority.
 On UNIX and Linux operating systems, you must be a root user. Additionally, theumask setting must be 022. To verify the umask setting issue the command:umask
 To set the umask value to 022, issue the command:umask 022
 Note: Record the values you provide for the middleware configuration utility forlater use with the DBConfig and ldapConfig utilities used during TivoliIdentity Manager server installation.
 Procedure: To start the middleware configuration utility for DB2 manually,complete the following steps:1. Log on to an account with system administration privileges on the computer
 where DB2 is installed.2. Start the middleware configuration utility, located on the base directory of the
 DVD or a download directory:v AIX: Start the middleware configuration utility by running the
 cfg_itim_mw_aix program.v Solaris: Start the middleware configuration utility by running the
 cfg_itim_mw_solaris program.v Linux for xSeries: Start the middleware configuration utility by running the
 cfg_itim_mw_xLinux program.v Linux for pSeries: Start the middleware configuration utility by running the
 cfg_itim_mw_pLinux program.v Linux for zSeries: Start the middleware configuration utility by running the
 cfg_itim_mw_zLinux program.
 Chapter 2. Installing and configuring a database 13
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v Windows: Start the middleware configuration utility by using thecfg_itim_mw.exe program if the Windows autorun feature is disabled.
 Each platform requires a file called cfg_itim_mw.jar to go along with the nativeprogram. The JAR file and the native program must be in the same directorylocation.
 3. Select your language, and click OK.4. From the Product Configuration panel, check only Configure IBM DB2
 Database, and click Next.5. You can receive a warning if DB2 is not at the correct level or not installed.
 Action might be required to make sure DB2 is at the correct level. To bypassthis warning, click Next.
 6. From the IBM DB2 Database Configuration Options panel, provide thefollowing information, and then click Next:
 v DB2 administrator ID or instance nameProvide the user ID that is used to connect to DB2 Database as the DB2administrator. For example, db2admin. If this value is new, the utility creates auser ID and instance name. If you provide an existing user ID and instancename, no new user ID or instance is created.
 v DB2 administrator passwordEnter the password that you have set for the DB2 Database administratoraccount.
 v Password confirmationType the password again.
 v DB2 server database homeProvide the directory on which the DB2 instance resides. For example, C: or/home/dbinstancename.
 v DB2 database nameProvide the name of the database you are creating. For example, itimdb.
 v ITIM database user IDProvide the user ID for the ITIM database you are creating. For example,itimuser.
 Note: On Windows systems, disable password expiration for this useraccount after running the utility.
 v Password for ITIM database user ID:Provide the password for the ITIM database user ID.
 v Password confirmationType the password again.
 v Group for the DB2 administratorSelect from the drop-down list a valid group, of which root is a member, toassociate the DB2 administrator ID instance name. For example, bin. Thisvalue is available only for UNIX or Linux operating systems.
 Note: The dollar sign ($) has special meaning in the installer frameworks usedby the middleware configuration utility. Avoid using $ in any fieldvalues. The installer framework or operating system platform might dovariable substitution for the value.
 7. If you have changed the default DB2 instance name, or if a DB2 instance existswith that name, you are prompted with a warning message. If you are only
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using the DB2 instance for Tivoli Identity Manager, click Yes. It is notrecommended to share the instance with another program.
 8. Review your configuration options before clicking Next to begin theconfiguration process.
 9. The configuration can take up to several minutes to complete. After theconfiguration completes successfully, click Finish to exit the deploymentwizard. This step concludes the middleware configuration process for DB2Database. To verify the middleware configuration utility completed for DB2without error, check the cfg_itim_mw.log in the system temp directory.
 Configuring DB2 silentlyTo start the middleware configuration utility silently, complete these steps:1. Copy the sample response file cfg_itim_mw.rsp (or cfg_itim_mw_windows.rsp
 for Windows systems) to a directory on the target computer.2. Update the response file with the correct values. Make sure that the
 configureDB2 value is set to "yes". If you are not configuring the directoryserver at the same time, make sure that the configureLDAP value is set to "no".
 3. From a command window, run this command:cfg_itim_mw –W ITIM.responseFile=cfg_itim_mw.rsp –silent
 Where cfg_itim_mw is:v AIX: cfg_itim_mw_aixv Solaris: cfg_itim_mw_solarisv Linux for xSeries: cfg_itim_mw_xLinuxv Linux for pSeries: cfg_itim_mw_pLinuxv Linux for zSeries: cfg_itim_mw_zLinuxv Windows: cfg_itim_mw_windows
 Note: If you run the middleware configuration utility silently, the response fileis updated during the configuration process.
 Related topics:
 “Running the middleware configuration utility” on page 13
 Manually configuring the DB2 serverYou can manually configure the DB2 server. The DB2 settings described in thischapter are initial settings that might require runtime adjustment. For moreinformation, refer to the IBM Tivoli Identity Manager Performance Tuning Guidetechnical supplement.
 Configuring the DB2 server requires the following steps:1. “Creating a user on Windows and UNIX systems” or “Creating a user on a
 Linux system” on page 162. “Creating the Tivoli Identity Manager database” on page 163. “Ensuring that TCP/IP communication is specified” on page 17
 Creating a user on Windows and UNIX systems: Create an operating systemuser named itimuser on the computer on which the DB2 server is installed. TheTivoli Identity Manager Server uses the default user ID itimuser to access thedatabase, although you have the option to create a user ID other than the default
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user ID or use an existing user ID. No special privileges are required for this user.Ensure that a password change is not required at the next logon and that thepassword never expires.
 To create a user, follow these steps:1. As root or as Administrator, start the system management tool for your
 operating system.v AIX: SMIT or SMITTY
 v Solaris: System Management Console (SMC)
 v Windows: Click Start > Administrative Tools > Computer Management >Local Users and Groups > Users.
 2. Add a new user itimuser and set the user password.3. Exit the system management tool.4. Test the user access. Ensure that you can log on with the user ID itimuser
 without encountering a password reset.5. Proceed to the next step, “Creating the Tivoli Identity Manager database.”
 Creating a user on a Linux system: You can use the console command interfaceor the GUI utility to create a user on Linux. To create a user by using the consolecommand interface on a Linux (Red Hat) operating system, enter the followingcommand:useradd -d /home/itimuser -p password itimuser
 The -d switch specifies the home directory. The entry itimuser specifies the userID that is created.
 Proceed to the next step, “Creating the Tivoli Identity Manager database.”
 Creating the Tivoli Identity Manager database: You can specify any name for theTivoli Identity Manager database, such as itimdb. To create the Tivoli IdentityManager database, follow these steps:1. Open a DB2 command window.v UNIX: Log on as the DB2 instance owner and ensure that the db2profile has
 been sourced into the environment.v Windows: Click Start > Run, and enter db2cmd.
 2. In the DB2 command window, enter these commands to create the database:db2 create database itim_dbname using codeset UTF-8 territory usdb2 connect to itim_dbname user itim_dbadmin_name using itim_dbadmin_passworddb2 create bufferpool ENROLEBP size automatic pagesize 32kdb2 update db cfg for itim_dbname using logsecond 12db2 update db cfg for itim_dbname using logfilsiz 10000db2 update db cfg for itim_dbname using applheapsz 2048db2 update db cfg for itim_dbname using app_ctl_heap_sz 1024db2 update db cfg for itim_dbname using maxfilop 256db2 update db cfg for itim_dbname using locklist 5000db2 update db cfg for itim_dbname using auto_runstats offdb2 update db cfg for itim_dbname using database_memory itim_dbmemorydb2 alter bufferpool IBMDEFAULTBP size automaticdb2 disconnect current
 The value of itim_dbname is a name such as itimdb. The value of itim_dbmemoryis 40000 for a single-server installation, COMPUTED for all platforms except AIXand Windows. For AIX and Windows, the value is AUTOMATIC. For more
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information about performance parameter tuning for DB2, refer to the IBMTivoli Identity Manager Performance Tuning Guide.
 3. Stop and start the DB2 server to reset the configuration.After you have created the Tivoli Identity Manager database and reset theconfiguration, stop and start the DB2 server to allow the changes to take effect.Enter the following commands:db2stopdb2start
 If entering db2stop fails and the database remains active, enter db2 forceapplication all to inactivate the database. Enter db2stop again.
 Ensuring that TCP/IP communication is specified: Installing DB2 specifiesTCP/IP communication by default. To confirm that TCP/IP communication isspecified on the DB2 server and on the DB2 client, follow these steps:1. Enter the following command:
 db2set -all DB2COMM
 2. If a tcpip entry is not in the list that was returned, enter the followingcommand, including tcpip and any other values that were returned in the listthat the command provided:db2set DB2COMM=tcpip,values_from_db2set_command
 For example, if the db2set -all DB2COMM command returned values such asnpipe and ipxspx in the list, specify these values again when you enter thedb2set command the second time:db2set DB2COMM=tcpip,npipe,ipxspx
 Determining the correct service listening port and service nameRunning the middleware configuration utility configures the service listening portnumber and the database service name.
 There is a service listening port associated with each DB2 instance. The port isused for establishing a DB2 connection from a DB2 application to the databaseowned by the instance. The default service port number for the DB2 defaultinstance (DB2 on windows and db2inst1 on Unix), which is created on installingthe DB2 server, is 50000. Running the middleware configuration utility to create aDB2 instance, the default service port number of the instance is 50002. If you havemigrated DB2 8.2 to DB2 9.1 or DB2 9.5 along with the DB2 instance, the DB2migration utility might reset the service port of the instance as 60000.
 To determine whether the correct service name or service listening port is defined,complete these steps:1. In the DB2 command window, enter these commands to check the service
 name:db2 connect to itim_dbname user itim_dbadmin_id using itim_dbadmin_passworddb2 get dbm cfg
 Look for the SVCENAME attribute to locate the service name.2. Locate the statement that is like the following example, which specifies the
 current port number in the services file on the computer on which the DB2server resides:v Windows
 – DB2 Version 9.1: service_name: 50000/tcp
 v UNIX– DB2 Version 9.1: service_name: 50000/tcp
 Chapter 2. Installing and configuring a database 17
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where service_name is the attribute you checked in the first step.
 The services file has the following path:v Windows
 – %SYSTEMROOT%\system32\drivers\etc\servicesv UNIX
 – /etc/services
 Related topics:
 See “Before you begin” on page 106 for topics related to DB2 migration.
 Tuning the DB2 Database for performancePerformance issues can occur after you initially configure DB2. These tasksdescribe actions you can take to ensure DB2 performs correctly.
 Configuring TCP KeepAlive settingsThe failover design of the messaging engine relies upon the database connectionsbeing broken when a messaging engine instance fails. In order for failover to occurin high availability environments, ensure that the system notices the brokenconnection in a timely manner and releases database locks. This task is done byconfiguring the TCP KeepAlive settings. For example, if you run DB2 on Linux,login as a system administrator and complete these steps:1. Run the following commands on the computer where your DB2 Server resides:
 echo 30 > /proc/sys/net/ipv4/tcp_keepalive_intvlecho 30 > /proc/sys/net/ipv4/tcp_keepalive_time
 Note: These settings are also used by IPv6 implementations.2. You might need to restart the network for changes to take effect, such as
 running the following Linux command:# /etc/init.d/network restart
 These settings will be effective only after a restart of the computer.
 Changing the DB2 application heap sizeLoading many users can encounter performance issues. You might see thismessage:Not enough storage available for processing the sql statements.
 To provide additional storage space, change the DB2 application heap size to alarger value. Using the IBM Tivoli Identity Manager Performance Tuning Guide to tuneDB2 is recommended for all systems, both for production and test environments.
 Installing and configuring the Oracle databaseThis section describes installing and configuring the Oracle database for TivoliIdentity Manager.
 In all cases, refer to the installation and migration guides that the OracleCorporation provides for complete information. For more information, refer tothese Web sites:
 http://otn.oracle.com/documentation/index.html
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http://otn.oracle.com/tech/index.html
 http://otn.oracle.com/tech/linux/index.html
 Before you create a databaseTo use multiple instances of Tivoli Identity Manager with the same OracleDatabase server, see “Multiple instances of Tivoli Identity Manager with an OracleDatabase server” before creating the database.
 To create an Oracle database for Tivoli Identity Manager, complete these steps:v “Installing the Oracle database server” on page 20v “Configuring the init.ora file” on page 20v “Setting environment variables” on page 21v “Backing up an existing database” on page 21v “Installing the Oracle JDBC driver” on page 21
 Multiple instances of Tivoli Identity Manager with an OracleDatabase serverIf you want to point several instances of Tivoli Identity Manager to multipledatabases on the same Oracle server you need to copy and modify this codeexample in the $ITIM_home/config/rdbms/oracle/enrole_admin.sql file. This codeneeds to be added after the Tivoli Identity Installation has started (to create the$ITIM_home/config/rdbms/oracle/enrole_admin.sql file), but before submittingthe dbConfig portion of the installation.
 The value enrole1_data_001.dbf’ has been changed to enrole1_data_002.dbf’ in thisexample. This value needs to be modified incrementally in each copy of the codefor each additional Tivoli Identity Manager instance being used on the same Oracleserver.
 Note: The two lines where the code needs to be modified are highlighted in bold.# pwd/u02/enrole/config/rdbms/oracle# more enrole_admin.sqlCREATE TABLESPACE enrole_dataDATAFILE 'enrole1_data_002.dbf'SIZE 160MAUTOEXTEND ONNEXT 20MMAXSIZE 1024MDEFAULT STORAGE (INITIAL 10MNEXT 1MPCTINCREASE 10)PERMANENTONLINELOGGING;
 CREATE TABLESPACE enrole_indexesDATAFILE 'enrole1_idx_002.dbf'SIZE 160MAUTOEXTEND ONNEXT 20MMAXSIZE 1024MDEFAULT STORAGE (INITIAL 10MNEXT 1MPCTINCREASE 10)PERMANENTONLINELOGGING;
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CREATE USER enrole IDENTIFIED BY enroleDEFAULT TABLESPACE enrole_dataQUOTA UNLIMITED ON enrole_dataQUOTA UNLIMITED ON enrole_indexes;GRANT CREATE SESSION TO enrole;GRANT CREATE TABLE to enrole;#
 Installing the Oracle database serverYou might install the Oracle database server on the same computer or on acomputer that is separate from Tivoli Identity Manager. For more informationabout installing the Oracle database server, refer to documentation available at thisWeb site:
 http://otn.oracle.com/tech/index.html
 Note: If you manually create the Oracle database for Tivoli Identity Manager, youmust manually install the JVM feature, or any transactions from TivoliIdentity Manager later fails. It is not required to manually create thedatabase and install the JVM feature, however. You can use the OracleDatabase Configuration Assistant wizard to create the database and installthe JVM feature.
 Configuring the init.ora fileYou must configure the init.ora file for the Tivoli Identity Manager database.Complete these steps:1. Copy the init.ora file.v Windows
 a. Under the ORACLE_HOME\admin\ directory, create a directory nameddb_name\pfile. The value of db_name might be itimdb.
 b. Copy the sample initsmpl.ora file from the ORACLE_HOME\db_1\admin\sample\pfile\ directory to the ORACLE_HOME\admin\db_name\pfile directory.
 c. Rename the new init.ora file to a value of initdb_name.ora.v UNIX
 Copy the ORACLE_HOME/product/10.2.0/db_2/dbs/init.ora file to a newORACLE_HOME/dbs/initdb_name.ora file.
 2. Based on your environment requirements, tune the value of the followingparameters in the initdb_name.ora file:db_name=itimdbcompatible=10.2.0.1.0processes=150shared_pool_size=50000000
 Additionally, define three control files for the Tivoli Identity Manager database.This example statement defines the control files for a UNIX operating system:control_files=(ORACLE_HOME/oradata/db_name/control01.ctl,ORACLE_HOME/oradata/db_name/control02.ctl,ORACLE_HOME/oradata/db_name/control03.ctl)
 Using the IBM Tivoli Identity Manager Performance Tuning Guide to tune Oracledatabase is recommended for all systems, both for production and testenvironments.
 3. Manually create all the directories defined in the initdb_name.ora file.
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Setting environment variablesSet the environment variables for Oracle by editing the .profile file. Requiredenvironment variables include ORACLE_SID and ORACLE_HOME, and include thelibrary path, and the system path.
 Source the profile on UNIX operating systems, which updates the environmentvariables in the current session, to ensure that Tivoli Identity Manager cancommunicate with the database. To source the profile, enter the followingcommand:# . /.profile
 For more information, refer to the Oracle Web site.
 Backing up an existing databasePerform a full backup of any existing database, and review the preliminary stepsthat the documentation from the Oracle Corporation provides for upgrading anOracle database, before you begin to install the Oracle product or upgrade anexisting database. For Web sites that provide this information, see “Installing theOracle database server” on page 20.
 Installing the Oracle JDBC driverIBM Tivoli Identity Manager Version 5.1 requires the Oracle 11g Release 1(11.1.0.7.0) JDBC driver whether you are using an Oracle 10g or 11g database.
 Copy the Oracle JDBC driver from the Oracle server directory or download it fromthe Oracle Web site into a directory on the computer on which Tivoli IdentityManager is to be installed. The Tivoli Identity Manager installation programprompts for the directory containing the JDBC driver and the driver name. In acluster configuration, the JDBC driver is required on the computer that has thedeployment manager and on each Tivoli Identity Manager cluster membercomputer. For example, if Oracle database is installed on Linux, but Tivoli IdentityManager is installed on Windows, create a directory C:\itim_jdbcdriver\ andcopy the JDBC driver file to that directory, then point to this directory duringinstallation.
 Creating the Tivoli Identity Manager databaseSkip this step if you use the Oracle Database Configuration Assistant wizard,which creates the Tivoli Identity Manager database.
 Manually create a Tivoli Identity Manager database using these steps:1. Create and start the database instance using these steps:v Windows
 a. Create the instance with this command on one line:# oradim -new -sid db_name -pfile ORACLE_HOME\admin\db_name\pfile\initdb_name.ora
 The value of the -sid parameter specifies the database instance name. Forexample, the value of db_name might be itimdb. The value of the -pfileparameter specifies the file that you previously configured in“Configuring the init.ora file” on page 20.
 b. Start the database instance with these commands:# sqlplus "/ as sysdba"SQL> startup nomount pfile=ORACLE_HOME\admin\db_name\pfile\initdb_name.ora
 c. Verify that the Windows service OracleService db_name is started.v UNIX
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Start the database instance with these commands:# ./sqlplus "/ as sysdba"SQL> startup nomount pfile= ORACLE_HOME/dbs/initdb_name.ora
 2. Use an SQL script like the following example to create your database. Changethe values in the script to match any requirements at your site. In this example,the value of the db_name is an instance name such as itimdb.-- Create databaseCREATE DATABASE db_name
 CONTROLFILE REUSELOGFILE '/u01/oracle/db_name/redo01.log' SIZE 1M REUSE,
 '/u01/oracle/db_name/redo02.log' SIZE 1M REUSE,'/u01/oracle/db_name/redo03.log' SIZE 1M REUSE,'/u01/oracle/db_name/redo04.log' SIZE 1M REUSE
 DATAFILE '/u01/oracle/db_name/system01.dbf' SIZE 10M REUSEAUTOEXTEND ONNEXT 10M MAXSIZE 200M
 CHARACTER SET UTF8;
 -- Create another (temporary) system tablespaceCREATE ROLLBACK SEGMENT rb_temp STORAGE (INITIAL 100 k NEXT 250 k);
 -- Alter temporary system tablespace online before proceedingALTER ROLLBACK SEGMENT rb_temp ONLINE;
 -- Create additional tablespaces ...-- RBS: For rollback segments-- USERs: Create user sets this as the default tablespace-- TEMP: Create user sets this as the temporary tablespaceCREATE TABLESPACE rbs
 DATAFILE '/u01/oracle/db_name/db_name.dbf' SIZE 5M REUSE AUTOEXTEND ONNEXT 5M MAXSIZE 150M;
 CREATE TABLESPACE usersDATAFILE '/u01/oracle/db_name/users01.dbf' SIZE 3M REUSE AUTOEXTEND ONNEXT 5M MAXSIZE 150M;
 CREATE TABLESPACE tempDATAFILE '/u01/oracle/db_name/temp01.dbf' SIZE 2M REUSE AUTOEXTEND ONNEXT 5M MAXSIZE 150M;
 -- Create rollback segments.CREATE ROLLBACK SEGMENT rb1 STORAGE(INITIAL 50K NEXT 250K)tablespace rbs;
 CREATE ROLLBACK SEGMENT rb2 STORAGE(INITIAL 50K NEXT 250K)tablespace rbs;
 CREATE ROLLBACK SEGMENT rb3 STORAGE(INITIAL 50K NEXT 250K)tablespace rbs;
 CREATE ROLLBACK SEGMENT rb4 STORAGE(INITIAL 50K NEXT 250K)tablespace rbs;
 -- Bring new rollback segments online and drop the temporary system oneALTER ROLLBACK SEGMENT rb1 ONLINE;ALTER ROLLBACK SEGMENT rb2 ONLINE;ALTER ROLLBACK SEGMENT rb3 ONLINE;ALTER ROLLBACK SEGMENT rb4 ONLINE;
 ALTER ROLLBACK SEGMENT rb_temp OFFLINE;DROP ROLLBACK SEGMENT rb_temp ;
 Note: Using the IBM Tivoli Identity Manager Performance Tuning Guide to tunethe Oracle database is recommended for all systems, both for productionand test environments.
 3. Install the JVM for the database. Use these commands:# sqlplus "/ as sysdba"
 SQL> @$ORACLE_HOME/rdbms/admin/catalog.sqlSQL> @$ORACLE_HOME/rdbms/admin/catproc.sqlSQL> @?/javavm/install/initjvm.sqlSQL> @?/xdk/admin/initxml.sqlSQL> @?/xdk/admin/xmlja.sqlSQL> @?/rdbms/admin/catjava.sql
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SQL> connect system/managerSQL> @$ORACLE_HOME/sqlplus/admin/pupbld.sql
 The value of the manager parameter is the password for the system useraccount.
 Tuning the Oracle database for performanceThis section describes some actions you can take to ensure the Oracle databasefunctions properly.
 Enabling XA recovery operationsOracle requires the granting of special permissions to perform enable XA recoveryoperations. Failure to enable XA recovery can result in the following error:WTRN0037: The transaction service encountered an error on an xa_recover operation.
 As the database administrator, connect to the database and run the followingcommands:grant select on pending_trans$ to public;grant select on dba_2pc_pending to public;grant select on dba_pending_transactions to public;grant execute on dbms_system to itim_db_user;
 where itim_db_user is the user that owns the Tivoli Identity Manager database,such as itimuser.
 Stop and restart the database instance for these changes to take effect.
 Configuring TCP KeepAlive settingsThe failover design of the messaging engine relies upon the database connectionsbeing broken when a messaging engine incarnation fails. In order for failover tooccur in high availability environments, ensure that the RDBMS detects the brokenconnection in a timely manner and releases database locks. This task is done byconfiguring the TCP KeepAlive settings. If you run Oracle on Windows Server, login as a system administrator and complete these steps:1. Run regedit from Start > Run.2. Navigate to the following path in the left pane:
 My Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters
 3. Right click in the right pane and select New > DWORD Value.4. Enter the name as KeepAliveInterval for the new parameter.5. Right click this new parameter and select Modify.6. Select Base as Decimal and enter the value as 30000 (30000 milliseconds = 30
 seconds).7. Similarly, add another DWORD value with name KeepAliveTime and set the
 value equal to 30000.
 These settings will be effective only after a reboot of the computer.
 Starting the Oracle product and the listener serviceTo start the Oracle database, complete these steps:v Windows
 Use the Services menu to start the Oracle database service calledOracleServicedb_name.
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v UNIXEnter these commands:# su - oracle# ./sqlplus "/ as sysdba"# SQL> startup
 To start the Oracle listener service, complete these steps:v Windows
 Use the Services menu to start the Oracle TNS listener namedOracleOraDb10_home1TNSListener. If the Oracle listener service is idle, start thelistener.
 v UNIX# su - oracle# ./lsnrctl start
 To ensure that Oracle processes are started, enter this command:ps -ef | grep ora
 To ensure that the listener is running, enter this command:# ./lsnrctl status
 Installing and configuring SQL Server 2005 on the Windows operatingsystem
 This section describes installing and configuring SQL Server 2005 on the Windowsoperating system. Complete these steps:v “Preparing to install SQL Server 2005”v “Installing SQL Server 2005”v “Configuring SQL Server 2005”v “Creating the Tivoli Identity Manager database” on page 25
 Preparing to install SQL Server 2005Complete the following procedures before installing SQL Server 2005 on aWindows system:1. Obtain the latest SQL Server 2005 service pack.2. Log in to the Windows system with an Administrator account before launching
 the SQL Server 2005 installation.
 Installing SQL Server 2005You might install SQL Server 2005 on the same computer or on a computer that isseparate from Tivoli Identity Manager. After installing SQL Server 2005, install thelatest SQL Server 2005 service pack. For more information about installing SQLServer 2005, refer to documentation available at these Web sites:
 http://www.msdn.com/library/
 http://www.microsoft.com/Sqlserver/2005/en/us/default.aspx
 Configuring SQL Server 2005You must complete several post-installation tasks to configure SQL Server 2005 forTivoli Identity Manager:
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Configuring SQL Server 2005 for XA transactionsTo configure SQL Server 2005 for XA transactions, complete these steps:1. Download and extract the JDBC driver from the following Web site:
 http://msdn2.microsoft.com/en-us/data/aa937724.aspx2. Assuming that you installed the MS SQL Server 2005 JDBC 1.2 driver at
 JDBC_DRIVER_INSTALL_DIR, follow the instructions in Understanding XATransactions by opening the JDBC_DRIVER_INSTALL_DIR\help\html\574e326f-0520-4003-bdf1-62d92c3db457.htm file. Complete the instructions in thesesections as follows:a. Running the MS DTC Serviceb. Configuring the JDBC Distributed Transaction Components
 Note: You do not have to complete the section titled Configuring theUser-Defined Roles because Tivoli Identity Manager creates thenecessary ID and associate with the SqlJDBCXAUser role for you.
 Installing the SQL Server JDBC driverIBM Tivoli Identity Manager version 5.1 requires SQL Server 2005 JDBC Driver 1.2.
 Copy the SQL Server JDBC driver from where SQL Server 2005 is installed ordownload it from the Microsoft Web site into a directory on the computer onwhich Tivoli Identity Manager is to be installed. The Tivoli Identity Managerinstallation program prompts for the directory containing the JDBC driver and thedriver name. In a cluster configuration, the JDBC driver is required on thecomputer that has the deployment manager and on each Tivoli Identity Managercluster member computer. For example, on the computer on which Tivoli IdentityManager is to be installed, create a directory C:\itim_jdbcdriver\ and copy theJDBC driver file to that directory, then point to this directory during installation.
 Verify the security configuration for SQL Server 2005To verify the security configuration for SQL Server 2005, complete these steps:1. Launch the Microsoft SQL Server Management Studio.2. Right click the SQL server root node, and click Properties.3. Select Security from the Select a page panel.4. Ensure that SQL Server and Windows Authentication Mode is selected.5. Click OK.
 Creating the Tivoli Identity Manager databaseYou must complete several post-installation tasks to create the Tivoli IdentityManager database.1. Launch the Microsoft SQL Server Management Studio.2. Navigate the tree, right-click on the Databases node, and select New Database.3. Under Database name, type in a database name such as itimdb, and click OK.4. For data files and transaction logs enter the following values:v Initial file size: 20 MBv Automatically grow filesv Allow unrestricted file growth
 Note: Ensure that the SQL server is in mixed authentication mode.
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Chapter 3. Installing and configuring a directory server
 Tivoli Identity Manager stores user account and organizational data, but notscheduling and audit data, in a directory server. This chapter focuses onconfiguring the directory server for use by Tivoli Identity Manager. The supportedcombinations of directory servers and required fix packs are described in the TivoliIdentity Manager Information Center.
 The information in this chapter is not a substitute for the more extensive,prerequisite documentation that is provided by the directory server product itself.For more information that you must previously know, refer to these sources:v IBM Tivoli Directory Server
 – Hardware and software requirements, and documentationhttp://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/index.jsp?toc=/com.ibm.IBMDS.doc/toc.xml
 – Fixeshttp://www.ibm.com/software/sysmgmt/products/support/B925741X14164Q78-download.html
 Before you install the directory server productBefore you install the directory server product, complete these steps:v Read the installation guide that the directory server product provides.v Ensure that your installation meets the directory server hardware and software
 requirements.
 Installing and configuring IBM Tivoli Directory ServerYou can install the IBM Tivoli Directory Server on the same computer with TivoliIdentity Manager or on a separate computer. IBM Tivoli Directory Server version6.1 and 6.2 support 64-bit on all operating system platforms. In addition, theseversions also support 32-bit for Windows and Linux operating systems.
 The IBM Tivoli Directory Server uses DB2 Database as a data store and WebSphereApplication Server for the Web Administration Tool.
 Installing IBM Tivoli Directory ServerThese steps provide information about installing IBM Tivoli Directory Server usingthe DVDs that are provided with the Tivoli Identity Manager product, which doesnot contain embedded middleware for DB2 and WebSphere Application Server. Ifyou are using an IBM Tivoli Directory Server installation DVD that containsembedded middleware for DB2 and WebSphere Application Server, you have theoption to install embedded DB2 and WebSphere Application Server for IBM TivoliDirectory Server and your installation process might vary.
 Note: You cannot use embedded DB2 for the Tivoli Identity Manager database orembedded WebSphere Application Server for Tivoli Identity Manager.
 To install IBM Tivoli Directory Server using the Tivoli Identity Manager productDVD, complete these steps:
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1. Install DB2 from the DVD provided with the Tivoli Identity Manager product,if DB2 is not already installed.
 2. Install WebSphere Application Server from the DVD provided with the TivoliIdentity Manager product. If you are installing Tivoli Identity Manager on thesame computer as IBM Tivoli Directory Server, you must complete theWebSphere Application Server installation first. For more information, see“Installing WebSphere Application Server in a single-server environment” onpage 42.
 3. Install IBM Tivoli Directory Server from the DVD provided with the TivoliIdentity Manager product.
 4. During the IBM Tivoli Directory Server installation, you must select Custom asthe installation type. Click Next.
 5. On the next panel, do not select DB2 Database, Embedded WebSphereApplication Server, or IBM Tivoli Directory Integrator. You must select IBMTivoli Directory Server 6.1. Other features are optional. Click Next.
 6. In the next panel, the installer detects your WebSphere Application Server. Youmight be prompted to select a custom location of the WebSphere ApplicationServer installation path. You can also choose to skip the deployment of WebAdministration Tools. Click Next.
 7. Review the summary and click Install to install IBM Tivoli Directory Server.
 For information about installing the directory server, refer to documentation thatthe directory server product provides. For example, access this Web site:
 http://www.ibm.com/software/sysmgmt/products/support/IBMDirectoryServer.html
 Installing the required fix packsIf your version of the IBM Tivoli Directory Server requires a fix pack, obtain andinstall the fixes. For more information, refer to this support Web site:
 http://www.ibm.com/software/sysmgmt/products/support/IBMDirectoryServer.html
 http://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/topic/com.ibm.IBMDS.doc/welcome.htm
 Verify that the correct fix pack is installed on the IBM Tivoli Directory Server. Toverify that the correct fix pack is installed on the IBM Tivoli Directory Server, issuethe following command:v AIX: lslpp -l 'idsldap*'
 v Linux: rpm -qa | grep idsldap
 v Solaris:1. Type pkginfo | grep IDSl to query the version for a particular package.2. Type pkgparam package_name VERSION for each installed package. For
 example, pkgparam IDSl64s61 VERSION for IBM Tivoli Directory Serverversion 6.1, or pkgparam IDSl32s60 VERSION for IBM Tivoli Directory Serverversion 6.0.
 v Windows:1. From the command line, type regedit.2. Look in the following registry area:
 – 6.1 - My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\IBM\IDSLDAP\6.1
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– 6.2 - My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\IBM\IDSLDAP\6.2
 For more information about these steps, refer to the Tivoli Identity ManagerInformation Center and to the documentation that the IBM Tivoli Directory Serverfix pack provides.
 Configuring IBM Tivoli Directory ServerSetting up the IBM Tivoli Directory Server requires creating the LDAP suffix foryour organization before you install the Tivoli Identity Manager Server. Setting upthe IBM Tivoli Directory Server also requires configuring the Tivoli IdentityManager referential integrity file. An LDAP suffix, also known as a namingcontext, is a distinguished name (DN) that identifies the top entry in a locally helddirectory hierarchy.
 The Tivoli Identity Manager installation product includes a middlewareconfiguration utility that creates database instances and user IDs and configuresparameters for DB2 and IBM Tivoli Directory Server. Default values are suppliedfor many of the typical parameters and all the advanced parameters. If an enteredparameter, such as the directory server administrator ID, exists, the middlewareconfiguration utility will skip the task of creation. You can choose to keep thosevalues, or provide values of your own. Required fields are marked by an asterisk(*). You can revisit any panel in the deployment wizard by clicking the Backbutton until you reach the panel.
 Note: The middleware configuration utility stores by default any input youprovide in a response file called db2ldap.rsp located in the system tempdirectory, for example the /tmp directory. This file is normally cleaned upafter the utility completes. If you cancel the utility before it completes, thisfile might not be erased.
 Running the middleware configuration utilityYou can run the middleware configuration utility to set IBM Tivoli Directory Serverparameters for later Tivoli Identity Manager deployment. The middlewareconfiguration utility:v Creates user IDs if neededv Creates IBM Tivoli Directory Server instances if neededv Creates directory server databases if neededv Tunes LDAP (buffer pool, log tuning)v Adds the LDAP suffixv Configures the non-SSL portv IBM Tivoli Directory Server version 6.1 copies and configures the referential
 integrity plug-in.IBM Tivoli Directory Server version 6.2 configures the referential integrityplug-in (included in version 6.2) for Tivoli Identity Manager.
 The middleware configuration utility can be run manually or silently. For moreinformation about silent configuration, see “Configuring IBM Tivoli DirectoryServer silently” on page 31.
 Before you begin: On Windows operating systems, you must be an administratoror have administrative authority.
 On UNIX and Linux operating systems, you must be a root user. Additionally, theumask setting must be 022. To verify the umask setting issue the command:
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umask
 To set the umask value to 022, issue the command:umask 022
 Procedure: To start the middleware configuration utility for IBM Tivoli DirectoryServer manually, complete the following steps:1. Log on to an account with system administration privileges on the computer
 where IBM Tivoli Directory Server is installed.2. Start the middleware configuration utility from the DVD or a download
 directory:v AIX: Start the middleware configuration utility by running the
 cfg_itim_mw_aix program.v Solaris: Start the middleware configuration utility by running the
 cfg_itim_mw_solaris program.v Linux for xSeries: Start the middleware configuration utility by running the
 cfg_itim_mw_xLinux program.v Linux for pSeries: Start the middleware configuration utility by running the
 cfg_itim_mw_pLinux program.v Linux for zSeries: Start the middleware configuration utility by running the
 cfg_itim_mw_zLinux program.v Windows: Start the middleware configuration utility by using the
 cfg_itim_mw.exe program if the Windows autorun feature is disabled.Each platform requires a file called cfg_itim_mw.jar to go along with the nativeprogram. The JAR file and the native program must be in the same directorylocation.
 3. Select your language, and click OK.4. From the Product Configuration panel, check only Configure IBM Tivoli
 Directory Server, and click Next.5. You can receive a warning if IBM Tivoli Directory Server is not at the correct
 level or not installed. Action might be required to make sure that IBM TivoliDirectory Server is at the correct level. To bypass this warning, click Next.
 6. From the IBM Tivoli Directory Server configuration options panel, provide thefollowing information, and then click Next:
 v Directory server administrator ID and instance nameProvide the user ID that is used to connect to IBM Tivoli Directory Server asthe directory server administrator. For example, itimldap.
 Note: On Windows systems, disable password expiration for this useraccount after running the utility.
 v Directory server administrator passwordEnter the password that you have set for the IBM Tivoli Directory Serveradministrator account.
 v Password confirmationType the password again.
 v Group for the DB2 administratorSelect from the drop-down list a valid group, of which root is a member, toassociate the DB2 administrator ID. For example, bin. This value is availableonly for UNIX/Linux.
 v Directory server database home
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Provide the directory on which the DB2 instance of directory server resides.For example, C: or /home/directory_server_instancename.
 v Directory server database nameProvide the name of the database you are creating. For example, ldapdb2.
 v Encryption seedProvide an encryption key, which can be any word or phrase. The key isused to encrypt Tivoli Identity Manager passwords and other sensitive text.The encryption seed must be at least 12 characters in length.
 Note: The dollar sign ($) has special meaning in the installer frameworks usedby the middleware configuration utility. Avoid using $ in any fieldvalues. The installer framework or operating system platform might dovariable substitution for the value.
 7. Provide the following LDAP information, and then click Next.v Administrator DN
 The user ID that represents the principal distinguished name. This DN is theroot suffix for Tivoli Identity Manager. For example, cn=root.
 v Administrator DN passwordThe password of the user ID that represents the principal distinguishedname. For example, secret.
 v Password confirmationType the password again.
 v User-defined suffixProvide the LDAP suffix. This suffix can be any valid suffix and is used asthe context root under which Tivoli Identity Manager information is located.For example, choose dc=com.
 v Non-SSL portThe port on which the directory server is listening. The default port is 389.
 Note: This default port might conflict with other services. For example, aWindows server could run Windows Active Directory services, whichuses a default port of 389.
 8. Review your configuration options before clicking Next to begin theconfiguration process.
 9. The configuration can take up to several minutes to complete. Once theconfiguration completes successfully, click Finish to exit the deploymentwizard. This task concludes the middleware configuration process for IBMTivoli Directory Server. To verify the middleware configuration utilitycompleted for IBM Tivoli Directory Server without error, check thecfg_itim_mw.log in the system temp directory.
 Configuring IBM Tivoli Directory Server silentlyTo start the middleware configuration utility silently, complete these steps:1. Copy the sample response file cfg_itim_mw.rsp (or cfg_itim_mw_windows.rsp
 for Windows systems) to a directory on the target computer.2. Update the response file with the correct values. Make sure that the
 configureLDAP value is set to "yes". If you are not configuring the databaseserver at the same time, make sure the configureDB2 value is set to "no".
 3. From a command window, run this command:cfg_itim_mw –W ITIM.responseFile=cfg_itim_mw.rsp –silent
 Where cfg_itim_mw is:
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v AIX: cfg_itim_mw_aixv Solaris: cfg_itim_mw_solarisv Linux for xSeries: cfg_itim_mw_xLinuxv Linux for pSeries: cfg_itim_mw_pLinuxv Linux for zSeries: cfg_itim_mw_zLinuxv Windows: cfg_itim_mw_windows
 Note: If you run the middleware configuration utility silently, the response fileis updated during the configuration process.
 Related topics
 “Running the middleware configuration utility” on page 29
 Verifying successful suffix object configurationTo verify the suffix object configuration in this example, enter this command:v Windows systems:
 ITDS_HOME\bin\ldapsearch.cmd -h localhost -b dc=com "(objectclass=domain)"
 v UNIX or Linux systems:ITDS_HOME/bin/ldapsearch.sh -h localhost -b dc=com "(objectclass=domain)"
 The options are:
 -h Specifies an alternate host on which the LDAP server is running.
 -b Specifies the search base of the initial search, instead of the default.
 The output confirms that you have configured permissions for dc=com andinitialized the suffix with data.dc=comobjectclass=domainobjectclass=topdc=com
 Manually configuring the referential integrity plug-in on the IBMTivoli Directory ServerThe referential integrity plug-in for Tivoli Identity Manager on the IBM TivoliDirectory Server helps maintain consistency in references to objects that are deletedfrom the directory. The referential integrity plug-in is configured when you run themiddleware configuration utility. The following steps explain how to manuallyconfigure the referential integrity plug-in on the IBM Tivoli Directory Server:
 IBM Tivoli Directory Server versions 6.1:
 1. Stop the IBM Tivoli Directory Server.2. Copy the referential integrity plug-in file libdelref.* from the Middleware
 Configuration DVD to the default installation directory for IBM Tivoli DirectoryServer.The referential integrity plug-in file is located on the Middleware ConfigurationDVD under delref\ITDS_VERSION\PLATFORM\LIB wherev ITDS_VERSION is ITDS6.1 for IBM Tivoli Directory Server version 6.1v PLATFORM is aix, linux, win, plinux, sun, or zlinuxv LIB is lib (for 32-bit binary files) or lib64 (for 64-bit binary files)
 Plug-in files are also located on the respective Supplemental DVD2 (IBM TivoliDirectory Server DVD) under delref\LIB\ directory.
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The default installation directory for IBM Tivoli Directory Server is in thefollowing location:v Windows:
 – 32-bit: ITDS_HOME\lib. For example, copy the file to the C:\ProgramFiles\IBM\LDAP\lib directory.
 – 64-bit: ITDS_HOME\lib64. For example, copy the file to the C:\ProgramFiles\IBM\LDAP\lib64 directory.
 v UNIX:– 32-bit: ITDS_HOME/lib. For example, copy the file to the
 usr/IBM/LDAP/lib directory.– 64-bit: ITDS_HOME/lib64. For example, copy the file to the
 usr/IBM/LDAP/lib64 directory.On UNIX systems, ensure that the file permission on the referential integrityplug-in file is set to -r-xr-xr-x, via the chmod 755 command..
 3. Copy the timdelref.conf file from the Middleware Configuration DVD underthe delref\etc directory to the ITDS_INSTANCE_HOME\etc directory. Forexample, copy the file to the C:\idsslapd-ldapdb2\etc directory.
 4. Edit the ibmslapd.conf configuration file for IBM Tivoli Directory Server in thefollowing directory:v UNIX: ITDS_INSTANCE_HOME/etc. For example, locate the file in the
 /home/instance_owner_name/etc directory.v Windows: ITDS_INSTANCE_HOME\etc. For example, locate the file in the
 C:\idsslapd-idsinst\etc directory.5. In the configuration file, specify the referential integrity file for Tivoli Identity
 Manager:a. Locate the following line:
 ibm-slapdPlugin: database path_to_rdbmfilename rdbm_backend_init
 The path_to_rdbmfilename variable is one of the following files:v AIX: /lib/libback-rdbm.av UNIX other than AIX: /lib/libback-rdbm.sov Windows: \lib\libback-rdbm.dll
 The Windows path is specified with a forward slash.b. Add the following line, all on one line, directly after the previous line (for
 64-bit environments, replace lib with lib64):v Solaris:
 ibm-slapdPlugin: preoperationITDS_HOME/lib/lib_filename DeleteReferenceInitfile="ITDS_INSTANCE_HOME/etc/timdelref.conf" dn="itim_suffix"
 v UNIX other than Solaris:ibm-slapdPlugin: preoperationITDS_HOME/lib/lib_filename DeleteReferenceInitfile=ITDS_INSTANCE_HOME/etc/timdelref.conf dn=itim_suffix
 v Windows:ibm-slapdPlugin: preoperation "ITDS_HOME/lib/lib_filename"DeleteReferenceInit file="ITDS_INSTANCE_HOME/etc/timdelref.conf"dn=itim_suffix
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Notes:
 1) The ITDS_HOME variable is the default installation directory for theIBM Tivoli Directory Server. The lib_filename variable is the name ofthe referential integrity plug-in filename, as identified in step 2 onpage 32.
 2) The itim_suffix variable is a value such as dc=com.3) On the Windows operating system, to specify the path to the
 libdelref.dll and the timdelref.conf files, ensure that you enclose thevalue of lib_filename in quotation marks. Additionally, specify the pathto the libdelref.dll file with a forward slash (/).
 6. Save the changes that you made to the configuration file.7. Start the IBM Tivoli Directory Server.8. Determine whether the referential integrity plug-in is reconfigured and loaded
 appropriately. Locate the IBM Tivoli Directory Server log file for theconfiguration.
 Windows:ITDS_INSTANCE_HOME\logs\ibmslapd.log. For example, the file is inthe C:\idsslapd-ldapdb2\logs directory.
 UNIX/Linux:ITDS_INSTANCE_HOME/etc/ibmslapd.log. On Linux, for example, thefile is in the /home/ldapdb2/idsslapd-ldapdb2/etc/logs directory.
 You see a message like this one:Plugin of type PREOPERATION is successfully loadedfrom /usr/ldap/lib/libdelref.a
 If you stop and start the IBM Tivoli Directory Server multiple times, more thanone message occurs in the log file. Examine the timestamp on the most recentmessage in the file. If the operation does not succeed, ensure that the referentialintegrity plug-in and configuration files are in their target directories.
 IBM Tivoli Directory Server versions 6.2:
 1. Stop the IBM Tivoli Directory Server.2. Copy the timdelref.conf file from the Middleware Configuration DVD under
 the delref\etc directory to the ITDS_INSTANCE_HOME\etc directory. Forexample, copy the file to the C:\idsslapd-idsinst\etc directory.
 3. Edit the ibmslapd.conf configuration file for IBM Tivoli Directory Server in thefollowing directory:v UNIX: ITDS_INSTANCE_HOME/etc. For example, locate the file in the
 /home/instance_owner_name/etc directory.v Windows: ITDS_INSTANCE_HOME\etc. For example, locate the file in the
 C:\idsslapd-idsinst\etc directory.4. In the configuration file, specify the referential integrity file for Tivoli Identity
 Manager:a. Locate the line that starts ibm-slapdPlugin: preoperation
 \lib\libdelref.dll DeleteReferenceInit and edit the file and dn values.If the line does not exist, add this sample and edit the file and dn values.ibm-slapdPlugin: preoperation \lib\libdelref.dll DeleteReferenceInitfile=C:\idsslapd-ldaptest\etc\tdsdelref.conf dn=o=sample
 where C:\idsslapd-ldaptest\etc\tdsdelref.conf is the path where you copied thetimdelref.conf file and o=sample is the suffix you used for the Tivoli IdentityManager LDAP database.
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b. Ensure that the ibm-slapdReferentialIntegrityPlugin attribute is set totrue otherwise the plug-in does not get loaded. The default setting is false.ibm-slapdReferentialIntegrityPlugin: TRUE
 c. Save the changes that you made to the configuration file.d. Start the IBM Tivoli Directory Server.e. Determine whether the referential integrity plug-in is reconfigured and
 loaded appropriately. Locate the IBM Tivoli Directory Server log file for theconfiguration.
 Windows:ITDS_INSTANCE_HOME\logs\ibmslapd.log. For example, the file isin the C:\idsslapd-ldapdb2\logs directory.
 UNIX/Linux:ITDS_INSTANCE_HOME/etc/ibmslapd.log. On Linux, for example,the file is in the /home/ldapdb2/idsslapd-ldapdb2/etc/logsdirectory.
 You see a message like this one:Plugin of type PREOPERATION is successfully loadedfrom /usr/ldap/lib/libdelref.a
 If you stop and start the IBM Tivoli Directory Server multiple times, morethan one message occurs in the log file. Examine the timestamp on the mostrecent message in the file. If the operation does not succeed, ensure that thereferential integrity plug-in and configuration files are in their targetdirectories.
 Manually tuning the IBM Tivoli Directory Server databaseYou can manually tune the performance of the DB2 instance that IBM TivoliDirectory Server uses. Complete these steps:1. Open a DB2 command window.v UNIX: Log on as the DB2 instance owner and enter db2 to open a DB2
 command window.v Windows: Click Start > Run, and enter db2cmd. When the DB2 command
 window opens, enter db2.2. In the DB2 command window, enter these commands to tune the IBM Tivoli
 Directory Server database instance:db2 connect to itds_dbname user itds_dbadmin_name using itds_dbadmin_passworddb2 alter bufferpool IBMDEFAULTBP size automaticdb2 alter bufferpool ldapbp size automaticdb2 update db cfg for itds_dbname using logsecond 12db2 update db cfg for itds_dbname using logfilsiz 10000db2 update db cfg for itds_dbname using database_memory itds_dbmemorydb2 disconnect current
 The value of itds_dbname is a name such as ldapdb2. The value of itds_dbmemoryis 40000 for a single-server installation, COMPUTED for all platforms except AIXand Windows. For AIX and Windows, the value is AUTOMATIC. For moreinformation about performance parameter tuning for DB2, refer to the IBMTivoli Identity Manager Performance Tuning Guide.
 3. Stop and start the DB2 server to reset the configuration.After you have reset the configuration, stop and start the DB2 server to allowthe changes to take effect. Enter the following commands:db2stopdb2start
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If entering db2stop fails and the database remains active, enter db2 forceapplication all to deactivate the database. Enter db2stop again.
 Sun Enterprise Directory ServerThis section describes installing and configuring Sun Enterprise Directory Server.
 Installing Sun Enterprise Directory ServerFor the instructions and more information about installing the Sun EnterpriseDirectory Server, refer to documentation available at these Web sites:
 http://www.sun.com/software/products/directory_srvr_ee/index.html
 http://docs.sun.com/app/docs/coll/1224.4
 http://www.sun.com/software/products/directory_srvr_ee/get.jsp
 Configuring Sun Enterprise Directory ServerTo configure the Sun Enterprise Directory Server, complete these steps:1. Create a Tivoli Identity Manager LDAP server instance. Issue the command:
 dsadm.sh create dsadm create -p portnumber -P SSL-port instance-path
 Where portnumber the port number for the Sun Enterprise Directory Server andSSL-port is the SSL port number for the Sun Enterprise Directory Server. Forexamples:v For UNIX systems, dsadm.sh create –p 1389 –P 1363 /local/itimldap
 v For Windows systems, dsadm.exe create –p 1389 –P 1363 C:\itimldap
 2. Start the Tivoli Identity Manager LDAP server. Issue the command:dsadm.sh start instance-path
 For example,dsadm.sh start /local/itimldap
 3. Create a root suffix. Issue the command:dsconf.sh create-suffix –h host –p portnumber rootsuffix
 For example,dsconf.sh create-suffix –h localhost –p 1389 dc=com
 This command creates the root suffix dc=com on the Tivoli Identity ManagerLDAP server.If you receive an Unable to bind securely on host:portNumber message, usethe -unsecured parameter:dsconf create-suffix –unsecured –h localhost –p 1389 dc=com
 4. Create and save a file called dcequalscom.ldif with the following content:dn:dc=comdc:comobjectclass:topobjectclass:domain
 5. Import the dcequalscom.ldif file to the dc=com root suffix. Issue the command:dsconf.sh import -h hostname -p portnumber path/dcequalscom.ldif rootsuffix
 For example,
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dsconf.sh import -h localhost -p 1389 /temp/dcequalscom.ldif dc=com
 If you receive an Unable to bind securely on host:portNumber message, usethe -unsecured parameter:dsconf.sh import -unsecured -h localhost -p 1389 /temp/dcequalscom.ldif dc=com
 6. Restart the directory server.
 Note: Sun Enterprise Directory Server access control instructions might haveenabled anonymous read access. To provide more secure data, modify thedefault access control instructions to disable anonymous read access. Formore information, refer to the Sun Enterprise Directory Serverdocumentation.
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Chapter 4. Optionally installing IBM Tivoli Directory Integrator
 IBM Tivoli Directory Integrator synchronizes and manages information exchangesbetween applications or directory sources. This chapter focuses on installing theIBM Tivoli Directory Integrator for use by Tivoli Identity Manager. The supportedversions and required fix packs for IBM Tivoli Directory Integrator are described inthe Tivoli Identity Manager Information Center.
 The information in this chapter is not a substitute for the more extensive,prerequisite documentation that is provided by the directory integrator productitself.
 Before you install the directory integrator productBefore you install IBM Tivoli Directory Integrator, complete these steps:v Read the installation guide that the directory integrator product provides.v Ensure that your installation meets the directory integrator hardware and
 software requirements.– IBM Tivoli Directory Integrator
 - Hardware and software requirements, and documentationhttp://www.ibm.com/software/sysmgmt/products/support/J958636N88774A05-doc.html
 - Fixeshttp://www.ibm.com/software/sysmgmt/products/support/IBMDirectoryIntegrator.html
 Installing IBM Tivoli Directory IntegratorYou can install the IBM Tivoli Directory Integrator on the same computer withTivoli Identity Manager or on a separate computer.
 Installing IBM Tivoli Directory IntegratorFor information about installing IBM Tivoli Directory Integrator, refer todocumentation that the product provides. For example, access this Web site:
 http://www.ibm.com/software/sysmgmt/products/support/J958636N88774A05-doc.html
 Installing the required fix packsIf your version of the IBM Tivoli Directory Integrator requires a fix pack, obtainand install the fixes. For more information, refer to this support Web site:v Support
 http://www.ibm.com/software/sysmgmt/products/support/IBMDirectoryIntegrator.html
 v Information centerhttp://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/index.jsp?toc=/com.ibm.IBMDI.doc/toc.xml
 © Copyright IBM Corp. 2009 39
 http://www.ibm.com/software/sysmgmt/products/support/J958636N88774A05-doc.html
 http://www.ibm.com/software/sysmgmt/products/support/J958636N88774A05-doc.html
 http://www.ibm.com/software/sysmgmt/products/support/IBMDirectoryIntegrator.html
 http://www.ibm.com/software/sysmgmt/products/support/IBMDirectoryIntegrator.html
 http://www.ibm.com/software/sysmgmt/products/support/J958636N88774A05-doc.html
 http://www.ibm.com/software/sysmgmt/products/support/J958636N88774A05-doc.html
 http://www.ibm.com/software/sysmgmt/products/support/IBMDirectoryIntegrator.html
 http://www.ibm.com/software/sysmgmt/products/support/IBMDirectoryIntegrator.html
 http://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/index.jsp?toc=/com.ibm.IBMDI.doc/toc.xml
 http://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/index.jsp?toc=/com.ibm.IBMDI.doc/toc.xml

Page 56
                        

Installing agentless adaptersAdapters allow Tivoli Identity Manager to manage resources. Agent-based adaptersrequire the installation of the adapter on the managed resource, and theinstallation of an adapter profile on the Tivoli Identity Manager server. Agentlessadapters require adapter installation on the computer that hosts IBM TivoliDirectory Integrator, and the installation of an adapter profile on the Tivoli IdentityManager server.
 You can install IBM Tivoli Directory Integrator on the same computer as TivoliIdentity Manager or remotely. If you install Tivoli Identity Manager locally, theTivoli Identity Manager installation program automatically installs agentlessadapters and you can also choose to automatically install agentless adapterprofiles. If you install Tivoli Identity Manager remotely, you must manually installthe agentless adapters on the computer that hosts IBM Tivoli Directory Integrator,and manually install agentless adapter profiles on the computer that hosts TivoliIdentity Manager.
 For more information about manually installing agentless adapters, see “Manuallyinstalling agentless adapters and adapter profiles” on page 81.
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Chapter 5. Installing and configuring WebSphere ApplicationServer
 WebSphere Application Server delivers a secure, scalable application infrastructurefor Tivoli Identity Manager Server. WebSphere Application Server can run in asingle-server or a cluster server environment.
 This chapter describes generic steps to create a WebSphere Application Serverenvironment before you install the Tivoli Identity Manager Server in either thesingle-server or cluster configurations. The supported releases and required fixpacks for WebSphere Application Server are described in the Tivoli Identity ManagerInformation Center.
 Before you install WebSphere Application ServerBefore you install WebSphere Application Server, complete the following tasks:v Read the WebSphere Application Server installation guide.v Determine whether you are installing WebSphere Application Server in a
 single-server or cluster environment.v Ensure that your system meets the product hardware and software requirements.v Ensure that all required operating system fix packs are in place. For more
 information about tuning operating systems for the WebSphere ApplicationServer, refer to this Web site:http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/topic/com.ibm.websphere.nd.doc/info/ae/ae/tprf_tuneopsys.html
 For more information about installing the WebSphere Application Server, refer tothe following Web sites:v Hardware and software requirements
 http://www.ibm.com/support/docview.wss?rs=180&uid=swg27006921v Support
 http://www.ibm.com/software/webservers/appserv/was/support/v Information center
 http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp
 Installing the WebSphere Application Server productWebSphere Application Server Version 6 introduces the concept of a profile inwhich installing the product becomes a two-step process:1. Install a shared set of core product files using the WebSphere Application
 Server installation product.2. Use profiles to define multiple application server runtime environments, each
 with its own administrative interfaces, that share the core files. Profiles arenecessary for the environment to function. There are three types of profileswhich can be created:v Application server: Can run as a stand-alone node or run as part of a
 deployment manager cell.v Deployment manager: Provides centralized management of application
 servers.
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v Custom: Must be federated and then customized through the deploymentmanager. A custom profile does not have its own administrative console. It ismanaged under the deployment manager node.
 For example, once the core files have been installed, create one or moredeployment manager profiles, application server profiles, or custom profiles. Aprofile can be created at any time after installation by using the Profile Creationwizard GUI or the manageprofiles command.
 Additional configuration steps are required if you want to install the IBM HTTPServer and WebSphere Web Server plug-in.
 For more information about installing the IBM HTTP Server, refer to the followingWeb site:http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=/com.ibm.websphere.ihs.doc/info/welcome_ihs.html
 For more information about planning to install the WebSphere Web Server plug-in,refer to the following Web site:http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=/com.ibm.websphere.nd.doc/info/ae/ae/tins_scenario5.html
 Installing WebSphere Application Server in a single-serverenvironment
 To install WebSphere Application Server in a single-server environment, completethese steps:1. Install the WebSphere Application Server product from the root user on UNIX
 systems, or from a user with administrator authority on the Windowsoperating system.
 2. Start the WebSphere Application Server installation program.3. Select the Application Server profile.4. By default, administrative security is enabled. Enabling administrative security
 protects your server from unauthorized users.5. Enter any additional values that the WebSphere installation program requires.6. When installation is complete, download and install the Update Installer for
 WebSphere Application Server from the product support Web site.7. Use the Update Installer to install a service pack containing WebSphere
 Application Server Version 6.1.0.23 or later. Make sure that you use the sameoperating system administrator account that you used for the installation.
 8. Ensure that you are using the IBM Java 2 Platform Standard EditionDevelopment Kit 1.5 Service Release 6 or later. Service Release 6 is needed ifyou intend to enable Java 2 security. You can download the service release andfollow the instructions to apply the fix at the following WebSphereApplication Server fix pack Web site:http://www-1.ibm.com/support/docview.wss?rs=180&uid=swg24017492
 9. After you apply the WebSphere Application Server fix pack, start theWebSphere Application Server using the following command:v Windows, run the following command:
 – WAS_PROFILE_HOME\bin\startServer.bat server_name
 v UNIX/Linux, run the following command:– WAS_PROFILE_HOME/bin/startServer.sh server_name
 42 IBM Tivoli Identity Manager Server: Installation and Configuration Guide
 http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=/com.ibm.websphere.ihs.doc/info/welcome_ihs.html
 http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=/com.ibm.websphere.ihs.doc/info/welcome_ihs.html
 http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=/com.ibm.websphere.nd.doc/info/ae/ae/tins_scenario5.html
 http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=/com.ibm.websphere.nd.doc/info/ae/ae/tins_scenario5.html
 http://www-1.ibm.com/support/docview.wss?rs=180&uid=swg24017492

Page 59
                        

The value of server_name is the name of the WebSphere Application Server.For example, server1.
 10. Open the First Steps panel for WebSphere Application Server and clickInstallation Verification to verify that there are no installation problems. Torun the first steps, use the following command:v Windows:
 – WAS_PROFILE_HOME\firststeps\firststeps.batv UNIX/Linux:
 – WAS_PROFILE_HOME/firststeps/firststeps.sh11. Verify that the WebSphere Application Server fix pack is at the correct level.
 Enter one of these commands:v Windows:
 WAS_PROFILE_HOME\bin\versionInfo.bat
 v UNIX:WAS_PROFILE_HOME/bin/versionInfo.sh
 For example, the version is like the following output:v WebSphere Application Server base
 Installed Product-----------------------------------------------Name IBM WebSphere Application ServerVersion 6.1.0.23ID BASE
 12. Use the following Web address to access the WebSphere administrativeconsole:http://hostname:port/ibm/console
 The value of hostname is either the fully qualified host name or the IP addressof the computer on which you installed the WebSphere Application Serverbase product. The value of port is the port number for the WebSphereadministrative HTTP transport. The default value is 9060. The port numbermight not be 9060 if there is another instance of the WebSphere ApplicationServer on the computer.
 13. Examine the SystemOut.log and SystemErr.log files in theWAS_PROFILE_HOME\logs\server_name to ensure that there are no otherproblems. For more information, see “Log files” on page 101.
 Once you have completed the installation, the next step is installing IBM TivoliDirectory Server. For more information, see “Installing and configuring IBM TivoliDirectory Server” on page 27.
 Installing WebSphere Application Server in a clusterenvironment
 To install WebSphere Application Server in a cluster environment, complete thesesteps:1. Install the WebSphere Application Server package, and create a deployment
 manager profile.2. Install the WebSphere Application Server package, create a custom profile, and
 federate the node to the cell managed by the deployment manager on eachcomputer in the cluster.
 3. Optionally install and configure IBM HTTP Server and WebSphere Web Serverplug-in.
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Install the WebSphere Application Server deployment managerTo install WebSphere Application Server deployment manager, complete thesesteps:1. Install the WebSphere Application Server product from the root user on UNIX
 systems, or from a user with administrator authority on the Windowsoperating system.
 2. Start the WebSphere Application Server installation program.3. Select the Deployment Manager profile.4. By default, administrative security is enabled. Enabling administrative security
 protects your server from unauthorized users.5. Enter any additional values that the WebSphere installation program requires.6. When installation is complete, download and install the Update Installer for
 WebSphere Application Server from the product support Web site.7. Use the Update Installer to install a service pack containing WebSphere
 Application Server Version 6.1.0.23 or later. Make sure that you use the sameadministrator account that you used for the installation.
 8. Ensure that you are using the IBM Java 2 Platform Standard EditionDevelopment Kit 1.5 Service Release 6 or later. Service Release 6 is needed ifthe user intends to enable Java 2 security. You can download the servicerelease and follow the instructions to apply the fix at the following WebSphereApplication Server fix pack Web site:http://www-1.ibm.com/support/docview.wss?rs=180&uid=swg24017492
 9. Start the deployment manager using the following command:v Windows:
 WAS_NDM_PROFILE_HOME\bin\startManager.bat
 v UNIX/Linux:WAS_NDM_PROFILE_HOME/bin/startManager.sh
 10. Open the First Steps panel for WebSphere Application Server and clickInstallation Verification to verify that there are no installation problems. Torun the First Steps panel, use the following command:v Windows:
 – WAS_NDM_PROFILE_HOME\firststeps\firststeps.batv UNIX/Linux:
 – WAS_NDM_PROFILE_HOME/firststeps/firststeps.sh11. Verify that the WebSphere Application Server fix pack is at the correct level.
 Enter one of these commands:v Windows:
 – Cluster memberWAS_PROFILE_HOME\bin\versionInfo.bat
 – Deployment managerWAS_NDM_PROFILE_HOME\bin\versionInfo.bat
 v UNIX:– Cluster member
 WAS_PROFILE_HOME/bin/versionInfo.sh
 – Deployment managerWAS_NDM_PROFILE_HOME/bin/versionInfo.sh
 For example, the version is like the following output:v WebSphere Application Server base
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Installed Product-----------------------------------------------Name IBM WebSphere Application ServerVersion 6.1.0.23ID BASE
 v Deployment managerInstalled Product-----------------------------------------------Name IBM WebSphere Application Server Deployment ManagerVersion 6.1.0.23ID ND
 12. Use the following Web address to access the WebSphere administrativeconsole:http://hostname:port/ibm/console
 The value of hostname is either the fully qualified host name or the IP addressof the computer on which you installed the WebSphere Application Serverbase product. The value of port is the port number for the WebSphereadministrative HTTP transport. The default value is 9060. The port numbermight not be 9060 if there is another instance of the WebSphere ApplicationServer on the computer.
 13. Examine the SystemOut.log and SystemErr.log files in theWAS_NDM_PROFILE_HOME\logs\dm_server_name directory to ensure thatthere are no other problems.
 Install the WebSphere Application Server product on each nodememberInstall WebSphere Application Server on each computer on which Tivoli IdentityManager Server runs as a Tivoli Identity Manager cluster member and federateeach node member to the cell.
 To install WebSphere Application Server on each cluster member host, completethese generic steps:1. Install the WebSphere Application Server product from the root user on UNIX
 systems, or from a user with administrator authority on the Windows operatingsystem.
 2. Start the WebSphere Application Server installation program.3. Select the Custom profile.4. In the Federation panel, complete these fields:
 a. Type the host name or IP address of the deployment manager.b. Type the SOAP port of the deployment manager or accept the default port.c. If administrative security is enabled, type the deployment manager
 administrative user name and password.5. When installation is complete, download and install the Update Installer for
 WebSphere Application Server from the product support Web site.6. Use the Update Installer to install a service pack containing WebSphere
 Application Server Version 6.1.0.23 or later. Make sure that you use the sameadministrator account that you used for the installation.
 7. Ensure that you are using the IBM Java 2 Platform Standard EditionDevelopment Kit 1.5 Service Release 6 or later. Service Release 6 is needed ifthe user intends to enable Java 2 security. You can download the service releaseand follow the instructions to apply the fix at the following WebSphereApplication Server fix pack Web site:http://www-1.ibm.com/support/docview.wss?rs=180&uid=swg24017492
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8. After you apply the WebSphere Application Server fix pack, verify the status ofthe WebSphere Application Server node agent using the following command:v Windows systems:
 WAS_PROFILE_HOME\bin\startNode.bat
 v UNIX or Linux systems:WAS_PROFILE_HOME/bin/startNode.sh
 9. Open the First Steps panel for WebSphere Application Server and clickInstallation Verification to verify that there are no installation problems. Torun the first steps, use the following command:v Windows:
 – WAS_PROFILE_HOME\firststeps\firststeps.batv UNIX/Linux:
 – WAS_PROFILE_HOME/firststeps/firststeps.sh
 Manually federate a WebSphere Application Server node memberThis step is optional if you either used a custom profile but did not federate thenode to the cell during installation, or you created a base WebSphere ApplicationServer profile, which does not federate the node member during installation. Tomanually federate a WebSphere Application Server node member, run the addnodecommand:v Windows:
 WAS_HOME\bin\addNode.bat dmgr_host portnumber -profileName profile_name
 v UNIX/Linux:WAS_HOME/bin/addNode.sh dmgr_host portnumber -profileName profile_name
 The value of WAS_HOME is the location of the WebSphere Application Serverhome directory where the WebSphere Application Server core files are installed.The dmgr_host parameter is the host name of the computer on which thedeployment manager is installed. The portnumber parameter specifies the SOAPport number that is assigned to the deployment manager. The default portnumber is 8887.A node agent is created and started after a node is successfully added to a cell.
 Verify the federation of nodes within the cellTo verify that all nodes have been federated and are running, complete these steps:1. Use the following Web address to access the WebSphere administrative console:
 http://hostname:port/ibm/console
 The value of hostname is either the fully qualified host name or the IP addressof the WebSphere Application Server deployment manager. The value of port isthe port number for the WebSphere administrative HTTP transport. The defaultvalue is 9060. The port number might not be 9060 if there is another instance ofthe WebSphere Application Server on the computer.
 2. Click System administration from the Integrated Solutions Console rootstructure. Click Nodes. Verify that the manager node and federated nodes arelisted and are available. You can also click Nodeagent to see the status of allnodeagents.
 Create the WebSphere clusters for the Tivoli Identity ManagerapplicationTivoli Identity Manager requires the creation of two server clusters in yourWebSphere Application Server environment. One cluster is used to host the TivoliIdentity Manager application. The other cluster is used as a messaging service.
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Before you create the cluster, make sure that all nodeagents are up. To create theWebSphere Application Server clusters, complete these steps:1. Use the following Web address to access the WebSphere administrative
 console:http://hostname:port/ibm/console
 The value of hostname is either the fully qualified host name or the IP addressof the WebSphere Application Server deployment manager. The value of portis the port number for the WebSphere administrative HTTP transport. Thedefault value is 9060. The port number might not be 9060 if there is anotherinstance of the WebSphere Application Server on the computer.
 2. Click Servers from the Integrated Solutions Console root structure.3. For WebSphere Application Server 6.1 deployment manager console, Click
 Clusters, and click New.4. Specify the name of the host application cluster. For example,
 ITIM_Application_Cluster. The cluster name must be unique within the cell.Use the default check box settings, and click Next.
 5. Specify a member name for the first cluster member.6. Specify the node you want to use to host the first cluster member.7. Click the radio button adjacent to Create the member using an application
 server template and select default.8. Keep all other default settings and click Next.9. Create a cluster member for each additional node by specifying a member
 name, selecting a node, and clicking Add Member. Tivoli Identity Managerdoes not support multiple cluster members on a single node. Click Next whenyou have finished adding cluster members.
 10. Verify the summary of information and click Finish.11. Repeat this process for the messaging cluster, specifying unique names for the
 messaging cluster and cluster members, such as ITIM_Messaging_Cluster.12. When you have finished creating the second cluster, click on Servers from the
 Integrated Solutions Console root structure. Click Clusters, and verify thatyour clusters appear.
 13. Click the name of each cluster, and click Cluster members to view detailedinformation about each cluster member.
 Optionally installing and configuring IBM HTTP Server andWebSphere Web Server plug-inAlthough you can install the IBM HTTP Server and the WebSphere Web Serverplug-in on the same computer that has the deployment manager, you might wantto install the IBM HTTP Server and the WebSphere Web Server plug-in on aseparate computer for additional security and load balancing.
 For more information on installing IBM HTTP Server, refer to the following Website:http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=/com.ibm.websphere.ihs.doc/info/welcome_ihs.html
 For more information planning to install the WebSphere Web Server plug-in, referto the following Web site:http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=/com.ibm.websphere.nd.doc/info/ae/ae/tins_scenario5.html
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Change TCP KeepAlive settings on WebSphere ApplicationServerThe failover design of the messaging engine relies upon the database connectionsbeing broken when a messaging engine instance fails. In order for failover to occurin high availability environments, ensure that the system detects the brokenconnection in a timely manner and releases database locks. This task is done byconfiguring the TCP KeepAlive settings. For example, if you are using Linux, loginas an administrator and complete these steps on all WebSphere Application Servernodes:1. Run the following command:
 echo 30 > /proc/sys/net/ipv4/tcp_keepalive_intvl
 Note: These settings are also used by IPv6 implementations.2. Ensure that the value of the heartbeat interval is set to 30 seconds:
 a. From the WebSphere Application Server administrative console, clickServers > Core groups > Core group settings > Default core group.
 b. Under the Additional properties section, click Custom properties. Verifythat this value is not blank. If it is not blank, change the values specified forthe IBM_CS_FD_PERIOD_SECS custom property. This property specifies thetime interval, in seconds, between consecutive heartbeats. The default valuefor this property is 30 seconds.
 Note: These settings are also used by IPv6 implementations.
 Tuning WebSphere Application Server for performancePerformance issues can occur after you initially configure WebSphere ApplicationServer These tasks describe actions you can take to ensure WebSphere ApplicationServer performs correctly.
 Disable Performance Monitoring Infrastructure (PMI) trackingBy default, WebSphere Application Server has the Performance MonitoringInfrastructure (PMI) enabled and set at the Basic level. At this level,URIRequestCount and URIServiceTime monitoring is enabled. These enablementscause performance problems when using the Console GUI due to the unique URLsthat are generated for that interface. To prevent performance degradation, eitherdisable PMI entirely or disable these specific PMI flags. Complete these steps:1. Log in to the WebSphere administrative console.2. From the left navigation pane, click Monitoring and Tuning > Performance
 Monitoring Infrastructure (PMI).3. Click the name of the server you want to manage.4. Select Custom and click the Custom link.5. Select Web Applications from the tree listing.6. Select URIConcurrentRequests.7. Select URIRequestCount.8. Select URIServiceTime.9. Click Disable at the top of the pane.
 10. Click Save to save the configuration.11. Repeat this procedure for each application server that run Tivoli Identity
 Manager.12. Restart all application servers for the changes to take effect.
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Chapter 6. Installing Tivoli Identity Manager
 This chapter describes tasks that install and configure the Tivoli Identity ManagerServer in a single-server or a cluster configuration. The installation programinstalls only the Tivoli Identity Manager Server.
 You can also install and configure Tivoli Identity Manager silently. For moreinformation, see Chapter 8, “Performing a silent installation and configuration ofTivoli Identity Manager,” on page 85.
 Installing Tivoli Identity Manager in a single-server configurationThis section describes tasks that install and configure the Tivoli Identity ManagerServer in a single-server configuration. The installation program installs only theTivoli Identity Manager Server.
 Before you beginBefore you begin to install Tivoli Identity Manager Server in a single-serverenvironment, complete these tasks:1. Determine which product DVDs that you need to install Tivoli Identity
 Manager. For an itemization of the DVD contents, refer to a text file such asitim-5.1-dvd-images-operatingsystem.txt that is provided with the DVD image.For a complete list of these image files, see Appendix C, “Installation imagesand fix packs,” on page 137.
 2. Ensure that free disk space and memory requirements are met. Additionally,ensure that there is adequate free disk space in the system temp directory andin the WAS_PROFILE_HOME directory. The target computer must meet thecomputer requirements described in the Tivoli Identity Manager InformationCenter.
 3. Ensure that you have the needed administrative authority. On Windowssystems, the logon user ID must be in the Administrators Group. On UNIXsystems, the logon user ID must be root.
 4. Installing the Tivoli Identity Manager Server writes data to the Tivoli IdentityManager database.
 5. If you are using IBM Tivoli Directory Server, ensure that you have run themiddleware configuration utility or that the directory server has loaded theappropriate referential integrity plug-in. For more information, see “Manuallyconfiguring the referential integrity plug-in on the IBM Tivoli Directory Server”on page 32.
 6. Ensure that the prerequisite applications as described in Table 3 are installedand running:
 Table 3. Prerequisite applications
 Prerequisite For more information, see
 Database Chapter 2, “Installing and configuring a database,” on page 9
 Directory server Chapter 3, “Installing and configuring a directory server,” onpage 27
 Directory integrator(optional)
 Chapter 4, “Optionally installing IBM Tivoli DirectoryIntegrator,” on page 39
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Table 3. Prerequisite applications (continued)
 Prerequisite For more information, see
 WebSphere ApplicationServer
 Chapter 5, “Installing and configuring WebSphere ApplicationServer,” on page 41
 Only Tivoli Identity Manager and WebSphere Application Server requireinstallation on the same computer. All other applications can be run locally orremotely to the computer on which Tivoli Identity Manager is installed. IBMTivoli Directory Integrator is an optional component.
 7. Ensure that the WebSphere Application Server can be stopped and startedbefore you install the Tivoli Identity Manager Server. To be sure, stop and startthe WebSphere Application Server. See Chapter 5, “Installing and configuringWebSphere Application Server,” on page 41 for more information about thesesteps.
 8. Capture the details of your configuration. For a detailed list of configurationparameters, see Appendix D, “Worksheets,” on page 139.
 9. If you are upgrading a version of Tivoli Identity Manager that is already on thecomputer, see Chapter 10, “Upgrading to Tivoli Identity Manager Version 5.1,”on page 103 for more information about protecting Tivoli Identity Managercustomizations and data.
 Starting the installation wizardTo install the Tivoli Identity Manager Server in a single-server configuration,complete the following steps:1. Log on to an account with system administration privileges on the computer
 where the Tivoli Identity Manager Server is to be installed.2. Install the installation program, or insert the Tivoli Identity Manager product
 DVD into the DVD drive. To locate the correct DVD for your environment,refer to Appendix C, “Installation images and fix packs,” on page 137.
 3. To run the installation program, complete these steps:v Windows:
 a. Click Start > Run.b. Enter the drive and path where the installation program is located and
 then enter the following command:instwin.exe
 The Welcome window opens.v UNIX/Linux:
 a. Open a command shell prompt window, and navigate to the directorywhere the installation program is located.
 b. Enter the following command for the Tivoli Identity Manager installationprogram:– AIX:
 instaix.bin
 – Linux:instlinux.bin
 – pLinux:instplinux.bin
 – zLinux:instzlinux.bin
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– Solaris:instsol.bin
 The installation program starts and displays the Welcome window.If you are running the installation program on a UNIX/Linux system thatdoes not have at least 150MB of free space in the /tmp directory, you shouldset the IATEMPDIR environment variable to a directory on a disk partitionwith enough free disk space. To set the variable, enter one of the followingcommands at the command line prompt before running the installationprogram again:– Bourne shell (sh), ksh, bash, and zsh:
 $ IATEMPDIR=temp_dir$ export IATEMPDIR
 – C shell (csh) and tcsh:$ setenv IATEMPDIR temp_dir
 where temp_dir is the path to the directory, for example /your/free/directory, where free disk space is available.
 Completing the installation wizard pagesUse the first set of installation wizard pages to set up the installation.
 The dollar sign ($) has special meaning in the installer frameworks used by InstallAnywhere. Avoid using $ in any field values. The installer framework or operatingsystem platform might do variable substitution for the value.
 To complete the installation wizard pages, complete these steps:1. To change the language that is used for the installation wizard pages, select
 another language from the drop-down list. This choice only affects theinstallation wizard and not the language version of Tivoli Identity Manager tobe installed. Then, click OK.
 Note: The license is always shown in the system locale of the machine andnot the installation language selected.
 2. Click Next to advance past the copyright and legal text.3. In the License Agreement window, read the license agreement and decide
 whether to accept its terms. Optionally click Read non-IBM terms to read theterms of any non-IBM products or Print to print out the license agreement. Toaccept the terms and continue with the installation, select Accept, and thenclick Next.
 4. Accept the default ITIM_HOME installation directory, or select Choose toselect another directory. Then, click Next.
 5. In the Installation Type window, select Single WebSphere Application Server.Then, click Next.
 6. The WebSphere Application Server Installation Directory window appears anddisplays a value for the WebSphere Application Server installation directory,or WAS_HOME, directory.There can be multiple installations of the WebSphere Application Server on acomputer. If the directory displayed is not the directory in which you intendto install the Tivoli Identity Manager Server, click Choose, enter the correctdirectory value, and click Next.
 7. From the WebSphere profile selection panel, select the WebSphere ApplicationServer profile name in which Tivoli Identity Manager is to be installed fromthe list, and click Next.
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8. In the next window, verify the following WebSphere Application Server data:v WebSphere Application Server name, which defaults to server1, where you
 intend to deploy the Tivoli Identity Manager Server.v Host name of the computer. Accept the displayed value unless the
 computer has multiple host names and the WebSphere Application Server isinstalled under a host name other than the displayed value.
 Verify the WebSphere Application Server data and click Next.9. If WebSphere Application Server administrative security is on, you are
 prompted to specify the administrator user ID and password, then click Next.10. In the Database Type window, select one of the following database types, and
 then click Next:v DB2 Databasev Oracle Databasev Microsoft SQL Server (only listed for Windows operating systems)Caution windows open to prompt you to confirm that these conditions aretrue:v If DB2 is selected, click Continue.v If the Oracle database or the Microsoft SQL server is selected, a window
 prompts you for the location and name of the JDBC driver. Provide thelocation and name, and click Next. For more information see “Installing theOracle JDBC driver” on page 21 and “Installing the SQL Server JDBCdriver” on page 25.
 v The directory server version is at the correct level. Confirm that the versionis correct and click Continue.
 11. A Keystore Password window requires you to specify the keystore password.The keystore password entered here is used to unlock the Tivoli IdentityManager keystore file which stores the encryption key used to encrypt TivoliIdentity Manager sensitive data. Then, click Next.
 12. A window appears to choose whether to install Agentless Adapters on IBMTivoli Directory Integrator.The Tivoli Identity Manager installation program installs these POSIX adaptersfor the following managed resources:v AIXv HP-UXv LDAPv Linuxv Solaris
 Installation programs for the agentless adapters that are installed by the TivoliIdentity Manager installation program are located in the ITIM_HOME\config\adapters directory so that you can reinstall adapters later if needed. Eventhough the Tivoli Identity Manager installation program installs POSIXadapters, it is recommended that you install the latest adapter profiles. Formore information about manual adapter installation, see “Manually installingagentless adapters and adapter profiles” on page 81.Select an option, and click Next.
 Note: If IBM Tivoli Directory Integrator is installed remotely, select Do NotInstall Agentless Adapters.
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13. In the Directory Integrator Home Directory window, enter or confirm thecorrect directory value, optionally click Choose to enter an alternate location,and click Next.
 14. In the Tivoli Common Directory window, accept the default directory that theTivoli Identity Manager installation program defines, or choose a new one.Then, click Next. Ensure that the directory has at least 25 MB of free space.The Tivoli Common Directory is the central location for allserviceability-related files, such as logs and first-failure capture data.
 15. In the Single Server Pre-Installation Summary window, review thecomponents to be installed, the Tivoli Identity Manager installation directory,your choice to install agentless adapters, the WebSphere Application Serverinstallation directory, and the required and available free disk space. Ifeverything is acceptable, click Install.
 Note: Once you click Install, if you click Cancel to cancel the installation youget a message indicating that Tivoli Identity Manager is not installed.However files are not automatically cleaned up through this action, andthis condition might result in a partial installation. Clean up any partialinstallation manually before running Install again.
 16. Complete the remaining automated installation program steps in “Respondingto major installation actions.”
 Responding to major installation actionsThe Tivoli Identity Manager installation program opens a series of progresswindows for additional, major installation actions. Some windows require yourinput. The installation program installs and configures Tivoli Identity Manager onthe WebSphere Application Server, sets up the Tivoli Identity Manager database onthe database server, and sets up the LDAP schema and a configuration of data onthe directory server.
 The major installation actions include these steps:1. Copying Tivoli Identity Manager files to the target computer.
 The installation program copies Tivoli Identity Manager files to theITIM_HOME directory.
 2. Ensuring that the WebSphere Application Server is running.The WebSphere Application Server must be running to allow Tivoli IdentityManager deployment and configuration to occur. The Tivoli Identity Managerinstallation program verifies the status of the WebSphere Application Server. Ifthe WebSphere Application Server is not running, the Tivoli Identity Managerinstallation program attempts to start the WebSphere Application Server.An error message appears if the Tivoli Identity Manager installation programfails to start the WebSphere Application Server. If an error occurs, you can doeither of these steps:v Quit the installation program and complete these steps:
 a. Resolve the problem that prevents starting the WebSphere ApplicationServer.
 b. Manually delete all files in the ITIM_HOME directory.c. Run the Tivoli Identity Manager installation program again.
 v Continue the installation program after you ensure that you can manuallystart and stop the WebSphere Application Server without error. Completethese steps:a. Stop the WebSphere Application Server:
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– Windows operating systems"WAS_PROFILE_HOME\bin\stopServer.bat servername"
 – UNIX or Linux operating systemsWAS_PROFILE_HOME/bin/stopServer.sh servername
 v Start the WebSphere Application Server:– Windows operating systems
 "WAS_PROFILE_HOME\bin\startServer.bat servername"
 – UNIX or Linux operating systemsWAS_PROFILE_HOME/bin/startServer.sh servername
 v Proceed to the next step in the Tivoli Identity Manager installation program.3. Gathering database data and configuring the database.
 In this step, the Tivoli Identity Manager installation program sets up the TivoliIdentity Manager database. For more information, see “Configuring the TivoliIdentity Manager database” on page 73.If an error occurs, examine the error and provide a corrective action. There ismore information in the ITIM_HOME\install_logs\dbConfig.stdout log file.You might need to refer to documentation that the database product provides.Continue the Tivoli Identity Manager installation program. When theinstallation completes, complete these steps:a. Save the current log data by renaming the ITIM_HOME\install_logs\
 dbConfig.stdout log file.b. Make sure that the Tivoli Identity Manager messaging engine is not
 running. Log in to the WebSphere administrative console, and completethese steps:1) Click Service Integration > Buses.2) Click itim_bus, if it exists.3) In the Topology section, click Messaging engines.
 For a single-server installation, you see an engine namednodename.servername-itim_bus.For a cluster installation, you see n+1 messaging engines, where n is thenumber of Tivoli Identity Manager cluster members. An additionalmessaging engine is used for the Tivoli Identity Manager messagingcluster.
 4) Select one or more messaging engines and click Stop.c. When the correction is complete, use this command to configure the Tivoli
 Identity Manager database:v Windows: ITIM_HOME\bin\DBConfig.exev UNIX/Linux: ITIM_HOME/bin/DBConfigNew log data is recorded in the ITIM_HOME\install_logs\dbConfig.stdoutlog file.
 Note: The DBConfig command creates the database table definitions thatTivoli Identity Manager requires. Run this command only if thecommand failed to configure the database during installation. If theTivoli Identity Manager database tables have been previously set,running the DBConfig command first, drops all the existing TivoliIdentity Manager tables.
 4. Gathering directory server data and configuring the directory server.
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In this step, the Tivoli Identity Manager installation program sets up the LDAPschema and the default data entries for Tivoli Identity Manager. For moreinformation, see “Configuring the directory server” on page 74.If an error occurs, record the error message that is displayed. The messagemight describe a problem in setting up the LDAP schema or creating aconfiguration of data on the directory server.Continue the Tivoli Identity Manager installation program. When theinstallation completes, complete these steps:a. Examine the errors and provide a corrective action. There is more
 information in the ITIM_HOME\install_logs\ldapConfig.stdout log file. Youmight also need to refer to documentation that the directory server productprovides.
 b. Save the current log data by renaming the ITIM_HOME\install_logs\ldapConfig.stdout log file.
 c. When the correction is complete, use this command to configure thedirectory server:v Windows operating systems:
 ITIM_HOME\bin\ldapConfig.exe
 v UNIX or Linux operating systems:ITIM_HOME/bin/ldapConfig
 New log data is recorded in the ITIM_HOME\install_logs\ldapConfig.stdout log file.
 Note: Running the ldapConfig command will restore default values that TivoliIdentity Manager uses. If you have changed the value of any of theseTivoli Identity Manager attributes, such as the password of the itimmanager user ID, the value is overwritten. Do not run the ldapConfigcommand a second time, unless the LDAP configuration fails during theTivoli Identity Manager Server installation process.
 5. Gathering Tivoli Identity Manager data and configuring the Tivoli IdentityManager Server.The Tivoli Identity Manager installation program copies a set of Tivoli IdentityManager property files to the ITIM_HOME\data directory. During this step,you can use the GUI to change some of the Tivoli Identity Manager properties.For more information, see “Configuring commonly used system properties” onpage 75.The Tivoli Identity Manager installation program also configures theWebSphere environment settings that the Tivoli Identity Manager Serverrequires. This step takes several minutes to complete.If an error occurs, record the error message that is displayed. The messagemight describe a problem in configuring the WebSphere environment settingsthat the Tivoli Identity Manager Server requires.Continue the Tivoli Identity Manager installation program. When theinstallation completes, complete these steps:a. Examine the errors and provide a corrective action. There is more
 information in the ITIM_HOME\install_logs\runConfigFirstTime.stdout logfile. You might also need to refer to documentation that the WebSphereproduct provides.
 b. When the correction is complete, use this command:To update commonly-used Tivoli Identity Manager properties, run thefollowing command:
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v Windows: ITIM_HOME\bin\runConfig.exev UNIX/Linux: ITIM_HOME/bin/runConfig
 The runConfig utility also accepts an install parameter. Use runConfig withthe install parameter when there is a problem reported for runConfigduring the Tivoli Identity Manager installation. Note that systemconfiguration requires several minutes to complete if the install option isused.v Windows: ITIM_HOME\bin\runConfig.exe installv UNIX/Linux: ITIM_HOME/bin/runConfig installNew log data is recorded in the ITIM_HOME\install_logs\runConfig.stdoutlog file.
 6. Deploying the Tivoli Identity Manager Server onto the WebSphere ApplicationServer.The Tivoli Identity Manager application runs within the WebSphere ApplicationServer as an enterprise application. The Tivoli Identity Manager installationprogram uses the WebSphere command-line interface (wsadmin) to deploy theTivoli Identity Manager application onto the WebSphere Application Server.Deploying the Tivoli Identity Manager application also performs certainconfiguration steps on the WebSphere Application Server. These steps requireseveral minutes to complete.When the deployment completes, the Tivoli Identity Manager files are in thesedirectories:v WAS_PROFILE_HOME\installedApps\cellname\ITIM.earv WAS_PROFILE_HOME\config\cells\cellname\applications\ITIM.ear
 Note: For the deployment manager node, these files are only in theWAS_NDM_PROFILE_HOME\config\cells\cellname\applications\ITIM.ear directory
 If the log data indicates failure to establish a SOAP connection to theWebSphere Application Server configuration manager, or some type ofWebSphere Application Server scripting error, complete these steps:a. Exit the Tivoli Identity Manager installation program.b. Resolve the problem that prevents connection to the WebSphere Application
 Server or a problem described as a scripting error. For more information,refer to the WebSphere documentation.
 c. Manually delete all files in the ITIM_HOME directory.d. Run the Tivoli Identity Manager installation program again.If the log data indicates that failure is due to a timeout, continue the TivoliIdentity Manager installation program.If the Tivoli Identity Manager installation program has completed, delete thefollowing directories if they exist:v WAS_PROFILE_HOME\installedApps\cellname\ITIM.earv WAS_PROFILE_HOME\config\cells\cellname\applications\ITIM.earRun one of the following commands to deploy the Tivoli Identity ManagerServer onto the WebSphere Application Server:v If WebSphere administrative security and application security is on, run this
 command:ITIM_HOME\bin\setupEnrole install server:server_name user:user_idpassword:pwd ejbuser:ejb_user_id
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The value of server_name is the name of the WebSphere Application Server onwhich the Tivoli Identity Manager application is deployed. The value ofuser_id is the WebSphere administrator user ID, such as wasadmin. The valueof pwd is the password for the WebSphere administrator user ID, such aswasadmin. The value of ejb_user_id is the Tivoli Identity Manager EJB user ID,which uses the WebSphere Application Server administrator user ID bydefault.
 v If WebSphere administrative security and application security is off, enterthis command:ITIM_HOME\bin\setupEnrole install server:server_name
 The default of server_name is server1.7. Restart the WebSphere Application Server to make the new WebSphere
 Application Server configuration available after completing the Tivoli IdentityManager Server installation.If an error message indicates failure to restart the WebSphere ApplicationServer, complete the installation and then attempt to restart the WebSphereApplication Server. To restart the WebSphere Application Server, complete thesesteps:a. Stop the WebSphere Application Server:v Windows, run the following command:
 – WAS_HOME\bin\stopServer.bat server_name
 v UNIX/Linux, run the following command:– WAS_HOME/bin/stopServer.sh server_name
 The value of server_name is the name of the WebSphere ApplicationServer. For example, server1.
 b. Start the WebSphere Application Server:v Windows, run the following command:
 – WAS_PROFILE_HOME\bin\startServer.bat server_name
 v UNIX/Linux, run the following command:– WAS_PROFILE_HOME/bin/startServer.sh server_name
 The value of server_name is the name of the WebSphere ApplicationServer. For example, server1.
 For more information, see “Verifying that the Tivoli Identity Manager Server isoperational.”
 Verifying that the Tivoli Identity Manager Server is operationalTo verify that the Tivoli Identity Manager Server and related processes are running,complete these steps:1. Ensure that the WebSphere Application Server is running.
 Start the WebSphere administrative console. On a browser, enter this Webaddress:http://hostname:port/ibm/console
 The value of hostname is the fully qualified host name or the IP address of thecomputer on which the WebSphere Application Server is running. The value ofport is the port number for the WebSphere administrative HTTP transport. Thedefault value is 9060. If you have multiple instances of the WebSphereApplication Server on the same computer, the port number might be a differentvalue, such as 9061.
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2. On the WebSphere administrative console, click Applications > EnterpriseApplication and verify that the Tivoli Identity Manager Server is running. Foradditional steps to verify that the Tivoli Identity Manager Server and otherprocesses are running, see Chapter 9, “Verifying and troubleshooting theinstallation,” on page 93.
 3. Log on to the Tivoli Identity Manager Server using the WebSphere embeddedHTTP transport. For example, at a browser window, enter this command:http://hostname:port/itim/console/
 The value of hostname is the host name of the WebSphere Application Server.The value of port is the default port number of the WebSphere virtual host. Thedefault port number is 9080. If you have multiple installations of theWebSphere Application Server on the same system, this port number mighthave a different value, such as 9081. The port number can be removed if anHTTP server is used as the front-end proxy.The browser displays the Tivoli Identity Manager logon window. Enter theTivoli Identity Manager Server administrator user ID (itim manager) andpassword (immediately after installation, the value is secret).
 4. After successfully logging on to Tivoli Identity Manager Server using theWebSphere embedded HTTP transport, attempt to log on to the Tivoli IdentityManager Server using the IBM HTTP Server if the IBM HTTP Server and theWebSphere Web Server plug-in are installed and configured. Log on at thisaddress:http://hostname:port/itim/console
 The value of hostname is the host name of the IBM HTTP Server. The value ofport is the port number of the WebSphere virtual host. The default port numberis 9080. The port number can be removed if an HTTP server is used as the frontend proxy.
 5. After a first, successful logon, the logon window immediately prompts you tochange the administrator password. Ensure that your password change issuccessful. After you change the password, you are ready to create yourorganization object and a user that is termed an ITIM User.
 If you cannot start and log on to Tivoli Identity Manager, see Chapter 9, “Verifyingand troubleshooting the installation,” on page 93.
 To perform optional post-installation tasks, see “Optional post-installation tasks”on page 69.
 Installing Tivoli Identity Manager in a cluster configurationThis section describes installing and configuring the Tivoli Identity Manager in acluster configuration. Before continuing, read “Configuration options” on page 4.For required application versions and fix packs, refer to the Tivoli Identity ManagerInformation Center.
 Before you beginBefore you begin to install Tivoli Identity Manager Server in a clusterconfiguration, complete these tasks:1. Determine which product DVDs that you need to install Tivoli Identity
 Manager. For an itemization of the DVD contents, refer to a text file such asitim-5.0-dvd-images-operatingsystem.txt that is provided with the DVD image.For a complete list of these image files, see Appendix C, “Installation imagesand fix packs,” on page 137.
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2. Ensure that free disk space and memory requirements are met on everycomputer in the cluster. Additionally, ensure that there is adequate free diskspace in the system temp directory and in the WAS_PROFILE_HOME andWAS_NDM_PROFILE_HOME directories. The target computers must meet thecomputer requirements described in the Tivoli Identity Manager InformationCenter.
 3. Ensure that you have the needed administrative authority. On Windowssystems, the logon user ID must be in the Administrators Group. On UNIXsystems, the logon user ID must be root.
 4. Installing the Tivoli Identity Manager Server writes data to the Tivoli IdentityManager database.
 5. In a cluster, the name of the Tivoli Identity Manager installation directorymust be the same for all cluster members. Specify an identical directory toavoid later runtime difficulties in identity feed activities on different clustermember computers.
 6. If you are using IBM Tivoli Directory Server, ensure that you have run themiddleware configuration utility or that the directory server has loaded theappropriate referential integrity plug-in. For more information, see “Manuallyconfiguring the referential integrity plug-in on the IBM Tivoli DirectoryServer” on page 32.
 7. Ensure that the prerequisite applications are running that are described inTable 4:
 Table 4. Prerequisites that must be running
 Prerequisite For more information
 Database Chapter 2, “Installing and configuring a database,”on page 9
 Directory server Chapter 3, “Installing and configuring a directoryserver,” on page 27
 Directory integrator (optional) Chapter 4, “Optionally installing IBM TivoliDirectory Integrator,” on page 39
 WebSphere Application Server Chapter 5, “Installing and configuring WebSphereApplication Server,” on page 41
 Only Tivoli Identity Manager and WebSphere Application Server requireinstallation on the same computer. All other applications can be run locally orremotely to the computer on which Tivoli Identity Manager is installed. IBMTivoli Directory Integrator is an optional component.
 8. Determine that the WebSphere Application Server cell and cluster are readyfor Tivoli Identity Manager installation. Complete the steps to construct aWebSphere Application Server cell and a cluster, described in “InstallingWebSphere Application Server in a cluster environment” on page 43.These processes must be running before and after you install the TivoliIdentity Manager Server:v Deployment managerv WebSphere Application Server node agents
 9. Capture the details of your configuration. For a detailed list of configurationparameters, see Appendix D, “Worksheets,” on page 139.
 10. If you are upgrading a version of Tivoli Identity Manager that is already onthe computer, see Chapter 10, “Upgrading to Tivoli Identity Manager Version5.1,” on page 103 for more information about protecting Tivoli IdentityManager customizations and data.
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Overview of the installation program in a cluster configurationInstallation in a cluster configuration requires that you install the Tivoli IdentityManager Server on the following computers:v The deployment manager
 Install the Tivoli Identity Manager Server on the computer that has thedeployment manager before you install the Tivoli Identity Manager Server oncluster nodes. The deployment of the Tivoli Identity Manager application andthe configuration of the database and the directory server for Tivoli IdentityManager occurs during this installation. The deployment manager distributesand expands the Tivoli Identity Manager application to all cluster membercomputers.
 v Cluster membersRepeat the steps in this chapter to install the Tivoli Identity Manager Server oneach computer that is a cluster member. The installation program does thesetasks:– Copies Tivoli Identity Manager files to the target computer– Configures the WebSphere Application Server that hosts the cluster memberInstalling the Tivoli Identity Manager Server on clusters must be donesequentially, one computer at a time. Running the Tivoli Identity Managerinstallation program simultaneously on more than one computer might result insynchronization problems with the WebSphere master configuration file.
 Note: If the same computer has both the deployment manager and a TivoliIdentity Manager cluster member, you must select both the deploymentmanager and the cluster member node types when you run the TivoliIdentity Manager installation program.
 Starting the installation wizardTo install Tivoli Identity Manager Server in a cluster configuration, complete thefollowing steps:1. Log on to an account with system administration privileges on the computer
 where the Tivoli Identity Manager Server is to be installed.2. Install the installation program, or insert the Tivoli Identity Manager product
 DVD into the DVD drive. To locate the correct DVD for your environment,refer to Appendix C, “Installation images and fix packs,” on page 137.
 3. To run the installation program, complete these steps:v Windows:
 a. Click Start > Run.b. Enter the drive and path where the installation program is located and
 then enter the following command:instwin.exe
 The Welcome window opens.v UNIX/Linux:
 a. Open a command shell prompt window, and navigate to the directorywhere the installation program is located.
 b. Enter the following command for the Tivoli Identity Manager installationprogram:– AIX:
 instaix.bin
 – Linux:
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instlinux.bin
 – pLinux:instplinux.bin
 – zLinux:instzlinux.bin
 – Solaris:instsol.bin
 The installation program starts and displays the Welcome window.If you are running the installation program on a UNIX/Linux system thatdoes not have at least 150MB of free space in the /tmp directory, you shouldset the IATEMPDIR environment variable to a directory on a disk partitionwith enough free disk space. To set the variable, enter one of the followingcommands at the command line prompt before running the installationprogram again:– Bourne shell (sh), ksh, bash, and zsh:
 $ IATEMPDIR=temp_dir$ export IATEMPDIR
 – C shell (csh) and tcsh:$ setenv IATEMPDIR temp_dir
 where temp_dir is the path to the directory, for example /your/free/directory, where free disk space is available.
 Completing the installation wizard pagesUse the first set of installation wizard pages to set up the installation:
 The dollar sign ($) has special meaning in the installer frameworks used by InstallAnywhere. Avoid using $ in any field values. The installer framework or operatingsystem platform might do variable substitution for the value.
 To complete the installation wizard pages, complete these steps:1. To change the language that is used for the installation wizard pages, select
 another language from the drop-down list. This choice only affects theinstallation wizard and not the language version of Tivoli Identity Manager tobe installed. Then, click OK.
 Note: The license is always shown in the system locale of the machine andnot the installation language selected.
 2. Click Next to advance past the copyright and legal text.3. In the License Agreement window, read the license agreement and decide
 whether to accept its terms. Optionally click Read non-IBM terms to read theterms of any non-IBM products or Print to print out the license agreement. Toaccept the terms and continue with the installation, select Accept, and thenclick Next.
 4. Accept the default ITIM_HOME installation directory, or select Choose toselect another directory. Then, click Next.
 5. In the Installation Type window, select Regular WebSphere cluster. Then,click Next.
 6. In the Installing Tivoli Identity Manager on a Cluster Environment window,read the conditions that apply to a cluster environment. Before continuing,apply any other changes that are necessary to configure the environment forthese conditions. For example, verify that the deployment manager and all
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WebSphere node agents are running. For more information, see “Verify thefederation of nodes within the cell” on page 46. Click Next.The Database Type window opens.
 7. In the Choose Cluster Node Type window, select one or both of these nodetypes:v Deployment manager
 You must install Tivoli Identity Manager first on the computer that has thedeployment manager.
 v Cluster memberInstall Tivoli Identity Manager on every cluster member that does not resideon the same computer as the deployment manager, after you install TivoliIdentity Manager on the computer that has the deployment manager. If youhave the deployment manager and a Tivoli Identity Manager clustermember on the same computer, you must select both node types.
 8. The WebSphere Application Server Installation Directory window appears anddisplays a value for a WAS_HOME directory.There can be multiple installations of the WebSphere Application Server on acomputer. If the WAS_HOME directory is not the directory on which youintend to install the Tivoli Identity Manager Server, enter the correct directoryvalue. Click Next.
 9. If you selected a cluster member for the Tivoli Identity Manager installation,select the WebSphere Application Server profile that hosts the cluster member.
 10. If you selected the deployment manager for the Tivoli Identity Managerinstallation, select the WebSphere Application Server profile name of thenetwork deployment manager in which Tivoli Identity Manager is to beinstalled from the list, and click Next.
 11. If you selected the deployment manager for the Tivoli Identity Managerinstallation, caution windows open to prompt you to confirm that thedirectory server version is at the correct level. Confirm that the version iscorrect and click Next.
 12. In the data window that requests the cluster name, enter the names of boththe Tivoli Identity Manager application cluster and the messaging cluster youcreated. Then, click Next.
 13. A window opens to prompt you to verify the host name of the computer.Accept the displayed value unless the computer has multiple host names, andeither the deployment manager or the WebSphere Application Server isinstalled under a host name other than the displayed value. Verify theWebSphere Application Server data and click Next.
 14. If WebSphere Application Server administrative security is on, specify theadministrator user ID and password, and click Next.
 15. In the Database Type window, select one of the following database types, andthen click Next:v DB2 Databasev Oracle Database
 If the Oracle database is selected, another window prompts you for thelocation and name of the Oracle JDBC driver. Provide the location andname, and click Next. For more information, see “Installing the Oracle JDBCdriver” on page 21.
 v Microsoft SQL Server (only listed for Windows operating systems)
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If the Microsoft SQL Server is selected, another window prompts you forthe location and name of the JDBC driver. Provide the location and name,and click Next. For more information see “Installing the SQL Server JDBCdriver” on page 25.
 16. If you are installing Tivoli Identity Manager on a cluster member, theDirectory Server Information window opens.On cluster members, complete the window containing LDAP fields. Thiswindow does not appear during Tivoli Identity Manager installation on thecomputer that has the deployment manager.Enter organization data in the fields in the window. For every cluster member,the information must be identical and must match the LDAP specification thatwas entered during Tivoli Identity Manager installation on the deploymentmanager. Click Next.
 17. A Keystore Password window requires you to specify the keystore password.The keystore password entered here is used to unlock the Tivoli IdentityManager keystore file which stores the encryption key used to encrypt TivoliIdentity Manager sensitive data. When you have entered the password, clickNext.Tivoli Identity Manager creates the keystore file itim_keystore.jceks at thedeployment manager node under the WAS_NDM_PROFILE\config\cells\cell_name\itim directory. This file then propagates to all cluster member nodesin the WAS_PROFILE_HOME\config\cells\cell_name\itim directory. Theinstaller verifies the keystore password by attempting to open the keystore oninstalling Tivoli Identity Manager at the cluster member node (except in thecase when the deployment manager node and cluster member node are on thesame computer). If the password is not correct, or the keystore file is notpresent, an error message occurs. If the keystore file is not present, copy thefile from the deployment manager node to the cluster member node, and clickNext again.
 18. A window appears to choose whether to install agentless adapters on IBMTivoli Directory Integrator.The Tivoli Identity Manager installation program installs these POSIX adaptersfor the following managed resources:v AIXv HP-UXv LDAPv Linuxv Solaris
 Installation programs for the agentless adapters that are installed by the TivoliIdentity Manager installation program are located in the ITIM_HOME\config\adapters directory. You can reinstall adapters later if needed. For moreinformation about manual adapter installation, see “Manually installingagentless adapters and adapter profiles” on page 81.Select an option, and click Next.
 Note: If IBM Tivoli Directory Integrator is installed remotely, select Do NotInstall Agentless Adapters.
 19. In the Location of IBM Tivoli Directory Integrator window, enter or confirmthe correct directory value, click Choose, and click Next.
 20. In the Tivoli Common Directory window, accept the default directory for theTivoli Common Directory that the Tivoli Identity Manager installationprogram defines, or choose a new one. For more information about directory
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paths, see “Definitions for HOME and other directory variables” on page xii.Then, click Next. Ensure that the directory has at least 25 MB of free space.The Tivoli Common Directory is the central location for allserviceability-related files, such as logs and first-failure capture data.
 21. In the Pre-install Summary window, review the components to be installed,the required free disk space, and the Tivoli Identity Manager installationdirectory. If everything is acceptable, click Install.
 Note: Once you click Install, if you click Cancel to cancel the installation youget a message indicating that Tivoli Identity Manager is not installed.However files are not automatically cleaned up through this action.This condition might result in a partial installation. Clean up anypartial installation manually before running Install again.
 22. Complete the remaining automated installation program. “Responding tomajor installation actions” describes these major steps.
 Responding to major installation actionsThe Tivoli Identity Manager installation program opens a series of progresswindows for additional, major installation actions. Some windows require yourinput. The installation program installs and configures the Tivoli Identity Managerapplication on the WebSphere Application Server, sets up the Tivoli IdentityManager database on the database server, and sets up the LDAP schema and aconfiguration of data on the directory server.
 The major installation actions include these steps:1. Copying Tivoli Identity Manager files to the target computer.
 The installation program copies Tivoli Identity Manager files to theITIM_HOME directory.
 2. If installation is on the deployment manager, the next step is gatheringdatabase data and configuring the database.In this step, the Tivoli Identity Manager installation program sets up the TivoliIdentity Manager database and configures the JDBC driver provider in theWebSphere Application Server. For more information, see “Configuring theTivoli Identity Manager database” on page 73.If an error occurs, examine the error and provide a corrective action. There ismore information in the ITIM_HOME\install_logs\dbConfig.stdout log file.You might need to refer to documentation that the database product or that theWebSphere product provides.Continue the Tivoli Identity Manager installation program. When theinstallation completes, complete these steps:a. Save the current log data by renaming the ITIM_HOME\install_logs\
 dbConfig.stdout log file.b. Make sure that the Tivoli Identity Manager messaging engine is not
 running. Log in to the WebSphere administrative console, and completethese steps:1) Click Service Integration > Buses.2) Click itim_bus, if it exists.3) In the Topology section, click Messaging engines.
 For a single-server installation, you see an engine namednodename.servername-itim_bus.
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For a cluster installation, you see n+1 messaging engines, where n is thenumber of Tivoli Identity Manager cluster members. An additionalmessaging engine is used for the Tivoli Identity Manager messagingcluster.
 4) Select one or more messaging engines and click Stop.c. When the correction is complete, type this command to configure the Tivoli
 Identity Manager database:v Windows: ITIM_HOME\bin\DBConfig.exev UNIX/Linux: ITIM_HOME/bin/DBConfigNew log data is recorded in the ITIM_HOME\install_logs\dbConfig.stdoutlog file.
 Note: The DBConfig command creates the database table definitions thatTivoli Identity Manager requires. Run this command only if thecommand failed to configure the database during installation. If theTivoli Identity Manager database tables have been previously set,running the DBConfig command first, drops all the existing TivoliIdentity Manager tables.
 3. If installation is on the deployment manager, the next step is gatheringdirectory server data and configuring the directory server.In this step, the Tivoli Identity Manager installation program sets up the LDAPschema and defines default settings for Tivoli Identity Manager. For moreinformation, see “Configuring the directory server” on page 74.If an error occurs, record the error message. The message might describe aproblem in setting up the LDAP schema or creating a configuration of data onthe directory server.Continue the Tivoli Identity Manager installation program. When theinstallation completes, complete these steps:a. Examine the errors and provide a corrective action. There is more
 information in the ITIM_HOME\install_logs\ldapConfig.stdout log file. Youmight also need to refer to documentation that the directory server productprovides.
 b. Save the current log data by renaming the ITIM_HOME\install_logs\ldapConfig.stdout log file.
 c. When the correction is complete, use these commands to configure thedirectory server:v Windows operating systems:
 ITIM_HOME\bin\ldapConfig.exe
 v UNIX or Linux operating systems:ITIM_HOME/bin/ldapConfig
 New log data is recorded in the ITIM_HOME\install_logs\ldapConfig.stdout log file.
 Note: Running the ldapConfig command will restore default values thatTivoli Identity Manager uses. If you have changed the value of any ofthese Tivoli Identity Manager attributes, such as the password of theitim manager user ID, the value is overwritten. Do not run theldapConfig command a second time, unless the LDAP configurationfails during the Tivoli Identity Manager Server installation process.
 4. If installation is on the deployment manager or on a cluster member, the TivoliIdentity Manager installation program copies a set of Tivoli Identity Manager
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property files to the ITIM_HOME directory. During this step, you can use theGUI to change some of the Tivoli Identity Manager properties.If the installation is on a cluster member, ensure that the directory and databaseconnection information that you enter on the Directory tab and the Databasetab match the information that you entered on these tabs when you configurethe deployment manager. The default database user ID is itimuser. The user IDpassword is the password that is used for the user ID itimuser during thedeployment manager setup. The user ID and password used for the clustermember needs to be the same as the user ID and password used on thedeployment manager. The Tivoli Identity Manager does not function properly ifany user information is incorrect. For more information, see “Configuringcommonly used system properties” on page 75.The Tivoli Identity Manager installation program also configures theWebSphere environment settings that the Tivoli Identity Manager Serverrequires. This step takes several minutes to complete.If an error occurs, record the error message. The message might describe aproblem in configuring the WebSphere environment settings that the TivoliIdentity Manager Server requires.Continue the Tivoli Identity Manager installation program. When theinstallation completes, complete these steps:a. Examine the errors and provide a corrective action. There is more
 information in the ITIM_HOME\install_logs\runConfigFirstTime.stdout logfile. You might also need to refer to documentation that the WebSphereproduct provides.
 b. When the correction is complete, enter one of the following commands:To update commonly-used Tivoli Identity Manager properties, run thefollowing command:v Windows: ITIM_HOME\bin\runConfig.exev UNIX/Linux: ITIM_HOME/bin/runConfig
 The runConfig utility also accepts an install parameter. Use runConfig withthe install parameter when there is a problem reported for runConfigduring the Tivoli Identity Manager installation. Note that systemconfiguration requires several minutes to complete if the install option isused.v Windows: ITIM_HOME\bin\runConfig.exe installv UNIX/Linux: ITIM_HOME/bin/runConfig installNew log data is recorded in the ITIM_HOME\install_logs\runConfig.stdoutlog file.
 5. Deploying Tivoli Identity Manager onto the deployment manager.The Tivoli Identity Manager application runs within the WebSphere ApplicationServer as an enterprise application. The Tivoli Identity Manager installationprogram uses the WebSphere command-line interface (wsadmin) to deploy theTivoli Identity Manager application onto the deployment manager.The Tivoli Identity Manager installation program also configures theWebSphere environment settings that the Tivoli Identity Manager Serverrequires. The deployment takes several minutes to complete.When the deployment completes, the Tivoli Identity Manager files are in theWAS_NDM_PROFILE_HOME\config\cells\cellname\applications\ITIM.eardirectory.
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If the deployment fails, an error message provides the location of thesetupEnrole.stdout log file. Examine the errors in the setupEnrole.stdout logfile. Then, complete these tasks:v If the log data indicates failure to create a SOAP connection to the
 deployment manager, or some type of deployment manager scripting error,complete these steps:a. Exit the Tivoli Identity Manager installation program.b. Resolve the problem that prevents connection to the WebSphere
 Application Server or a problem described as a scripting error. For moreinformation, refer to the WebSphere documentation.
 c. Manually delete all files in the ITIM_HOME directory.d. Run the Tivoli Identity Manager installation program again.
 v If the log data indicates that failure is due to a timeout, continue the TivoliIdentity Manager installation program. When installation finishes, completethese steps:a. If the WAS_NDM_PROFILE_HOME\config\cells\cellname\applications\
 ITIM.ear directory was created, delete the directory on the computer thathas the deployment manager.
 b. Run one of the following commands to deploy the Tivoli IdentityManager Server onto the deployment manager:– If WebSphere administrative security and application security is on,
 run this command:ITIM_HOME\bin\setupEnrole install user:user_idpassword:pwd ejbuser:ejb_user_id
 The value of server_name is the name of the WebSphere ApplicationServer on which the Tivoli Identity Manager application is deployed.The value of user_id is the WebSphere administrator user ID, such aswasadmin. The value of pwd is the password for the WebSphereadministrator user ID, such as wasadmin. The value of ejb_user_id is theTivoli Identity Manager EJB user ID, which uses the WebSphereApplication Server administrator user ID by default.
 – If WebSphere administrative security and application security is off,enter this command:ITIM_HOME\bin\setupEnrole install
 6. Restart the cluster. For more information, see “Starting clusters.”7. Verify that the Tivoli Identity Manager Server is working correctly. For more
 information, see “Verifying that the Tivoli Identity Manager Server isoperational” on page 68.
 Starting clustersWhen installation completes and configuration and security modification is done,restart all node agents where cluster members are running, then start your clusters.On the WebSphere administrative console, complete these steps:1. Start both the Tivoli Identity Manager application and the Tivoli Identity
 Manager messaging cluster.a. Click Servers > Clusters.b. Select the Tivoli Identity Manager clusters.c. Click Start. The Tivoli Identity Manager application starts when the clusters
 start.
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Use the WebSphere administrative console to verify that all required clustermembers are started. Complete these steps:1. Click Applications > Enterprise Applications. Examine the status of the Tivoli
 Identity Manager application.2. Click Servers > Application Servers. Examine the status of the cluster
 members.3. Additionally, examine the log files for other problems. For more information,
 see “Log files” on page 101.
 If the status of the Tivoli Identity Manager application indicates a partial start,complete these steps:1. Locate the computer that has the cluster member that fails to start.2. Examine the following log files of the computer where the cluster member
 resides to determine whether the Tivoli Identity Manager server has startedsuccessfully:v WAS_PROFILE_HOME\logs\server_name\SystemOut.logv TIVOLI_COMMON_DIRECTORY\CTGIM\logs\trace.log
 3. Correct the problem. Then, use the WebSphere administrative console to startthe cluster member.
 Verifying that the Tivoli Identity Manager Server is operationalTo verify that the Tivoli Identity Manager Server and related processes are running,complete these steps:1. Start both clusters. For more information, see “Starting clusters” on page 67.2. Log on to Tivoli Identity Manager Server using the WebSphere embedded
 HTTP transport. For example, at a browser window, enter this command:http://hostname:port/itim/console/
 The value of hostname is the fully qualified name or IP address of the computerwhich hosts the WebSphere Application Server cluster member and the TivoliIdentity Manager Server application. The value of port is the port number ofthe WebSphere virtual host. The default port number is 9080. If you havemultiple instances of the WebSphere Application Server on the same computer,the port number might be a different value, such as 9081. The port number canbe removed if an HTTP server is used as the front-end proxy. For moreinformation, see “Determining the port number of the default host” on page101.
 The browser displays the Tivoli Identity Manager logon window. Enter theTivoli Identity Manager administrator user ID (itim manager) and password(immediately after installation, the value is secret).
 3. After a first, successful logon, the logon window immediately prompts you tochange the administrator password. Ensure that your password change issuccessful. After you change the password, you are ready to create yourorganization object and a user that is called an ITIM User.
 If you cannot start and log on to Tivoli Identity Manager, see Chapter 9, “Verifyingand troubleshooting the installation,” on page 93.
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Optional post-installation tasks
 Optionally installing a language packAfter installing Tivoli Identity Manager, you can install a language pack thatprovides support for languages other than English.
 To install the language pack, complete these steps:1. Before you run the Tivoli Identity Manager language pack setup program,
 ensure that the version of the Java Runtime Environment that Tivoli IdentityManager requires is accessible from the command line. For more information,refer to the Tivoli Identity Manager Information Center.For example, you can use the version of Java that comes with WebSphereApplication Server. Enter this command:WAS_HOME\java\bin\java -fullversion
 You should receive a response similar to the following:java full version "1.5.0 IBM Windows 32 build pwi32devifx-20061107(iFix 111765 SR3 + 111700)"
 2. Download the language pack installer jar file.3. Use command line mode to install the language pack using the itimlp_setup.jar
 file. For example, enter this language pack command at a command prompt:WAS_HOME\java\bin\java –jar itimlp_setup.jar
 For Linux, ensure you use the version of Java installed with WebSphereApplication Server, located in WAS_HOME/java/bin, to install the languagepack.The Tivoli Identity Manager language pack setup program starts. To completethe language pack installation, follow the instructions that appear in the setupprogram windows.
 4. Restart the WebSphere Application Server to make these changes effective, bycompleting these steps:a. Stop the WebSphere Application Server:
 Windows, run the following command:– WAS_HOME\bin\stopServer.bat server_name
 UNIX/Linux, run the following command:– WAS_HOME/bin/stopServer.sh server_name
 The value of server_name is the name of the WebSphere ApplicationServer. For example, server1.
 b. Start the WebSphere Application Server:Windows, run the following command:– WAS_PROFILE_HOME\bin\startServer.bat server_name
 UNIX/Linux, run the following command:– WAS_PROFILE_HOME/bin/startServer.sh server_name
 The value of server_name is the name of the WebSphere ApplicationServer. For example, server1.
 After the language pack has been successfully installed, you can change thelanguage displayed in the Tivoli Identity Manager interface by changing thelanguage preference for your browser: Make language preference changes prior tologging into Tivoli Identity Manager.
 For Internet Explorer, complete the following steps:
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1. Select Tools > Internet Options
 2. On the General tab, click Languages.3. Click Add, select languages to add, and click OK.4. Select a language and set the language priority using the buttons to move
 the priority up or down.5. Click OK.6. Click OK again to save your changes.For Mozilla Firefox 3.0, complete the following steps:1. Select Tools > Options
 2. On the Advanced tab, under the Languages section, click Choose.3. Select a language and click Add.4. Select a language and set the language priority using the buttons to move
 the priority up or down.5. Click OK to save your changes.
 To uninstall the language pack from the system, change to the ITIM_HOME\timlpdirectory, and then enter this language pack command at a command prompt:java –jar timlp_uninstall.jar
 Optionally installing adapter profilesYou can choose to install and import any adapter profiles that you did not installduring the Tivoli Identity Manager installation process.
 Note: If you have upgraded from Tivoli Identity Manager version 5.0 to version5.1 and are using a service instance that was created using a Tivoli IdentityManager 5.0 profile, you must upgrade to the 5.1 adapter before you creategroups on the service. The adapters for Tivoli Identity Manager 5.0 do notsupport group management.
 For more information about the role of adapters, see “Tivoli Identity Manageradapters” on page 3
 To install and import adapter profiles, complete these steps:1. Open and extract the compressed adapter file.2. Place the JAR file that contains the adapter profile in a temporary directory on
 the computer that is running Tivoli Identity Manager.3. As administrator, open the Tivoli Identity Manager user interface.4. Click Configure System > Manage Service Types.5. On the Manage Service Types window, click Import.6. On the Service Definition File field, click Browse. Then, locate the JAR file
 that contains the adapter profile.7. When the Service Definition File field contains the adapter profile file name,
 click OK.8. On the Success page, click Close.9. After installing Tivoli Identity Manager and installing the Tivoli Identity
 Manager language pack, if the default language is not English and the adapterlabels are displayed in English, complete these steps:a. Click Configure System > Manage Service Types.b. Click Import on the Service Type table.c. Click Browse next to the Service Definition File field.
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d. Locate the timx_agents.jar file under the ITIM_HOME\timlp directory andclick OK.
 e. Click Close on the Success page.
 Changing cluster configurations after Tivoli Identity Manageris installed
 This section describes expanding or reducing the members in a cluster forperformance reasons after Tivoli Identity Manager is installed.
 Expanding a cluster using a new computerTo add a new cluster member to an existing Tivoli Identity Manager cluster,complete these steps to add a computer with a WebSphere Application Server thatwas not previously in the WebSphere cell.1. Create a profile on a new computer and federate the new node into the cell.
 There are two ways to complete this step:v Create a custom profile
 Create a custom profile on the new computer and federate the profile intothe deployment manager cell.
 v Create a base profileCreate a base profile on the new computer and then run the addNodecommand to federate the new node into the cell. For more information, see“Manually federate a WebSphere Application Server node member” on page46.
 2. Create a Tivoli Identity Manager cluster member on the new node. Repeat thisprocedure to create cluster members on both the application cluster and themessaging engine cluster. On the WebSphere administrative console, completethese steps:a. Click Servers > Cluster.b. On the next window, click the Tivoli Identity Manager cluster name.c. Click Cluster Members, then click New.d. Select the node name that is the node that you added to the cell. Enter the
 node name. Then, click Next.e. Verify the summary window, then click Finish.f. Save the changes.
 3. Run the Tivoli Identity Manager installation program on the new computer,choosing cluster member installation.
 4. Run the following command on the deployment manager node to set the policyfor the association of the messaging engine and the cluster member:v Windows operating systems:
 ITIM_HOME\bin\runConfig.exe install
 v UNIX or Linux operating systems:ITIM_HOME/bin/runConfig install
 5. Start the new cluster member. Click Servers > Clusters and select the cluster. Inthe cluster, click Cluster Members. Select the new member and click Start.
 Removing cluster membersTo remove cluster members, complete these steps:1. Run the Tivoli Identity Manager uninstallation program on the computer that
 has the cluster member that you intend to remove. For more information, seeChapter 11, “Uninstalling Tivoli Identity Manager,” on page 121.
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2. On the WebSphere administrative console, delete the cluster members fromboth Tivoli Identity Manager clusters.
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Chapter 7. Configuring the Tivoli Identity Manager Server
 Configuring the Tivoli Identity Manager Server has these steps:v “Configuring the Tivoli Identity Manager database”v “Configuring the directory server” on page 74v “Configuring commonly used system properties” on page 75v “Modifying system properties during normal operation” on page 82
 Optionally, you can configure security after installing Tivoli Identity Manager. Formore information about configuring security post-install for Tivoli IdentityManager, see Appendix B, “Configuring security for Tivoli Identity Manager,” onpage 127.
 Configuring the Tivoli Identity Manager databaseThe Tivoli Identity Manager installation program automatically uses the DBConfigdatabase configuration tool during a single-server installation, or during a clusterinstallation on the deployment manager, to set up the database to work with TivoliIdentity Manager. For more information about initial installation and configurationfor a database, see Chapter 2, “Installing and configuring a database,” on page 9.
 Completing the database configuration windowsA database configuration window opens to allow you to configure the databaseproperty file and to set up tables in the Tivoli Identity Manager database. Thefields that appear in the window might vary, depending on which database youuse. For more information about database fields, see “Recording user data” onpage 10.
 In the database configuration window, follow these steps:1. Complete the Identity Manager Database Information fields. The data is
 required to configure and connect to the Tivoli Identity Manager database. Youcan configure these fields:v Host Name
 Specify the name of the database host.v Port Number
 Specify the port number of the database instance.v Database Name
 For DB2 or Microsoft SQL databases:Specify the database name.
 For Oracle database:
 a. Click the radio button adjacent to SID or Service Name.b. Specify the Oracle system identifier (SID) or service name
 depending on the radio button you selected.v Admin ID
 Specify the administrator ID for the database host. Ensure that theadministrator ID has the rights to create tablespace and stop and start thedatabase.
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v Admin PasswordSpecify the password for the administrator ID.
 2. Click Test to ensure that the connection to the database is active. When thedatabase test is successful, the Tivoli Identity Manager User Password fieldbecomes active and the Test button changes to Continue. The User ID fielddisplays the default value itimuser, although you can change this user ID.Before you continue, ensure that the user ID itimuser exists.
 3. Enter the correct password for the existing database user ID that is nameditimuser, and then click Continue. The database configuration requires severalminutes to complete.
 Manually starting the DBConfig database configuration toolThe DBConfig command creates the database table definitions that Tivoli IdentityManager requires. Run this command only if the command failed to configure thedatabase during installation. If the Tivoli Identity Manager database tables havebeen previously set, running the DBConfig command first drops all of thepreviously existing Tivoli Identity Manager tables. If you run this command afterinstallation, ensure the messaging engines under the service integration bus(itim_bus) have been stopped from the WebSphere Application Serveradministrative console before running DBConfig.
 Running the database configuration tool writes data to the ITIM_HOME\install_logs\dbConfig.stdout log file. If you want to save the original file, back upthe file before running the command. The database configuration requires severalminutes to complete.
 To manually start the database configuration tool (DBConfig), complete these tasks:1. Back up the ITIM_HOME\install_logs\dbConfig.stdout file.2. Run the following command:v Windows: ITIM_HOME\bin\DBConfig.exev UNIX/Linux: ITIM_HOME/bin/DBConfig
 Note: You must run the runConfig command after running DBConfig to ensurethat database changes are updated.
 If DBConfig has never run after an install completes, you must run thefollowing commands to update changes:v Windows operating systems:
 ITIM_HOME\bin\runConfig.exe install
 v UNIX or Linux operating systems:ITIM_HOME/bin/runConfig install
 Configuring the directory serverThe Tivoli Identity Manager installation program automatically uses theldapConfig database configuration tool during a single-server installation, orduring a cluster installation on the deployment manager, to set up the directoryserver to work with Tivoli Identity Manager. For more information about initialinstallation and configuration for a directory server, see Chapter 3, “Installing andconfiguring a directory server,” on page 27.
 Running the ldapConfig command will restore default values that Tivoli IdentityManager uses. If you have changed the value of any of these Tivoli Identity
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Manager attributes, such as the password of the itim manager user ID, the value isoverwritten. Do not run the ldapConfig command a second time, unless the LDAPconfiguration fails during the Tivoli Identity Manager Server installation process.
 Completing the directory server configuration windowsTo configure the LDAP data repository with Tivoli Identity Manager values,complete these steps:1. Enter the values for the LDAP Server Information fields (Principal DN,
 Password, Host Name, Port) to set up the connection to the directory server.For example, the value of the Host Name field is the fully qualified host nameof the computer on which the directory server is running.
 2. Click Test to ensure that the connection to the directory server can beestablished. When the test for a connection to the directory server is successful,the fields in the Identity Manager Directory Information section become active.
 3. Enter the values for the Identity Manager Directory Information fields. You canconfigure these fields:v Number of hash buckets
 Specify the number of hash buckets.v Name of Your Organization
 Specify the name of your organization. For example, My Organization.v Default Org Short Name
 Specify the short name of your organization. For example, myorg.v Identity Manager DN Location
 Specify the Tivoli Identity Manager suffix. For example, dc=com.
 When you are finished, click Continue.
 Manually running the ldapConfig configuration toolTo avoid the loss of existing directory server data, you must not manually run thistool unless a directory server configuration problem occurs during installation.
 Running the configuration tool writes data to the ITIM_HOME\install_logs\ldapConfig.stdout log file. If you want to save the original file, back up the filebefore running the command. The directory server configuration requires severalminutes to complete.
 To manually start the ldapConfig configuration tool, complete these steps:1. Back up the ITIM_HOME\install_logs\ldapConfig.stdout file.2. Run the following command:
 ITIM_HOME\bin\ldapConfig
 Configuring commonly used system propertiesThe Tivoli Identity Manager installation program automatically runs the runConfigsystem configuration tool to edit commonly used system properties for the TivoliIdentity Manager Server and also to configure WebSphere Application Serversettings for the Tivoli Identity Manager application. The Tivoli Identity Managerinstallation program runs the system configuration tool for both a single-serverand cluster configuration, which includes the deployment manager and the clustermembers.
 The system configuration tool provides these windows:
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v “General tab”v “Directory tab” on page 77v “Database tab” on page 77v “Logging tab” on page 78v “Mail tab” on page 78v “UI tab” on page 79v “Security tab” on page 80
 You can run the system configuration tool manually. For more information, see“Manually starting the system configuration tool” on page 80. For alternative waysto configure system properties, see “Modifying system properties during normaloperation” on page 82.
 Related topics:
 Single-server installation: “Responding to major installation actions” on page 53
 Cluster installation: “Responding to major installation actions” on page 64
 General tabClick the General tab. The General tab of the system configuration tool configuresthe general information about the Tivoli Identity Manager Server.
 The following field values on the General tab are prefilled by the installationprogram:v Scheduling information
 – Heart Beat (seconds)The Scheduling Information field displays information about how frequentlya scheduling thread queries the scheduled message stores for events toprocess (Heart Beat). You might want to consider performance issues beforeyou enable a more frequent beat. Only system administrators can modify theHeart Beat, which is measured in seconds.
 – Recycle Bin Age Limit (days)When you delete Tivoli Identity Manager objects (such as organization units,persons, or accounts), the objects are not immediately removed from thesystem. Instead, they are moved to a recycle bin container. Emptying therecycle bin is a separate deletion process that involves running cleanupscripts.The recycle bin is disabled by default but can be enabled by editing theenRole.properties file in the ITIM_HOME\data directory.For example, to avoid assigning an old user ID to a new user, the assignmentprocess might check the recycle bin to determine if an old user ID exists. Youmight set the value of the recycle bin interval to an interval that determinesthe length of time to retain old user IDs.The Recycle Bin Age Limit field specifies the number of days that an objectremains in the recycle bin of the system before it becomes available fordeletion by cleanup scripts. The cleanup scripts can only remove those objectsthat are older than the age limit setting. For example, if the age limit setting is62 days (the default value), only objects that have been in the recycle bin formore than 62 days can be deleted by cleanup scripts.You can use the following scripts to either manually remove or to schedulethe periodic cleanup of recycle bin entries with expired age limits:
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- Windows:ITIM_HOME\bin\win\ldapClean.cmd
 To schedule periodic cleanup, register the preceding command script withthe Windows scheduler.
 - UNIX:ITIM_HOME/bin/unix/ldapClean.sh
 To schedule periodic cleanup, create a UNIX cron job such as the followingexample:ITIM_HOME/bin/unix/schedule_garbage.cron
 Related topics:
 See “Configuring commonly used system properties” on page 75.
 Directory tabClick the Directory tab. The Directory tab of the system configuration tool displaysdirectory connection information and LDAP connection pool information. The tabalso has a Test button to test the connection to the directory server. If you updateany field on this tab, click Test to ensure that the connection works.
 The information is pre-filled for the deployment manager, but not for a WebSphereApplication Server. If necessary, modify the following information for the directoryserver:v Principal DN and password that the Tivoli Identity Manager Server uses to log
 on to the directory serverv Host name or IP address for the directory server
 For IPv6, literal addresses need to be enclosed in brackets. For example,[abcd:abcd:abcd:abcd:abcd:abcd:abcd:abcd]
 where abcd is a hexadecimal number from 0000-FFFF.v Port number for the directory serverv The LDAP connection pool information defines a pool of LDAP connections
 accessible by the Tivoli Identity Manager Server. After a connection isestablished and data is stored in the LDAP directory server, changing the hostname or the port number might have detrimental effects.– In the Maximum Pool Size field, specify the maximum number of connections
 that the LDAP Connection Pool can have at any time.– In the Initial Pool Size field, specify the initial number of connections to be
 created for the LDAP Connection Pool.– In the Increment Count field, specify the number of connections to be added
 to the LDAP Connection Pool every time a connection is requested after allconnections are in use.
 Related topics:
 See “Configuring commonly used system properties” on page 75.
 Database tabClick the Database tab. The Database tab displays general database informationand database pool information. The tab also has a Test button to test the
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connection to the database. If you update any field on this tab, click Test to ensurethat the connection works. Changing the configuration after the system is set upcan have detrimental effects.
 Depending on the type of connection that is used, one of several windows isdisplayed when configuring database properties. The window in this exampledisplays the Database tab when Tivoli Identity Manager does not use an OracleClient to connect to the Oracle database.
 If this installation is on a cluster member, the information must match the databasespecification previously made for the deployment manager.v In the JDBC URL field, specify the URL value with type 4 JDBC Driver URL
 format.For IPv6, literal addresses need to be enclosed in brackets. For example,jdbc:db2://[abcd:abcd:abcd:abcd:abcd:abcd:abcd:abcd]:50002/itimdb
 where abcd is a hexadecimal number from 0000-FFFF.v In the Database User and the User Password fields, specify the database account
 and password that Tivoli Identity Manager uses to log on to the database. Thedefault user ID is itimuser, which is created by the Tivoli Identity Managerdatabase configuration program (DBConfig). The account must have a valid userpassword.
 v The database pool information determines the number of JDBC connections. Formore information about supported JDBC drivers, see “Database server products”on page 1.– In the Initial Capacity field, specify the initial number of JDBC connections.– In the Maximum Capacity field, specify the maximum number of JDBC
 connections that the Tivoli Identity Manager Server can open to the databaseat any one time.
 Related topics:
 See “Configuring commonly used system properties” on page 75.
 Logging tabClick the Logging tab.
 The Logging tab of the system configuration tool enables you to set the level oftracing. Choose one of these values:
 MIN Writes less information to the log file. Use this setting for bestperformance.
 MID Writes an increased amount of information to the log file.
 MAX Writes the maximum amount of information to the log file. The increasedamount of logging activity might affect performance. This setting isapproximately the equivalent of VERBOSE.
 Related topics:
 See “Configuring commonly used system properties” on page 75.
 Mail tabClick the Mail tab.
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The Mail tab of the system configuration tool displays mail notification andgateway parameters:v In the Tivoli Identity Manager Base URL field, specify the login Universal
 Resource Locator (URL) for the Tivoli Identity Manager Server. This address isthe first part of a URL that is sent to the recipient of mail messages at runtime.The URL also points to the login page of the Tivoli Identity Manageradministrative console.The value is the URL of the proxy server (for example, the IBM HTTP Server).Specify the host name (or IP address) and port in the base URL. Ensure that thevalue matches the published login URL to your Tivoli Identity Manager system.– Single-server configuration
 base URL is the address of the Web server (for example, the IBM HTTPServer) which by default uses port 80.
 – Cluster configurationbase URL is the address of the Web server which load-balances to allapplication server instances in the cluster (not the base URL of a specificapplication server instance).
 For IPv6, literal addresses need to be enclosed in brackets. For example,http://[abcd:abcd:abcd:abcd:abcd:abcd:abcd:abcd]:80
 where abcd is a hexadecimal number from 0000-FFFF.v In the Mail From field, specify the address to the Tivoli Identity Manager system
 administrator e-mail address for your site. All e-mail is delivered from the MailFrom parameter. You must change this address, otherwise you send spam to thee-mail address listed.
 v In the Mail Server Name field, specify the SMTP mail host that sends mailnotification. SMTP mail servers are supported. The SMTP host is the mailgateway. For example, enter a host name such as swiftcreek.mycity.ibm.com.
 Related topics:
 See “Configuring commonly used system properties” on page 75.
 UI tabClick the UI tab.
 The UI tab of the system configuration tool displays information to customize theTivoli Identity Manager Server GUI.v In the Customer Logo field, specify the path and file name of the logo graphic.v In the Customer Logo Link field, specify an optional URL link activated by
 clicking the logo image. System administrators can specify these two variables toreplace the IBM logo with their company logo throughout the Tivoli IdentityManager system. The default IBM logo file is the ibm_banner.gif file, which islocated in the WAS_PROFILE_HOME\installedApps\cellname\ITIM.ear\itim_console.war\html\images directory. In a cluster configuration, this defaultlogo can be found in the node member workstation and not on the DeploymentManager workstation.
 v In the List Page Size field, specify how many items that require a search in thedirectory are displayed on lists throughout the user interface. If the total numberof items exceeds the set List Page Size, the list is spread over multiple pages. For
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example, the value controls the size of the names list that appears when youbrowse the My Organization > Manage People tab in the Tivoli IdentityManager GUI.
 Related topics:
 See “Configuring commonly used system properties” on page 75.
 Security tabClick the Security tab. The Security tab of the system configuration tool displaysinformation to manage database, LDAP, and application server user IDs andpasswords that are stored in Tivoli Identity Manager properties files. The tabdisplays the encryption settings and application server user managementpreferences in Tivoli Identity Manager.
 By default, passwords in the Tivoli Identity Manager property files are encrypted.v In the Encryption box, check the box to encrypt the passwords used for database
 and directory server connections and the password of the EJB user that is usedfor EJB authentication. The encryption flags are set to true. Clear the box todecrypt the passwords and set the flags to false. The flags are represented by thefollowing properties in the enRole.properties file:enrole.password.database.encryptedenrole.password.ldap.encryptedenrole.password.appServer.encrypted
 v In the System User and System User Password fields, specify the system userand the system user password. The fields are pre-filled if WebSphereadministrative security and application security is on, and an administrator userID and password have been entered. The fields are blank if WebSphereadministrative security and application security is not on.
 v In the EJB User and EJB User Password fields, specify the EJB user and the EJBuser password. The fields initially take the values of the System User andPassword fields.If you define your own EJB user during installation to be different from theSystem User, you might need to modify the EJB User and EJB User Passwordfields. If you change the value of the EJB user ID or the EJB password on thissystem configuration Security window and run runConfig as a stand-alonecommand, additional manual steps are required after Tivoli Identity Managerinstallation to map the security role to the Tivoli Identity Manager user in orderto start Tivoli Identity Manager. For more information, see “Mapping anadministrative user to a role” on page 131.
 Note: The EJB user password is restricted to 12 characters.
 Related topics:
 See “Configuring commonly used system properties” on page 75.
 Manually starting the system configuration toolTo update commonly-used Tivoli Identity Manager properties, run the followingcommand:v Windows: ITIM_HOME\bin\runConfig.exev UNIX/Linux: ITIM_HOME/bin/runConfig
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The runConfig utility also accepts an install parameter. Use runConfig with theinstall parameter when there is a problem reported for runConfig during the TivoliIdentity Manager installation. Note that system configuration requires severalminutes to complete if the install option is used.v Windows: ITIM_HOME\bin\runConfig.exe installv UNIX/Linux: ITIM_HOME/bin/runConfig install
 Running the system configuration tool writes log data to the ITIM_HOME\install_logs\runConfig.stdout log file.
 Manually installing agentless adapters and adapter profilesAgentless adapter profiles are installed automatically by the Tivoli IdentityManager installation program during a new installation. The adapter is installeddepending on whether the IBM Tivoli Directory Integrator is installed on the sameserver as Tivoli Identity Manager. You can verify they installed correctly by lookingfor the POSIX adapters listed under Configure System > Service Types in theadministrative console user interface. However, if either the adapters or profilesfailed to install, you can install them manually.
 The following tasks are for agentless adapter installation only. For informationabout installing agent-based adapters and adapter profiles, see the Installingsection of the Tivoli Identity Manager Information Center.
 Installing agentless adaptersYou can install agentless adapters interactively or silently.
 To install agentless adapters interactively on Windows for example, run thefollowing command to install the adapters:WAS_HOME\java\bin\java.exe -cp PosixAdapterInstall.jar run
 To install agentless adapters silently, complete these steps:1. Update the ITIM_HOME\config\adapters\response.txt file, replacing every
 occurrence of %1 with the value of ITDI_HOME.2. Run the following command to install the adapters:
 cd ITIM_HOME\config\adapters"ITIM_HOME\java\bin\java.exe" -cp PosixAdapterInstall.jar run-silent -options response.txt
 Installing agentless adapter profilesIt is recommended that you download the latest POSIX adapters from the adapterdownload site.
 To install agentless adapter profiles, run the following commands:v For Window operating systems:
 cd ITIM_HOME\config\adapters"ITIM_HOME/bin/unix/config_remote_services.sh" -profile LdapProfile
 -jar LdapProfile.jar
 "ITIM_HOME/bin/unix/config_remote_services.sh" -profile PosixSolarisProfile-jar PosixSolarisProfile.jar
 "ITIM_HOME/bin/unix/config_remote_services.sh" -profile PosixLinuxProfile-jar PosixLinuxProfile.jar
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"ITIM_HOME/bin/unix/config_remote_services.sh" -profile PosixHpuxProfile-jar PosixHpuxProfile.jar
 "ITIM_HOME/bin/unix/config_remote_services.sh" -profile PosixAixProfile-jar PosixAixProfile.jar
 v For UNIX operating systems:-bash-3.00# ./config_remote_services.sh -profile LdapProfile-jar /opt/IBM/itim/config/adapters/LdapProfile.jar
 -bash-3.00# ./config_remote_services.sh -profile PosixSolarisProfile-jar /opt/IBM/itim/config/adapters/PosixSolarisProfile.jar
 -bash-3.00# ./config_remote_services.sh -profile PosixLinuxProfile-jar /opt/IBM/itim/config/adapters/PosixLinuxProfile.jar
 -bash-3.00# ./config_remote_services.sh -profile PosixHpuxProfile-jar /opt/IBM/itim/config/adapters/PosixHpuxProfile.jar
 -bash-3.00# ./config_remote_services.sh -profile PosixAixProfile-jar /opt/IBM/itim/config/adapters/PosixAixProfile.jar
 Note: You can also install them by selecting Configure System > Manage ServiceTypes > Import from the administrative console user interface.
 Related topics:
 “Installing agentless adapters” on page 40
 Modifying system properties during normal operationYou configure the Tivoli Identity Manager Server by managing system properties.For example, a system property determines how the server responds to the correctcompletion of a challenge question. System properties can be modified at any time.
 You might need to restart the Tivoli Identity Manager Server when changes aremade to certain system properties such as the server startup modules, which arenot recognized unless you restart the server. Restart the Tivoli Identity ManagerServer after modifying any property using the system configuration tool. Changesto other system properties can be recognized within 30 seconds. Logging propertiescan be changed without restarting the server and changes take effect within 5minutes.
 To modify system properties, use these choices:v Use the system configuration tool, runConfig. For more information, see
 “Modifying system properties with the system configuration tool.”v Change manually. For more information, see “Modifying system properties
 manually” on page 83.v Use the Tivoli Identity Manager Server GUI. For more information, see
 “Modifying system properties with the Tivoli Identity Manager GUI” on page83.
 Modifying system properties with the system configurationtool
 After installation, use the system configuration tool (runConfig) for the followingtasks:v Changing the password of the database user.
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v Specifying password encryption and updating Tivoli Identity Manager EJB userIDs and passwords.
 Modifying system properties manuallyAlternatively, you can manually modify system properties by editing theappropriate property file.
 System and supplemental property files are located on the Tivoli Identity ManagerServer in the ITIM_HOME\data directory. These files contain all the system andsupplemental properties used by the server. For more information about systemproperties located in the enRole.properties file, refer to the IBM Tivoli IdentityManager Information Center.
 Modifying system properties with the Tivoli Identity ManagerGUI
 You can also modify certain system properties from within the Configurationsection of the main menu navigation bar in the Tivoli Identity Manager ServerGUI.
 From the Set Systems Security tab, you can modify the following properties:v Enable/disable password editingv Password expiration period (number of days)
 This property is only for the Tivoli Identity Manager Server account. The userhas to change the password before this period is reached. Whenever a newpassword is set for the Tivoli Identity Manager Server account, the passwordexpiration period is affected from that time. You can disable password expirationby setting this value to zero.
 v Password retrieval expiration period (number of hours)After the new account is created, the user receives an e-mail with the URL linkthat provides the password. The user has to get the password before thispassword retrieval period expires.
 v Maximum number of invalid logon attemptsSets the maximum number of invalid logon attempts. If exceeded, the account issuspended. The default setting is ″0″ (unlimited logon attempts).
 From the Configure Forgotten Password Settings tab, you can modify the followingproperties:v Lost password question behavior
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Chapter 8. Performing a silent installation and configurationof Tivoli Identity Manager
 Tivoli Identity Manager can be run in a silent mode, which reads response filesthat contain input values to configure the directory server, database server,WebSphere Application Server, and Tivoli Identity Manager. Silent installation issupported in both single-server and cluster environments, and for clean installationand upgrade. Example response files are provided in the base DVD in theresponse_files directory.
 The installation program reads input from the two response files,installvariables.properties and configReponse.properties. Theinstallvariables.properties file has the installer-related input values such as theinstallation directory, database type, directory server type, and so on. TheconfigResponse.properties file has system configuration input values such as thedatabase server location, LDAP server location, and so on, There are differentfilenames for an upgrade scenario. The following set of response files are neededfor clean installation and for the upgrade depending on the application servertype:v Clean installation:
 – For single-server or deployment manager:installvariables.properties, configResponse.properties
 – For cluster members:installvariables.properties, configResponseCM.properties
 v Upgrade:
 – For single-server or deployment manager:installvariablesUpgrade.properties, configResponseUpgrade.properties
 – For cluster members: installvariablesUpgrade.properties,configResponseCMUpgrade.properties
 Notes:
 1. You can use a different file name for the installation response file (for example,installvariablesUpgrade.properties) because it can be passed to the installerwith the "-f" flag, but the name of the configuration response file must alwaysbe configResponse.properties
 2. The configResponse.properties or configResponseUpgrade.properties templateonly contains the minimum set of required system properties. You can addadditional system properties to the file if necessary. Use the convention:sysConfigResponse.propertyFileName.propertyName=value. For example:sysConfigResponse.enRoleLDAPConnection.enrole.ldapserver.ip=localhostsysConfigResponse.enRoleLDAPConnection.enrole.ldapserver.port=389sysConfigResponse.enRoleLDAPConnection.java.naming.security.principal=cn=rootsysConfigResponse.enRoleLDAPConnection.java.naming.security.credentials=xxxxxx
 The system configuration program running in silent mode sets the values of thelisted properties in the enRoleLDAPConnection.properties file. This file islocated in the ITIM_HOME/data directory.
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Before you beginBefore you run the silent install, install and configure any necessary middleware,such as a directory server, database server, directory integrator, and applicationserver. Ensure that all these components are working correctly and that you haveentered the correct data; any errors in setting up the system can result in thefailure of silent installation.
 Performing a silent installation in a single-server environmentTo perform a silent installation in a single-server environment, complete thesetasks:v Clean installation:
 1. Copy the response files installvariables.properties andconfigResponse.properties to a directory on the target computer.
 2. Update the response files with the correct values.3. Run ″instplatform -i silent -f installvariables.properties″ if you have the
 installer and the response files are at the same directory. The names for thesystem platform installer programs are:– Windows: instwin.exe– AIX: instaix.bin– Linux: instlinux.bin– Linux for System p: instplinux.bin– Linux for System z: instzlinux.bin– Solaris: instsol.bin
 Note: If you have the installer and the response files in the differentdirectory or in the different drive, then you have to use the relative orabsolute path for the installvariables.properties file and you have touse the absolute path for the configResponse.properties file. Forexample, if the response files are in the C:\temp directory on aWindows machine, use this command:instwin.exe -i silent -f C:\temp\installvariables.properties-DITIM_CFG_RESP_FILE_DIR=C:\temp
 UNIX machines use a different installer command, such as instaix.binfor AIX, and a different path.
 v Upgrade:
 1. Copy the response files installvariablesUpgrade.properties andconfigResponseUpgrade.properties to a directory on the target computer.
 2. Rename the configResponseUpgrade.properties file asconfigResponse.properties.
 3. Update the response files with the correct values.4. Run ″instplatform -i silent -f installvariablesUpgrade.properties″ if you have
 the installer and the response files are at the same directory. The names forthe system platform installer programs are:– Windows: instwin.exe– AIX: instaix.bin– Linux: instlinux.bin– Linux for System p: instplinux.bin– Linux for System z: instzlinux.bin
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– Solaris: instsol.bin
 Note: If you have the installer and the response files in the differentdirectory or in the different drive, then you have to use the relative orabsolute path for the installvariables.properties file and you have touse the absolute path for the configResponse.properties file. Forexample, if the response files are in the C:\temp directory on aWindows machine, use this command:instwin.exe -i silent -f C:\temp\installvariablesUpgrade.properties-DITIM_CFG_RESP_FILE_DIR=C:\temp
 UNIX machines use a different installer command, such as instaix.binfor AIX, and a different path.
 Silent installation might take some time to complete. To check on the installationprogress, check the itim_install_activity.log file located in the ITIM_HOME\install_logs directory.
 Verify the installation and troubleshoot to resolve any problems that happenedduring installation and startup. For more information, see Chapter 9, “Verifyingand troubleshooting the installation,” on page 93.
 Performing a silent installation in a cluster environmentTo perform a silent installation in a cluster environment, complete these tasks:v Clean installation:
 – On the deployment manager:1. Copy the response files installvariables.properties and
 configResponse.properties to a directory on the target computer.2. Update the response files with the correct values.3. Run ″instplatform -i silent -f installvariables.properties″ if you have the
 installer and the response files are at the same directory. The names forthe system platform installer programs are:- Windows: instwin.exe- AIX: instaix.bin- Linux: instlinux.bin- Linux for System p: instplinux.bin- Linux for System z: instzlinux.bin- Solaris: instsol.bin
 Note: If you have the installer and the response files in the differentdirectory or in the different drive, then you have to use the relativeor absolute path for the installvariables.properties file and you haveto use the absolute path for the configResponse.properties file. Forexample, if the response files are in the C:\temp directory on aWindows machine, use this command:instwin.exe -i silent -f C:\temp\installvariables.properties-DITIM_CFG_RESP_FILE_DIR=C:\temp
 UNIX machines use a different installer command, such asinstaix.bin for AIX, and a different path.
 – On the cluster members:
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1. Copy the response files installvariables.properties andconfigResponseCM.properties to a directory on the target computer.
 2. Rename the configResponseCM.properties file asconfigResponse.properties.
 3. Update the response files with the correct values.4. Run ″instplatform -i silent -f installvariables.properties″ if you have the
 installer and the response files are at the same directory. The names forthe system platform installer programs are:- Windows: instwin.exe- AIX: instaix.bin- Linux: instlinux.bin- Linux for System p: instplinux.bin- Linux for System z: instzlinux.bin- Solaris: instsol.bin
 Note: If you have the installer and the response files in the differentdirectory or in the different drive, then you have to use the relativeor absolute path for the installvariables.properties file and you haveto use the absolute path for the configResponse.properties file. Forexample, if the response files are in the C:\temp directory on aWindows machine, use this command:instwin.exe -i silent -f C:\temp\installvariables.properties-DITIM_CFG_RESP_FILE_DIR=C:\temp
 UNIX machines use a different installer command, such asinstaix.bin for AIX, and a different path.
 v Upgrade:
 – On the deployment manager:1. Copy the response files installvariablesUpgrade.properties and
 configResponseUpgrade.properties to a directory on the target computer.2. Rename the configResponseUpgrade.properties file as
 configResponse.properties.3. Update the response files with the correct values.4. Run ″instplatform -i silent -f installvariablesUpgrade.properties″ if you
 have the installer and the response files are at the same directory. Thenames for the system platform installer programs are:- Windows: instwin.exe- AIX: instaix.bin- Linux: instlinux.bin- Linux for System p: instplinux.bin- Linux for System z: instzlinux.bin- Solaris: instsol.bin
 Note: If you have the installer and the response files in the differentdirectory or in the different drive, then you have to use the relativeor absolute path for the installvariablesUpgrade.properties file andyou have to use the absolute path for the configResponse.propertiesfile. For example, if the response files are in the C:\temp directoryon a Windows machine, use this command:instwin.exe -i silent -f C:\temp\installvariablesUpgrade.properties-DITIM_CFG_RESP_FILE_DIR=C:\temp
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UNIX machines use a different installer command, such asinstaix.bin for AIX, and a different path.
 – On the cluster members:1. Copy the response files installvariablesUpgrade.properties and
 configResponseCMUpgrade.properties to a directory on the targetcomputer.
 2. Rename the configResponseCMUpgrade.properties file asconfigResponse.properties.
 3. Update the response files with the correct values.4. Run ″instplatform -i silent -f installvariablesUpgrade.properties″ if you
 have the installer and the response files are at the same directory. Thenames for each system platform installer programs are:- Windows: instwin.exe- AIX: instaix.bin- Linux: instlinux.bin- Linux for System p: instplinux.bin- Linux for System z: instzlinux.bin- Solaris: instsol.bin
 Note: If you have the installer and the response files in the differentdirectory or in the different drive, then you have to use the relativeor absolute path for the installvariablesUpgrade.properties file andyou have to use the absolute path for the configResponse.propertiesfile. For example, if the response files are in the C:\temp directoryon a Windows machine, use this command:instwin.exe -i silent -f C:\temp\installvariablesUpgrade.properties-DITIM_CFG_RESP_FILE_DIR=C:\temp
 UNIX machines use a different installer command, such asinstaix.bin for AIX, and a different path.
 Silent installation might take some time to complete. To check on the installationprogress, check the itim_install_activity.log file located in the ITIM_HOME\install_logs directory.
 Verify the installation and troubleshoot to resolve any problems that happenedduring installation and startup. For more information, see Chapter 9, “Verifyingand troubleshooting the installation,” on page 93.
 Configuring the database silentlyTo configure the database using a response file:1. Copy the configResponse.properties file to a directory on the target computer.2. Update configResponse.properties file with correct database information.3. Edit the ITIM_HOME/bin/DBConfig.lax file to set the value for the following
 two properties:IS_SILENT=trueRESPONSE_FILE=full path to the configResponse.properties file
 4. Invoke the database configuration program:ITIM_HOME/bin/DBConfig
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The database configuration might take a few minute to complete. To monitor onthe configuration progress, view the dbConfig.stdout file located in theITIM_HOME/install_logs directory.
 Configuring the directory server silentlyTo configure the directory server using a response file:1. Copy the configResponse.properties file to a directory on the target computer.2. Update configResponse.properties file with correct directory server information.3. Edit the ITIM_HOME/bin/ldapConfig.lax file to set the value for the following
 two properties:IS_SILENT=trueRESPONSE_FILE=full path to the configResponse.properties file
 4. Invoke the LDAP configuration program:ITIM_HOME/bin/ldapConfig
 The directory server configuration might take a few minute to complete. Tomonitor the configuration progress, view the ldapConfig.stdout file located in theITIM_HOME/install_logs directory.
 Configuring the system silently in a single-server environmentTo configure the system using a response file:1. Copy the configResponse.properties file to a directory on the target computer.2. Update configResponse.properties file with correct information.3. Edit the ITIM_HOME/bin/runConfig.lax file to set the value for the following
 two properties:IS_SILENT=trueRESPONSE_FILE=full path to the configResponse.properties file
 4. Start the WebSphere Application Server.5. Invoke the system configuration program:
 ITIM_HOME/bin/runConfig install
 The system configuration might take a few minute to complete. To monitor theconfiguration progress, view the runConfig.stdout file located in theITIM_HOME/install_logs directory.
 Configuring the system silently in a cluster environmentTo configure the system using a response file:1. On the deployment manager, copy the configResponse.properties to a directory
 on the target computer.2. On the cluster member system copy the configResponseCM.properties file and
 rename it to configResponse.properties in a directory on the target computer.3. Update configResponse.properties file with correct information.4. Edit the ITIM_HOME/bin/ldapConfig.lax file to set the value for the following
 two properties:IS_SILENT=trueRESPONSE_FILE=full path to the configResponse.properties file
 5. Start the WebSphere deployment manager and all the node agents.6. Invoke the system configuration program:
 ITIM_HOME/bin/runConfig install
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The system configuration might take a few minute to complete. To monitor theconfiguration progress, view the runConfig.stdout file located in theITIM_HOME/install_logs directory.
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Chapter 9. Verifying and troubleshooting the installation
 This section describes how to correct problems with the Tivoli Identity Managerinstallation. It also explains how to verify that the Tivoli Identity Manager Serverand its prerequisite processes are running correctly.
 You can test whether the database, the directory server, and other programs thatthe Tivoli Identity Manager Server uses are correctly configured and are in fullcommunication with each other.
 Correcting problems with starting the installationIf you cannot start the Tivoli Identity Manager installation program, check theserequirements:v Is there enough real memory available to run the installation program? For more
 information, refer to the IBM Tivoli Identity Manager Information Center.v Are the correct operating system levels, patches, and space requirements
 provided for the hardware and software prerequisites? For more information,refer to the IBM Tivoli Identity Manager Information Center.
 v Does the installation program have the correct file permissions to run?Administrative privileges are required.
 v Is your firewall preventing processes that are active during installation fromaccessing external resources? For example, if you have a firewall that preventsldapsearch from connecting to the directory server, the Tivoli Identity Managerinstallation fails.
 v If the installation is on a UNIX or Linux system, do you have the correctpermissions and display variables set?A common mistake is to log in to the desktop, omit disabling access control, andthen telnet or SSH to a remote host on which you intend to install the TivoliIdentity Manager Server. To correct this problem, complete these tasks:1. Run this command at the command shell of your desktop to disable access
 control for the X Server:xhost +
 2. After you telnet or SSH to the remote host, run this command to set theDISPLAY environment variable:export DISPLAY=hostname:0.0
 The value of hostname is the host name or IP address of your local desktopcomputer.
 Tivoli Identity Manager configuration errorsCheck the Tivoli Identity Manager activity summary log file(itim_install_activity.log). If a non-fatal error is reported and it involves DBConfig,ldapConfig, or system configuration, you can use stand-alone Tivoli IdentityManager configuration utilities to recover. For more information about theseutilities, see Chapter 7, “Configuring the Tivoli Identity Manager Server,” on page73.
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Verifying the installationThis section describes verifying whether the database, the directory server, andother programs that the Tivoli Identity Manager Server uses are correctlyconfigured and are in full communication with the Tivoli Identity Manager Server.
 Ensuring that the WebSphere Application Server is runningThe WebSphere Application Server on which the Tivoli Identity Managerapplication is deployed needs to be running.
 To determine whether the WebSphere Application Server is running, enter thiscommand:v Windows operating systems:
 WAS_PROFILE_HOME\bin\serverStatus.bat -all
 v UNIX or Linux operating systems:WAS_PROFILE_HOME/bin/serverStatus.sh -all
 If you do not find the process running, run this command to start the server:v Windows operating systems:
 – WAS_PROFILE_HOME\bin\startServer.bat server_name
 v UNIX or Linux operating systems:– WAS_PROFILE_HOME/bin/startServer.sh server_name
 The value of server_name is the name of the WebSphere Application Server. Forexample, server1.
 Additionally, examine the log files in the logs directory for entries that indicate thestatus of server1. For example, examine the log files in the WAS_PROFILE_HOME\logs\server1 directory.
 Verifying that the Tivoli Identity Manager Server is runningTo verify that the Tivoli Identity Manager Server and related processes are running,complete these steps:1. Ensure that the WebSphere Application Server is running.
 Start the WebSphere administrative console. On a browser, enter this Webaddress:http://hostname:port/ibm/console
 The value of hostname is the fully qualified host name or the IP address of thecomputer on which the WebSphere Application Server is running. The value ofport is the port number for the WebSphere administrative HTTP transport. Thedefault value is 9060.
 2. On the WebSphere administrative console, click Applications > EnterpriseApplications and verify that the Tivoli Identity Manager Server is running. Ifthe Tivoli Identity Manager Server is not running, select the application, andthen click Start.If the Tivoli Identity Manager Server does not start, examine the following logfiles:v WAS_PROFILE_HOME\logs\server_name\SystemOut.log
 The value of profile_name is the name of the WebSphere Application Serverprofile running Tivoli Identity Manager.The value of servername is typically server1 for single-server environments.
 v TIVOLI_COMMON_DIRECTORY\CTGIM\logs\trace.log
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In this directory, also examine the msg.log file. Installing Tivoli IdentityManager Server defines the value of TIVOLI_COMMON_DIRECTORY.
 3. Log on to the Tivoli Identity Manager Server using the WebSphere embeddedHTTP transport. For example, at a browser window, enter this command:http://hostname:port/itim/console
 The value of hostname is the fully qualified host name or the IP address of thecomputer on which the WebSphere Application Server is running. The value ofport is the port number of the WebSphere virtual host. The default port numberis 9080. The port number can be removed if an HTTP server is used as thefront-end proxy.The browser displays the Tivoli Identity Manager login window. To log in toTivoli Identity Manager, enter the Tivoli Identity Manager Server administratoruser ID (itim manager) and password (immediately after installation, the valueis secret).
 4. After a first, successful login, the login window immediately prompts you tochange the administrator password. Ensure that your password change issuccessful.
 Note: It is recommended you create a backup administrator user ID with thesame access rights as the "itim manager″ user ID.
 5. If continued attempts fail to log on to Tivoli Identity Manager, determinewhether the SystemOut.log file contains errors about referencing Tivoli IdentityManager properties files.Ensure that the ITIM_HOME\data directory contains the properties files.Additionally, ensure that the WebSphere Application Server also references theITIM_HOME\data directory. Complete these steps:a. On the WebSphere administrative console, click Servers > Application
 Servers.b. Select a server such as server1 and under Server Infrastructure > Java and
 Process Management, click Process Definition.c. In the Process Definition, click Java Virtual Machine.d. Ensure that the Classpath field specifies the {ITIM_HOME}\data directory.
 6. If continued attempts fail, examine the status of the Tivoli Identity Managermiddleware.v “Testing the database connection” on page 96v “Ensuring that the directory server is operational” on page 98
 Checking the Tivoli Identity Manager bus and messaging engineBefore starting the Tivoli Identity Manager Server, use the WebSphereadministrative console to check the status of the bus and messaging engine.
 To check the bus and messaging engine, complete these steps:1. Start the WebSphere administrative console.
 http://hostname:port/ibm/console
 The value of hostname is the fully qualified host name or the IP address of thecomputer on which the WebSphere Application Server is running. The value ofport is the port number for the WebSphere administrative HTTP transport. Thedefault value is 9060.
 2. Click Service Integration > Buses.3. If the bus has been set, you see the itim_bus. Click itim_bus.4. In the Topology section, click Messaging engines.
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For a single-server installation, you see an engine named nodename.servername-itim_bus and the status of the engine is started.For a cluster installation, you see n+1 messaging engines, where n is thenumber of Tivoli Identity Manager cluster members. An additional messagingengine is used for the Tivoli Identity Manager messaging cluster. All theseengines need to be started.
 If a message engine is not started, click the messaging engine name, and under theAdditional Properties section, click Message store to see the data source JNDIname. From this JNDI name, you can link the Tivoli Identity Manager data sourcedefined under the Resources section and test the data source connection. If thedata source connection test fails, see “Testing the database connection” for moreinformation about how to resolve the issue. If the connection test succeeds,examine the WAS_PROFILE_HOME\logs\server_name\SystemOut.log file todetermine the reason that the messaging engine cannot be started.
 Verifying that the database is running correctly
 Testing the database connectionBefore starting the Tivoli Identity Manager Server, use the WebSphereadministrative console to test the database connection. Complete these steps:1. Start the WebSphere administrative console.
 http://hostname:port/ibm/console
 The value of hostname is the fully qualified host name or the IP address of thecomputer on which the WebSphere Application Server is running. The value ofport is the port number for the WebSphere administrative HTTP transport. Thedefault value is 9060.
 2. Click Resources > JDBC > Data Sources.3. Select ITIM Data Source.4. Click Test Connection. A message appears that indicates the test result.
 Repeat these steps for the ITIM Bus DataSource, and for clusters, additionally testthe ITIM BUS Shared DataSource.
 If any connections do not work, complete these steps:1. The CLASSPATH definition of the JDBC provider is set up during the Tivoli
 Identity Manager installation. Verify that the CLASSPATH value is correct.Complete these steps:a. Start the WebSphere administrative console.
 http://hostname:port/ibm/console
 The value of hostname is the fully qualified host name or the IP address ofthe computer on which the WebSphere Application Server is running. Thevalue of port is the port number for the WebSphere administrative HTTPtransport. The default value is 9060.
 b. Click Resources > JDBC > JDBC Providers > ITIM XA DB2 JDBCProvider.
 c. Examine the properties to verify that the CLASSPATH value is correct. Forexample, its value is like these values for DB2:$ITIM_DB_JDBC_DRIVER_PATH\db2jcc.jar$ITIM_DB_JDBC_DRIVER_PATH\db2jcc_license_cisuz.jar$ITIM_DB_JDBC_DRIVER_PATH\db2jcc_license_cu.jar
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To determine the value of $ITIM_DB_JDBC_DRIVER_PATH, clickEnvironment > WebSphere Variables. Scroll through the list to locate thevariable and confirm it is correct.
 2. Verify that the DB2 user ID and password are correct. Complete these steps:a. Start the WebSphere administrative console.
 http://hostname:port/ibm/console
 The value of hostname is the fully qualified host name or the IP address ofthe computer on which the WebSphere Application Server is running. Thevalue of port is the port number for the WebSphere administrative HTTPtransport. The default value is 9060.
 b. Click Resources > JDBC > Data Sources > ITIM Data Source.c. Examine these fields to verify the correct values:v Component-managed Authentication Alias
 The value isitim-init.v Container-managed Authentication Alias
 The value is itim-init.d. Under the Related Items category, click JAAS - J2C authentication data
 Examine the Alias list to ensure that an itim-init entry exists.1) Click itim-init.2) Verify that the value of the user ID field is identical to the Tivoli
 Identity Manager Database User specified in ITIM_HOME\data\enRole.properties file, for example, itimuser. Do not change this value.
 3) Note the password field. If you use this field to reset the password,ensure that the password value that you enter is identical to the valuedefined in the ITIM_HOME\data\enRoleDatabase.properties file.
 3. Ensure that other database settings are correct by checking the status of theDB2 service listening port (typically 50000, 50002, or 60000) by using a utilitysuch as netstat. The system etc directory contains a file called services whichcontains the actual port number being used. For more information, see“Determining the correct service listening port and service name” on page 17.
 4. If DB2 is not listening on the port and you are using IPv6 and UNIX/Linux toconnect to DB2, you might need to modify your /etc/hosts file. Complete thesesteps:a. On the machine running IPv6, append these two lines to your /etc/hosts
 file:IPv4_address hostnameIPv6_address hostname
 For example, if the hostname is myhost, the IPv6_address is0000:ffff:ffff:0000:20e:cff:fe50:39c8 and the IPv4_address is192.168.4.4, then you need to append these two lines in the /etc/hosts file.
 b. Log in as the DB2 instance owner and restart the DB2 server by issuing thefollowing commands:db2stopdb2start
 c. Ensure that DB2 is running on the IPv6 address by issuing the followingcommand:netstat -an | grep db2port
 For example, if the db2 is running on the port 50000, then you see thefollowing line as the output:
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tcp 0 0 :::50000 :::* LISTEN
 Troubleshooting SQL Server 2005 issuesWhen the itim manager account logs in for the first time the user is typicallyprompted to change the password. This prompt might not work in case of SQLServer 2005. In order to resolve this issue, complete these steps:1. After installing Tivoli Identity Manager, log in to the SQL Server 2005 host
 computer.2. Launch the Microsoft SQL Server Management Studio.3. Expand the SQL server in the object explorer.4. Expand Databases and move to the master database.5. Expand Security > Schemas.6. Right click DBO and click Properties
 7. Click Permissions, click Add, and browse to add the required users.8. Grant all permissions to these required users and click OK.9. Restart the server, disconnect, and reconnect with user sa in mixed
 authentication mode.
 Verifying that the directory server is properly running
 Ensuring that the directory server is operationalThis section describes the steps to ensure that the installed directory server forTivoli Identity Manager is running.
 To determine whether the IBM Tivoli Directory Server is running, complete thesesteps:v On Windows systems, click Start > Programs > Administrative Tools >
 Services. Locate the directory server entry, such as IBM Tivoli Directory ServerInstance V6.2 - ldapdb2Ensure that the directory server service is started. If the service has not started,select it, and then select Action > Start from the main menu of the Serviceswindow.
 v On UNIX/Linux systems, ensure that the ibmslapd process is running. Enter thiscommand:ps -ef | grep ibmslapd
 The ps (process) command searches for processes. The grep command selects theprocesses that contain a string. The parameters in this example include:
 -e Select all processes.
 -f Display a full listing.If the IBM Tivoli Directory Server is running, a process ID (PID) number isreturned. If a PID number is not returned, the server must be restarted. First,stop the server:ibmslapd -I <instancename> -k
 Restart the server:ibmslapd -I <instancename>
 v If the IBM Tivoli Directory Server is running, you must ensure that the IBMTivoli Directory Server is not in configuration mode only. Enter this command:ldapsearch -s base -b " " objectclass=* ibm-slapdisconfigurationmode
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If the IBM Tivoli Directory Server is not in configuration mode, the value of theibm-slapdisconfigurationmode parameter is FALSE. The ldapsearch commandopens a connection to an LDAP server, binds, and performs a search. The -sparameter specifies the scope of the search to be base, one, or sub, whichsearches the base object, one level, or subtree. The -b parameter uses searchbaseas the starting point for the search, instead of the default.
 If problems continue, examine the ibmslapd.log file for messages that indicatewhether the directory server is completely or partially started. The location of thelog file depends on the IBM Tivoli Directory Server version:
 Windows:ITDS_INSTANCE_HOME\logs\ibmslapd.log. For example, the file is in theC:\idsslapd-ldapdb2\logs directory.
 UNIX/Linux:ITDS_INSTANCE_HOME/etc/ibmslapd.log. On Linux, for example, the fileis in the /home/ldapdb2/idsslapd-ldapdb2/etc/logs directory.
 Checking the Web browser operationThis section describes potential problems associated with the Web browser.
 Ensuring that the browser registers the Java plug-inTivoli Identity Manager uses applets that require the Java plug-in, which isprovided by the Java 2 Runtime Environment, Standard Edition (JRE). The Javaplug-in provides a connection between browsers and the Java platform, andenables applets to run within a browser. For more information about the version ofthe Java plug-in that Tivoli Identity Manager supports, refer to the Tivoli IdentityManager Information Center.
 If the Java plug-in is not installed on your system, or is not at a supported level,the browser prompts you to install the plug-in. For more information about thesesteps, refer to the Tivoli Identity Manager Information Center.
 Microsoft Internet Explorer: Enabling active scriptingFor Microsoft Internet Explorer, ensure that the Active Scripting item is enabled inthe Scripting section of the Internet Options. Complete these steps:1. Click Tools > Internet Options on the main menu.2. On the Security tab, click the Internet icon, and then click the Custom Level
 button.3. In the Scripting, Active Scripting area, select Enable.4. Click OK.5. In the Internet Options window, click OK.
 Using a supported browserYou might not be able to log on to Tivoli Identity Manager for various reasons. Forexample, you could be using an unsupported Web browser. For a list of supportedbrowsers, refer to the Tivoli Identity Manager Information Center.
 Avoiding two Web browser sessions on the same computerDo not start two separate browser sessions from the same client computer. The twosessions are regarded as one session ID, which causes problems with data.
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Troubleshooting Tivoli Identity Manager within WebSphere ApplicationServer
 The Tivoli Identity Manager application runs within the WebSphere ApplicationServer as an enterprise application. The Tivoli Identity Manager installationprogram uses the WebSphere command-line interface (wsadmin) to deploy theTivoli Identity Manager application onto the WebSphere Application Server.Deploying the Tivoli Identity Manager application also performs certainconfiguration steps on the WebSphere Application Server.
 When the deployment completes, the Tivoli Identity Manager files are in thesedirectories:v WAS_PROFILE_HOME\installedApps\cellname\ITIM.earv WAS_PROFILE_HOME\config\cells\cellname\applications\ITIM.ear
 If the deployment fails, check the installation log files under ITIM_HOME\install_logs\ starting with the itim_install_activity.log, and examine thesetupEnrole.stdout log file.
 Correcting connection scripting errorsIf the log data indicates a failure to establish a SOAP connection to the WebSphereApplication Server configuration manager, or some type of WebSphere ApplicationServer scripting error, complete these steps:1. Resolve the problem that prevents the connection to the WebSphere Application
 Server or the problem described as a scripting error. For more information,refer to the WebSphere documentation.
 2. Run one of the following commands to deploy the Tivoli Identity ManagerServer onto the WebSphere Application Server:v If WebSphere administrative security and application security is on, run this
 command (this command is one line):ITIM_HOME\bin\setupEnrole.exe install server:name user:user_idpassword:pwd ejbuser:ejb_user_id
 The value of server_name is the name of the WebSphere Application Server onwhich the Tivoli Identity Manager application is deployed. The value ofuser_id is the WebSphere administrator user ID, such as wasadmin. The valueof pwd is the password for the WebSphere administrator user ID, such aswasadmin. The value of ejb_user_id is the Tivoli Identity Manager EJB user ID,which uses the WebSphere Application Server administrator user ID bydefault.
 v If WebSphere administrative security and application security is off, enterthis command:ITIM_HOME\bin\setupEnrole.exe install server:name
 Correcting timeout errorsIf the log data indicates that the failure is due to a timeout error, continue theTivoli Identity Manager installation process.
 If the Tivoli Identity Manager installation program has completed, delete thefollowing directories if they exist:v WAS_PROFILE_HOME\installedApps\cellname\ITIM.earv WAS_PROFILE_HOME\config\cells\cellname\applications\ITIM.ear
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Run one of the following commands to deploy the Tivoli Identity Manager Serveronto the WebSphere Application Server:v If WebSphere administrative security and application security is on, run this
 command:– Windows operating systems:
 ITIM_HOME\bin\setupEnrole.exe install server:name user:user_idpassword:pwd ejbuser:ejb_user_id
 – UNIX or Linux operating systems:ITIM_HOME/bin/setupEnrole.sh install server:name user:user_idpassword:pwd ejbuser:ejb_user_id
 The value of server_name is the name of the WebSphere Application Server onwhich the Tivoli Identity Manager application is deployed. The value of user_idis the WebSphere administrator user ID, such as wasadmin. The value of pwd isthe password for the WebSphere administrator user ID, such as wasadmin. Thevalue of ejb_user_id is the Tivoli Identity Manager EJB user ID, which uses theWebSphere Application Server administrator user ID by default.
 v If WebSphere administrative security and application security is off, enter thiscommand:– Windows operating systems:
 ITIM_HOME\bin\setupEnrole.exe install server:name
 – UNIX or Linux operating systems:ITIM_HOME/bin/setupEnrole.sh install server:name
 Determining the port number of the default hostIf you have multiple instances of WebSphere Application Server running on thesame computer, the port number might be a different value. To determine the portnumber of the default host, complete these steps:1. Log in to the WebSphere Application Server administrative interface.2. Click Server > Application servers.3. Click the server which hosts the Tivoli Identity Manager application cluster
 member.4. Under the Communications section, click the Ports link.5. Find the port number listed next to the WC_defaulthost port name. This port
 number is the one used to connect to Tivoli Identity Manager.
 Log filesWhen the system configuration is complete, you can find the log files in Table 5 inthe directories specified.
 Table 5. Installation log file names and directories
 File names Description and location
 log.txt Installation log file for WebSphereApplication Server.
 Located in the system temp directory.
 v itim_install.stdout
 v itim_install.stderr
 Standard out and error log files for TivoliIdentity Manager.
 Located in the system root directory.
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Table 5. Installation log file names and directories (continued)
 File names Description and location
 v dbConfig.stdout
 v ldapConfig.stdout
 v dbUpgrade.stdout
 v ldapUpgrade.stdout
 v itim_installer_debug.txt
 v runConfigFirstTime.stdout
 v runConfig.stdout
 v setupEnrole.stdout
 v StartStopWas.stdout
 v itim_install_activity.log
 Located in the ITIM_HOME\install_logsdirectory.
 trace.log
 msg.log
 Located in theTIVOLI_COMMON_DIRECTORY\CTGIM\logs\ directory.
 The Tivoli Common Directory is thecentral location for allserviceability-related files, such as log filesand first-failure capture data.
 cfg_itim_mw.log Located in the System %TEMP% directory.
 The middleware configuration utility logfile.
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Chapter 10. Upgrading to Tivoli Identity Manager Version 5.1
 The Tivoli Identity Manager installation program upgrades a computer that has thefollowing versions of Tivoli Identity Manager:v Tivoli Identity Manager Version 4.6v Tivoli Identity Manager Version 5.0
 Some manual steps are required to preserve or recustomize settings. This sectiondescribes upgrading both single-server and cluster configurations. For moreinformation about prerequisite software that this release supports, refer to the TivoliIdentity Manager Information Center.
 Description of the upgrade processThe upgrade process has these major tasks:1. Migrate your operating system to a level that this release of Tivoli Identity
 Manager supports, and ensure that the system has the required fix pack orpatches. For more information about operating system requirements, see theIBM Tivoli Identity Manager Information Center Release Information.
 Note: If you are upgrading from Linux SUSE 9 to SUSE 10, make sure to backup your existing /etc/services file before the upgrade and copy the fileback to the /etc directory after upgrade.
 2. Migrate your database to the supported version, and ensure that you canperform database commands.
 3. Migrate your directory server to the supported version, and ensure that youcan perform directory server commands.
 4. If you are using IBM Tivoli Directory Integrator, migrate it to the supportedversion.
 5. If you are upgrading from Tivoli Identity Manager Version 4.6, installWebSphere Application Server Version 6.1 in a separate directory. RunningWebSphere Application Server Version 6.1 upgrade utilities (WASPreUpgradeand WASPostUpgrade) is not recommended. To perform the installation,perform the following tasks:v Single-server: Install WebSphere Application Server 6.1 and any necessary fix
 packs for a stand-alone node.v Cluster: Install WebSphere Application Server 6.1 and any necessary fix packs
 on the deployment manager node and each cluster member node, thenfederate the nodes to the cell and create a cluster.
 If you do not want to disable the old version of WebSphere Application Serverupon installing WebSphere Application Server Version 6.1, make sure to choosethe option to allow coexistence with WebSphere Application Server Version 5.1.WebSphere Application Server Version 6.1 detects any port conflicts with theolder version.For more information about installation, refer to Chapter 5, “Installing andconfiguring WebSphere Application Server,” on page 41 or the WebSpheredocumentation at this Web site:http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/index.jspIf you are upgrading from Tivoli Identity Manager Version 5.0, apply anynecessary fix packs to WebSphere Application Server 6.1.
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6. If you are upgrading from Tivoli Identity Manager Version 4.6, stop the oldversion of WebSphere Application Server where Tivoli Identity Manager isrunning:v Single-server: Stop WebSphere Application Server Version 5.1.v Cluster: Stop WebSphere Application Server Version 5.1 on all nodes in the
 cell where Tivoli Identity Manager is running and stop the WebSphereApplication Server deployment manager.
 7. Upgrade the Tivoli Identity Manager Server using the Tivoli Identity ManagerVersion 5.1 installation program.The Tivoli Identity Manager installation program upgrades the databaseschema and data, the directory server schema and data, the WebSphereApplication Server configuration for Tivoli Identity Manager, the Tivoli IdentityManager property files, and other Tivoli Identity Manager files. During theupgrade process, the ITIM_HOME\data directory is backed up to theITIM_HOME\data\backup directory for later recovery if necessary.If you are using IBM Tivoli Directory Integrator, you need to upgrade theadapters separately. See the IBM Tivoli Identity Manager Information CenterAdapter document for detailed instructions.
 Note: To perform the upgrade, you must select the current ITIM_HOMEdirectory as the Tivoli Identity Manager Version 5.1 installation location.After making an upgrade, you can validate the current Tivoli IdentityManager version by examining the copyright notice in the header of theMessages.properties file in the ITIM_HOME\data directory.
 Processes and settings that the upgrade process preservesThe upgrade process preserves running workflow processes pending for approvalor other related actions such as password changes. If you are upgrading fromTivoli Identity Manager 4.6, for these workflow processes to continue to run afterupgrade, you need to ensure that no messages are in the Java Message Service(JMS) queues. For more information, see “Determining that the WebSphere MQmessage queue is empty” on page 113.
 The upgrade process preserves the following settings:v Certificate-authority (CA) certificates. Tivoli Identity Manager demonstration
 certificates are updated.v Tivoli Identity Manager properties defined in the following files:
 – enRole.properties– enRoleAuthentication.properties– enRoleDatabase.properties– enRoleLDAPConnection.properties– enRoleMail.properties– enRoleLogging.properties– enroleAuditing.properties– enroleworkflow.properties– ui.properties– CustomLabels.properties– CustomLabels_en.properties– adhocreporting.properties– crystal.properties
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– SelfServiceScreenText.properties– SelfServiceScreenText_en.properties– SelfServiceHelp.properties– SelfServiceUI.properties– SelfServiceHomePage.properties– scriptframework.properties
 v The following workflow system files in the data\workflow_systemprocessdirectory:– notifytemplate.html
 Note: The notification template has been modified since Tivoli IdentityManager Version 5.0. To use the new template, renamenotifytemplate.html.5.0 back to notifytemplate.html. For moreinformation about migration of notification templates, see “Migratingnotification templates” on page 114.
 – addserviceselectionpolicy.xmlv Any default notification templates stored in LDAP if they were modified in
 Tivoli Identity Manager Version 4.6 or 5.0. If you are upgrading from TivoliIdentity Manager 4.6 and none of the default notification templates weremodified in Version 4.6, the upgrade process replaces all of them with the newtemplates. For more information about manual migration of notificationtemplates, see “Migrating notification templates” on page 114.
 Processes and settings that are not preserved, or requiremanual upgrade
 The upgrade process does not preserve the following workflow processes, whichyou must stop or allow to complete before you upgrade Tivoli Identity Manager:v Policy Add/Modify/Removev Dynamic Role Add/Modify/Removev Reconciliationsv Identity feeds
 All other customized data and settings are lost after the upgrade process. For moreinformation, see “Preserving customized data manually” on page 114. These usercustomizations are not preserved:v Java security (for Tivoli Identity Manager 4.6 on WebSphere Application Server
 5.1)If you are upgrading from Tivoli Identity Manager 4.6, you need to manuallyapply the changes that you made for the previous IBM Development Kit for Javato the new IBM Development Kit for Java bundled with WebSphere ApplicationServer 6.1.
 v Custom logos used in a Welcome page and XLS style sheets. If you modified thewelcome page, you must reimplement the Styles.css file.
 v EJB user ID and password (for Tivoli Identity Manager 4.6 on WebSphereApplication Server 5.1)During upgrade the user enters the WebSphere Application Server 6.1administrator user ID and password. If you are running Tivoli Identity Manager4.6 on WebSphere Application Server 5.1, the user ID and password might be thesame or different from this new entry. The default Tivoli Identity Manager EJBuser ID and password on the Security tab of the system configuration GUI is setas the same as the WebSphere Application Server 6.1 administrative user ID and
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password. Change the EJB user ID and password if the user ID and passwordare different from the WebSphere Application Server administrative user ID andpassword.
 v Any customized WebSphere Application Server configurations. Examples includethe ITIM_CLIENT role mapping, which must be remapped, and the sharedlibrary used by Tivoli Identity Manager through a WebSphere Application Servershared library definition.
 v Crystal configurationBack up all existing Crystal configuration scripts before performing the upgradeso the same scripts can be referenced later. For more information about Crystalconfiguration, see “Configuring Crystal” on page 119.
 Additionally, manually upgrade the following components:v Tivoli Identity Manager jar files that the Tivoli Identity Manager client
 applications use.Tivoli Identity Manager client applications must replace their currentitim_api.jar, api_ejb.jar, itim_server_api.jar and jlog.jar files with those files fromTivoli Identity Manager Version 5.1.For any Tivoli Identity Manager client application that has a duplicate copy ofTivoli Identity Manager properties files on the client side, take these steps:1. Rename the duplicate property files on the client application to preserve any
 manual changes that you might have made.2. Copy the property files from the Tivoli Identity Manager Server to the
 duplicate copy on the client application.3. If you manually changed the duplicate property files earlier, manually apply
 the changes again.v The HR Feed services forms in Tivoli Identity Manager 5.1 add a new check box
 for evaluating Separation Of Duty policies. To enable this feature, use ConfigureSystem -> Design Form to include the new attribute erevaluatesod in the HRfeed service definition form. The erevaluatesod attribute is of the type booleanand needs to be include as a check box on the form.
 v Tivoli Identity manager Version 5.1 has introduced new default access controlitems, however the upgrade process does not change the access control items forthe existing organizations. You need to manually upgrade them. For moredetails, see “Manually upgrading the access control items” on page 119.
 Before you beginBefore upgrading Tivoli Identity Manager complete these steps:1. Reduce system activity before starting the upgrade process.
 It is recommended that you avoid starting policy enforcements or reconciliationrequests before upgrading Tivoli Identity Manager. Do not delete entriesdirectly from the SCHEDULED_MESSAGES table in the Tivoli IdentityManager database.
 2. Complete or stop the following workflow processes, which are not preservedduring upgrade:v Policy Add/Modify/Removev Dynamic Role Add/Modify/Removev Reconciliationsv Identity feeds
 3. Make sure that no new workflow requests are submitted before the upgradeprocess by shutting down API clients and turning off web access to the Tivoli
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Identity Manager application. If you are upgrading from Tivoli IdentityManager 4.6, for running workflow processes to continue to run after upgrade,make sure that the JMS messages in the JMS queues are clear. See “Determiningthat the WebSphere MQ message queue is empty” on page 113 for details onhow to check the JMS queues.
 4. Migrate the database server to the supported version. Then, back up the TivoliIdentity Manager database, and ensure that the database server is running.v DB2 Database
 For information about upgrading DB2 Database, refer to this Web site:http://publib.boulder.ibm.com/infocenter/db2luw/v9/index.jsp
 Note: Upon upgrade of DB2 Database, the port number might change. Verifythat the port number you are using. For more information, see“Determining the correct service listening port and service name” onpage 17.
 v OracleFor information about upgrading Oracle, refer to this Web site:http://www.oracle-base.com/articles/11g/UpgradingTo11g.php
 v SQL Server 2005For information about upgrading SQL Server 2005, refer to this Web site:http://www.microsoft.com/sql/solutions/upgrade/default.mspxFor information about configuring SQL Server 2005, see “Configuring SQLServer 2005” on page 24.
 5. Migrate the directory server to the supported version. Then, back up the TivoliIdentity Manager schema and data, and ensure that the directory server isrunning. For Tivoli Identity Manager Version 4.6 or 5.0 recovery purposes,export the Tivoli Identity Manager LDAP directory to an LDIF file. If you arerunning the IBM Tivoli Directory Server, configure the IBM Tivoli DirectoryServer referential integrity plug-in. For more information, see “Manuallyconfiguring the referential integrity plug-in on the IBM Tivoli Directory Server”on page 32.
 Note: Migration is not necessary if you are using IBM Tivoli Directory ServerVersion 6.1 or 6.2 or Sun Enterprise Directory Server 6.3, which aresupported directory servers.
 6. Complete these steps for the WebSphere Application Server installation andconfiguration:v Single-server: Install any necessary fix packs. If you are upgrading from
 Tivoli Identity Manager 4.6, install WebSphere Application Server 6.1 andany necessary fix packs for a stand-alone node.
 v Cluster: Install any necessary fix packs. If you are upgrading from TivoliIdentity Manager 4.6, install WebSphere Application Server 6.1 and anynecessary fix packs on the deployment manager node and each clustermember node, then federate the nodes to the cell and create clusters for theTivoli Identity Manager application and the messaging engine.
 7. On a single-server configuration, and on each cluster member in a clusterconfiguration, complete these steps:a. Back up the itim directory.b. If you are upgrading from Tivoli Identity Manager 4.6, access the
 OLD_WAS_HOME\installedApps\cellname\enRole.ear directory and storeany customized files in a temporary holding area.
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c. If you are upgrading from Tivoli Identity Manager 5.0, access theWAS_HOME\installedApps\cellname\ITIM.ear directory and store anycustomized files in a temporary holding area.
 8. Ensure that the appropriate servers are running in the WebSphere environment.Complete this step:v Single-server configuration:
 Start WebSphere Application Server 6.1 with the latest fix packs that youinstalled (refer to the Tivoli Identity Manager Information Center for the mostcurrent fix pack and possible APARs).
 v Cluster configuration:Using the WebSphere administrative console for 6.1, ensure that thedeployment manager and all the nodes are federated and the node agents arerunning and that the latest fix packs have been installed (refer to the TivoliIdentity Manager Information Center for the most current fix pack and possibleAPARs).
 9. If you are upgrading from Tivoli Identity Manager 4.6, stop and remove theTivoli Identity Manager application enRole using the WebSphere administrativeconsole for 5.1.
 Upgrading from Tivoli Identity Manager Version 4.6 or 5.0 to Version5.1
 These tasks can be use to upgrade a single-server configuration or a clusterconfiguration.
 Upgrading a single-server configurationThe upgrade process performs these tasks in a single-server configuration:1. Backs up files in the ITIM_HOME\data directory.2. Replaces the files in the ITIM_HOME directory.3. Checks the WebSphere Application Server Version status and tries to start the
 WebSphere Application Server if it is not running. Refer to the Tivoli IdentityManager Information Center for the most current fix pack and possible APARs.
 4. Starts the system configuration tool (runConfig) to prompt the user toexamine current system configuration values.
 5. Updates several Tivoli Identity Manager properties files. For moreinformation, see “Processes and settings that the upgrade process preserves”on page 104.
 6. Configures WebSphere Application Server for Tivoli Identity Manager Version5.1.
 7. Upgrades the Tivoli Identity Manager database schema and data.8. Upgrades the Tivoli Identity Manager directory server schema and data.9. Deploys the Tivoli Identity Manager application (ITIM.ear) to WebSphere
 Application Server.10. Stops and starts WebSphere Application Server as well as Tivoli Identity
 Manager application.
 To upgrade a single-server configuration, complete these steps:1. To run the installation program, complete these steps:v Windows:
 a. Click Start > Run.
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b. Enter the drive and path where the installation program is located andthen enter the following command:instwin.exe
 The Welcome window opens.v UNIX/Linux:
 a. Open a command shell prompt window, and navigate to the directorywhere the installation program is located.
 b. Enter the following command for the Tivoli Identity Managerinstallation program:– AIX:
 instaix.bin
 – Linux:instlinux.bin
 – pLinux:instplinux.bin
 – zLinux:instzlinux.bin
 – Solaris:instsol.bin
 The installation program starts and displays the Welcome window.If you are running the installation program on a UNIX/Linux system thatdoes not have at least 150MB of free space in the /tmp directory, youshould set the IATEMPDIR environment variable to a directory on a diskpartition with enough free disk space. To set the variable, enter one of thefollowing commands at the command line prompt before running theinstallation program again:– Bourne shell (sh), ksh, bash, and zsh:
 $ IATEMPDIR=temp_dir$ export IATEMPDIR
 – C shell (csh) and tcsh:$ setenv IATEMPDIR temp_dir
 where temp_dir is the path to the directory, for example/your/free/directory, where free disk space is available.
 2. Select the appropriate language and click OK.3. Click Next to advance past the copyright and legal text.4. In the License Agreement window, read the license agreement and decide
 whether to accept its terms. If you do, select Accept and click Next.5. In the Choose Install Directory window, you must select the existing Tivoli
 Identity Manager home directory that you want to upgrade. Accept theexisting directory, or click Choose and select the correct directory. Then, clickNext.
 6. In the Upgrade IBM Tivoli Identity Manager window, click Continue to Nextto start the upgrade.
 7. Read the caution windows to ensure that the prerequisite applications meetthe requirements that Tivoli Identity Manager supports. Then, click Next.
 8. In the WebSphere Application Server installation directory window, specifythe location of WebSphere Application Server 6.1. There can be multipleinstances of the WebSphere Application Server on the computer. Click Next.
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9. In the next window, choose the WebSphere Application Server base profilewhere the Tivoli Identity Manager application is to be deployed. Click Next.
 10. If WebSphere Application Server administrative security is on, a WebSphereApplication Server user ID and password window is presented. Enter the userID and password and click Next.
 11. In the Java home window, note the directory to which Tivoli Identity ManagerVersion 5.1 now points. You might need to manually migrate any files thatreference the previous directory to reference the current directory. Click OK.
 12. If you use Oracle database or Microsoft SQL Server, a Where is the JDBCDriver? Window is presented. Specify the JDBC driver location and name.Click Next. For more information, see “Installing the Oracle JDBC driver” onpage 21 and “Installing the SQL Server JDBC driver” on page 25.
 13. In the Tivoli Common Directory window, accept the default directory for theTivoli Common Directory or specify a different directory. The Tivoli IdentityManager installation program creates the CTGIM subdirectory to storeserviceability-related files for Tivoli Identity Manager. Ensure that thedirectory has at least 25 MB of free space. Click Next.
 14. In the Pre-install Summary window, click Install.15. The installation program launches the system configuration tool runConfig to
 enable you to change configuration settings, if necessary. In the SystemConfiguration Tool window, examine the values of all parameters, which arepreserved from the previous version of Tivoli Identity Manager.On the Database tab, verify that the JDBC URL has the correct format of type4 JDBC driver URL, and click Test to test the database connection.Change the EJB user ID and password on the Security tab if the user ID andpassword are different from the WebSphere Application Server administrativeuser ID and password.Verify the values and click OK. The system configuration requires severalminutes to complete.For more information about runConfig, see “Configuring commonly usedsystem properties” on page 75.
 16. The installer invokes the database upgrade program to upgrade the databaseschema and data. If you are upgrading from Tivoli Identity Manager 4.6 withWebSphere Application Server 5.1, you need to provide the databaseadministrative user ID and password to create the database schema for themessaging engine. If the administrative user ID does not have the properprivileges to create the database schema, an error message is displayed duringthe upgrade. Run the ITIM_HOME\bin\DBUpgrade program after theupgrade completes and enter the correct database administrative ID. Thisprogram ensures that the database schema and tables for the messagingengine are created.
 17. The installer invokes the LDAP upgrade program to upgrade the LDAPschema and data silently.
 Note: For Sun Enterprise Directory Server 6.3, if the upgrade adds newindexes, you must index your data again after the upgrade to TivoliIdentity Manager Version 5.1 has completed.
 18. After the installation has completed, you might have to manually update anycustomizations which were not preserved during the upgrade process. Formore information, see “Preserving customized data manually” on page 114.
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Upgrading a cluster configurationThe upgrade process performs these tasks in a cluster configuration:1. Backs up files in the ITIM_HOME\data directory.2. Replaces the files in the ITIM_HOME directory.3. On the computer that has the deployment manager, does these tasks:
 a. Deploys the Tivoli Identity Manager application to WebSphere ApplicationServer.
 b. Starts the system configuration tool (runConfig), which prompts the user toexamine current system configuration values, updates several Tivoli IdentityManager properties files, and configures WebSphere Application Server forTivoli Identity Manager. For more information, see “Processes and settingsthat the upgrade process preserves” on page 104.
 c. Upgrades the Tivoli Identity Manager database schema and data.d. Upgrades the Tivoli Identity Manager directory server schema and data.
 4. On each computer that has a Tivoli Identity Manager cluster member, starts thesystem configuration tool (runConfig), which prompts the user to examinecurrent system configuration values, updates several Tivoli Identity Managerproperties files, and configures WebSphere Application Server for TivoliIdentity Manager. For more information, see “Processes and settings that theupgrade process preserves” on page 104.
 To upgrade a cluster configuration on the deployment manager, and on eachcluster member computer, complete these steps:1. To run the installation program, complete these steps:v Windows:
 a. Click Start > Run.b. Enter the drive and path where the installation program is located and
 then enter the following command:instwin.exe
 The Welcome window opens.v UNIX/Linux:
 a. Open a command shell prompt window, and navigate to the directorywhere the installation program is located.
 b. Enter the following command for the Tivoli Identity Managerinstallation program:– AIX:
 instaix.bin
 – Linux:instlinux.bin
 – pLinux:instplinux.bin
 – zLinux:instzlinux.bin
 – Solaris:instsol.bin
 The installation program starts and displays the Welcome window.If you are running the installation program on a UNIX/Linux system thatdoes not have at least 150MB of free space in the /tmp directory, youshould set the IATEMPDIR environment variable to a directory on a disk
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partition with enough free disk space. To set the variable, enter one of thefollowing commands at the command line prompt before running theinstallation program again:– Bourne shell (sh), ksh, bash, and zsh:
 $ IATEMPDIR=temp_dir$ export IATEMPDIR
 – C shell (csh) and tcsh:$ setenv IATEMPDIR temp_dir
 where temp_dir is the path to the directory, for example/your/free/directory, where free disk space is available.
 2. Select the appropriate language and click OK.3. Click Next to advance past the copyright and legal text.4. In the License Agreement window, read the license agreement and decide
 whether to accept its terms. If you do, select Accept and click Next.5. In the Choose Install Directory window, you must select the existing Tivoli
 Identity Manager home directory that you want to upgrade. Accept theexisting directory, or click Choose. and select the correct directory. Then, clickNext.
 6. In the Upgrade IBM Tivoli Identity Manager? window, click Continue to Nextto start the upgrade.
 7. Read the caution windows to ensure that the prerequisite applications meetTivoli Identity Manager requirements. Then, click Next.
 8. If the Tivoli Identity Manager cluster member is installed on the computer,specify the WebSphere Application Server installation directory, click Next.Then select the WebSphere Application Server profile name and click Next.
 9. If the deployment manager is installed on the computer, specify thedeployment manager installation directory, click Next. Then select theWebSphere Deployment Manager profile name and click Next.
 10. If WebSphere Application Server administrative security is on, a WebSphereApplication Server user ID and password window is presented. Enter the userID and password and click Next.
 11. In the Java home window, notice the directory to which Tivoli IdentityManager Version 5.1 now points. You might need to manually migrate anyfiles that reference the previous directory to reference the current directory.Click OK.
 12. If you use Oracle database or Microsoft SQL Server, a Where is the JDBCDriver? Window is presented. Specify the JDBC driver location and name.Click Next. For more information, see “Installing the Oracle JDBC driver” onpage 21 and “Installing the SQL Server JDBC driver” on page 25.
 13. In the Tivoli Common Directory window, accept the default directory for theTivoli Common Directory or specify a different directory. The Tivoli IdentityManager installation program creates the CTGIM subdirectory to storeserviceability-related files for Tivoli Identity Manager. Ensure that thedirectory has at least 25 MB of free space.
 14. In the Pre-install Summary window, read the summary. Then, click Install.15. The installation program launches the system configuration tool runConfig to
 enable you to change configuration settings, if necessary. In the SystemConfiguration Tool window, examine the values of all parameters, which arepreserved from the previous version of Tivoli Identity Manager.On the Database tab, verify that the JDBC URL has the correct format of type4 JDBC driver URL, and click Test to test the database connection.
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Change the EJB user ID and password on the Security tab if the user ID andpassword are different from the WebSphere Application Server administrativeuser ID and password.Verify the values and click OK. The system configuration requires severalminutes to complete.For more information about runConfig, see “Configuring commonly usedsystem properties” on page 75.
 16. On the deployment manager, the installer invokes the database upgradeprogram to upgrade the database schema and data. If you are upgrading fromTivoli Identity Manager 4.6 with WebSphere Application Server 5.1, you needto provide the database administrative user ID and password to create thedatabase schema for the messaging engine. If the administrative user ID doesnot have the proper privileges to create the database schema, an errormessage is displayed during the upgrade. Run the ITIM_HOME\bin\DBUpgrade program after the upgrade completes and enter the correctdatabase administrative ID. This program ensures that the database schemaand tables for the messaging engine are created.
 17. On the deployment manager, the installer invokes the LDAP upgrade programto upgrade the LDAP schema and data silently.
 Note: For Sun Enterprise Directory Server 6.3, if the upgrade adds newindexes, you must index your data again after the upgrade to TivoliIdentity Manager Version 5.1 has completed.
 18. After the installation has completed, you might have to manually update anycustomizations which were not preserved during the upgrade process. Formore information, see “Preserving customized data manually” on page 114.
 Determining that the WebSphere MQ message queue is emptyTo determine if the number of messages in the workflow queues is zero andtherefore empty, run the WAS_MQ_HOME\bin\runmqsc.exe utility and use thedisplay command to show the status of the following queues:v WQ_itim_ms, the mail services queuev WQ_itim_rs, the remote services queuev WQ_itim_wf, the workflow queuev WQ_itim_adhocSync, the custom report services queuev WQ_itim_rs_pending, the remove services pending queuev WQ_itim_ps, the remote services queuev WQ_itim_policy, the policy queuev WQ_itim_policy_simulation, the policy simulation queuev WQ_itim_import_export, the import/export queue
 For example, in a single-server environment, assume that WebSphere MQ isdeployed on the node named ″A″ and the server is named ″server1″. Enter thiscommand:runmqsc WAS_A_server1
 In a clustered environment, enter this command:runmqsc WAS_A_jmsserver
 The following command displays the status of the Tivoli Identity Managerworkflow queue:
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display qlocal('WQ_itim_ms') curdepth maxdepth
 Ensure that all message queues are empty. In the resulting display, the CURDEPTHattribute shows the number of messages in the queue. For example:AMQ8409: Display Queue details.
 QUEUE(WQ_itim_ms) MAXDEPTH(640000)CURDEPTH(0)
 If all queue depths (“CURDEPTH”) are zero, then no messages need processing,continue with the Tivoli Identity Manager upgrade. Do not restart WebSphereApplication Server 5.1. If you have current queue depths greater than zero,messages are still being processed. Wait and check the queue depths again.
 To return to the pre-upgrade steps, see “Before you begin” on page 106.
 Preserving customized data manuallyTo preserve customized data that is not preserved by the upgrade process,complete these manual steps if applicable.
 For more information about processes that are not preserved, see “Processes andsettings that are not preserved, or require manual upgrade” on page 105.
 Manually applying Java securityManually apply the changes that you made for the previous IBM Development Kitfor Java to the new IBM Development Kit for Java. For more information aboutenabling Java security, see “Enabling Java 2 security by creating and modifyingpolicy files” on page 132.
 Customizing logos and style sheetsIf you need to insert customized logos and style sheets in the WAS_HOME\cellname\ITIM.ear directory, restore these files from a backup location.
 Preserving WebSphere Application Server customizationsYou can preserve WebSphere customizations, such as specific JAR files usingsettings for a WebSphere Application Server shared library. For a shared library,you need to define the name of the shared library to the newly deployed TivoliIdentity Manager Version 5.1. For example, Tivoli Identity Manager Version 4.6 or5.0 might load a shared library with a name such as user_shared_library.
 Complete these tasks on the WebSphere administrative console to associate thepreviously defined shared library with Tivoli Identity Manager Version 5.1:1. Click Applications > Enterprise Applications > ITIM.2. Click Shared library references.3. Select the shared library, and click OK and Apply to apply the changes.4. Save the configuration.5. Restart the WebSphere Application Server to allow the changes to take effect.
 You might need to preserve other WebSphere customizations.
 Migrating notification templatesIf you are upgrading from Tivoli Identity Manager 4.6, the upgrade program doesnot overwrite (upgrade) any notification templates if you have updated the default
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notification templates from Tivoli Identity Manager Versions 4.6. To migrate oldnotification templates to Tivoli Identity Manager Version 5.1, you must update boththe XML Text Template Language (XTTL) contents and the style.
 The following table provides a list of templates contained in tenant.tmpl.
 Table 6. Templates contained in tenant.tmpl
 Template name Template DN
 Todo Item Reminder Notification cn=Reminder,erglobalid=<%config.workflow%>,ou=config,ou=itim, <%tenant.dn%>
 Default Compliance AlertNotification
 cn=Compliance,erglobalid=<%config.workflow%>,ou=config,ou=itim, <%tenant.dn%>
 Default New Account Notification cn=NewAccount,erglobalid=<%config.workflow%>,ou=config,ou=itim, <%tenant.dn%>
 Default New Password AccountNotification
 cn=NewPassword,erglobalid=<%config.workflow%>,ou=config,ou=itim,<%tenant.dn%>
 Default Change AccountNotification
 cn=ChangeAccount,erglobalid=<%config.workflow%>,ou=config,ou=itim,<%tenant.dn%>
 Default Restore AccountNotification
 cn=RestoreAccount,erglobalid=<%config.workflow%>,ou=config,ou=itim,<%tenant.dn%>
 Default Suspended AccountNotification
 cn=SuspendedAccount,erglobalid=<%config.workflow%>, ou=config,ou=itim,<%tenant.dn%>
 Default Deprovision AccountNotification
 cn=Deprovision,erglobalid=<%config.workflow%>,ou=config,ou=itim, <%tenant.dn%>
 Default Activity TimeoutNotification
 cn=ActivityTimeout,erglobalid=<%config.workflow%>,ou=config,ou=itim,<%tenant.dn%>
 Default Process TimeoutNotification
 cn=ProcessTimeout,erglobalid=<%config.workflow%>,ou=config,ou=itim,<%tenant.dn%>
 Default Process CompletionNotification
 cn=ProcessCompletion,erglobalid=<%config.workflow%>, ou=config,ou=itim,<%tenant.dn%>
 Default ManualActivityNotification
 cn=ManualActivityApproval,erglobalid=<%config.workflow%>,ou=config,ou=itim,<%tenant.dn%>
 Default ManualActivityRFINotification
 cn=ManualActivityRFI,erglobalid=<%config.workflow%>, ou=config,ou=itim,<%tenant.dn%>
 Default ManualActivityWorkOrderNotification
 cn=ManualActivityWorkOrder,erglobalid=<%config.workflow%>, ou=config,ou=itim,<%tenant.dn%>
 Updating XML Text Template Language (XTTL) contentsThe new XTTL contents needed for the default workflow notification templates inTivoli Identity Manager Version 5.1 include:v Todo Item Reminder Notification
 No changes required.v Default Compliance Alert Notification
 Add:<ITIMURL/>
 v Default New Account Notification
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Add:<ITIMURL/>
 <JS>if (EmailContext.hasNewAccess()) {'<RE key="accountNewAccess"/>:<JS>EmailContext.getAccountNewAccessAsString();</JS>\n';
 }</JS>
 v Default New Password Account NotificationAdd:<ITIMURL/>
 v Default Change Account NotificationAdd:<ITIMURL/>
 <JS>if (EmailContext.hasNewAccess()) {'<RE key="accountNewAccess"/>:<JS>EmailContext.getAccountNewAccessAsString();</JS>\n';
 }</JS>
 v Default Restore Account NotificationAdd:<ITIMURL/>
 v Default Suspended Account NotificationAdd:<ITIMURL/>
 v Default Deprovision Account NotificationAdd:<ITIMURL/>
 <JS>if (EmailContext.hasRemovedAccess()) {'<RE key="accountRemovedAccess"/>:<JS>EmailContext.getAccountRemovedAccessAsString();</JS>\n';
 }</JS>
 v Default Activity Timeout Notification– Add:
 <ITIMURL/>
 <JS>if (EmailContext.hasRemovedAccess()) {'<RE key="accountRemovedAccess"/>:<JS>EmailContext.getAccountRemovedAccessAsString();</JS>\n';
 }</JS>
 – Remove the following:<RE key="description"/>:<RE><KEY><JS>activity.description;</JS></KEY></RE>
 – Modify the following:<RE key="state"/>: <RE><KEY><JS>process.STATE_PREFIX+activity.state;</JS></KEY></RE>
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<RE key="detail"/>:<JS>Enrole.localize(process.resultDetail, "$LOCALE");</JS>
 v Default Process Timeout Notification– Add:
 <ITIMURL/>
 – Modify the following:<RE key="detail"/>:<JS>Enrole.localize(process.resultDetail, "$LOCALE");</JS>
 v Default Process Completion Notification– Add:
 <ITIMURL/>
 – Modify the following:<RE key="detail"/>:<JS>Enrole.localize(process.resultDetail, "$LOCALE");</JS>
 v Default ManualActivityApproval Notification– Add:
 <ITIMURL/>
 <JS>if (process.subjectAccess!=null) if(process.subjectAccess.length>0) {
 '<RE key="accessName"/>:<JS>process.subjectAccess;</JS>\n';}</JS>
 – Modify the following:<JS>if (process.parentId == '0') { 'leftvalign="middle"><td class="text-description" bgcolor="EBEDF3"><REkey="requestedBy"/>:</td><td width="773" class="text-description"bgcolor="white"><JS>process.requestorName;</JS></td></tr>';}</JS>
 v Default ManualActivityRFI NotificationAdd:<ITIMURL/>
 <JS>if (process.subjectAccess!=null) if(process.subjectAccess.length>0) {
 '<RE key="accessName"/>:<JS>process.subjectAccess;</JS>\n';}</JS>
 v Default ManualActivityWorkOrder NotificationNo changes required.
 In addition, all recertification templates are modified and the following six newtemplates are added:v Decline Mark notificationv Decline Marked notificationv Decline Deletes Access notificationv Decline Deleted Access notificationv Decline Marks Access notificationv Decline Marked Access notification
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To modify the contents of default workflow notification templates, log in to theTivoli Identity Manager Version 5.1 GUI administrative console with administrativepermission and complete these steps:1. Go to Configure System > Workflow Notification Properties
 2. Select the template to modify.3. On the Notification Template page, modify the appropriate section of the
 notification template.
 Updating notification template styleThe style of e-mail notifications (XHTML templates) in Tivoli Identity ManagerVersion 5.1 has changed.
 To design an XHTML template use the following cascading style sheet (CSS) fileand images:v Imperative style sheet
 BASE_URL/console/css/imperative.cssv Images
 – Tivoli logoBASE_URL/console/html/images/left-tiv-1.gif
 – IBM bannerBASE_URL/console/html/images/ibm_banner.gif
 – Background imageBASE_URL/console/html/images/mid-part-1.gif
 – Template bodyBASE_URL/console/html/images/portfolio_background.gif
 Note: The value of BASE_URL is http://servername:port/itim
 The following colors are used to format the background:v Title bar: #a8a8a8v Tables containing values: gray and EBEDF3
 v Copy Right Table: #a8a8a8
 To apply a style sheet, link the style sheet in the following way:<link type="text/css" title="Styles" rel="stylesheet"href="BASE_URL/console/css/imperative.css" />
 Note: The value of BASE_URL is http://servername:port/itimThe text-description class of the above CSS is used to format the text in the e-mailnotification. For example, to format the title, use the following code:<!-- Title Bar --><table width="100%" border="0" cellpadding="0" cellspacing="0"><tbody><tr bgcolor="#a8a8a8"><td height="20" width="8"></td><!-- ITIM Notification Label -->
 <td height="20" class="text-description" width="979"valign="middle">$TITLE</td><td height="20" width="5"></td>
 </tr></tbody></table>
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To modify the contents of default workflow notification templates, log in to theTivoli Identity Manager Version 5.1 GUI administrative console with administrativepermission and complete these steps:1. Go to Configure System > Workflow Notification Properties
 2. Select the template to modify.3. On the Notification Template page, modify the appropriate section of the
 notification template.
 Manually upgrading the access control itemsThe upgrade process does not affect the access control items for the existingorganizations. The process does not add the new default access control items. Nordoes it modify or delete the existing access control items. However, it does add thenew default user groups, if they do not exist. New organizations created after theupgrade have all the default access control items and user groups.
 Tivoli Identity Manager introduced the customizable persona-based console formanaging the organizations in version 5.0. For an upgraded Tivoli IdentityManager version 5.1 to use the new features, you must manually create the accesscontrol items for the targeted persona. For example, for an auditor to run all theready-to-use reports and view all the reporting data, you need to have all theaccess control items for the Auditor principal listed in the Tivoli Identity ManagerVersion 5.1 Information Center topic "Default access control items"(Administering>Security administration).
 For more details on how to create an access control item, refer to the Tivoli IdentityManager Version 5.1 Information Center topic "Access control item management"(Administering>Security administration).
 Note: For a new installation of Tivoli Identity Manager Version 5.1, with thedefault set of user groups, access control items, and views, thepersona-based console provides sets of tasks, for the default administrativeuser types.
 Configuring CrystalNote to Reviewers:According to Henry Crystal upgrades successfully with WAS 6.1without manual steps.Can we remove this section?
 Perform these steps to configure Crystal following an upgrade to Tivoli IdentityManager Version 5.1:v WebSphere Application Server single-server:
 1. Ensure that correct values are present in the ITIM_HOME\data\crystal.properties file.
 2. Edit and run the following script:– Windows: importCrystalJars_WAS.bat– UNIX/Linux: importCrystalJars_WAS.sh
 3. Edit and run the following script:– Windows: CrystalTestWAS.bat– UNIX/Linux: CrystalTestWAS.sh
 4. Edit and run the following script:
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– Windows: buildCrystalWebArchive_WAS.bat– UNIX/Linux: buildCrystalWebArchive_WAS.sh
 5. Edit and run the following script:– Windows: CrystalUpgradeWAS.bat– UNIX/Linux: CrystalUpgradeWAS.sh
 v WebSphere Application Server cluster configuration:– On the federated nodes, perform these steps:
 1. Ensure that correct values are present in the ITIM_HOME\data\crystal.properties file.
 2. Edit and run the following script:- Windows: importCrystalJars_WAS.bat- UNIX/Linux: importCrystalJars_WAS.sh
 – On the network deployment manager, perform these steps:1. Ensure that correct values are present in the ITIM_HOME\data\
 crystal.properties file.2. Edit and run the following script:
 - Windows: importCrystalJars_WAS.bat- UNIX/Linux: importCrystalJars_WAS.sh
 3. Edit and run the following script:- Windows: CrystalTestWAS.bat- UNIX/Linux: CrystalTestWAS.sh
 4. Edit and run the following script:- Windows: buildCrystalWebArchive_WAS.bat- UNIX/Linux: buildCrystalWebArchive_WAS.sh
 5. Edit and run the following script:- Windows: CrystalUpgradeWAS.bat- UNIX/Linux: CrystalUpgradeWAS.sh
 For more information about Crystal configuration, refer to the Tivoli IdentityManager Information Center.
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Chapter 11. Uninstalling Tivoli Identity Manager
 Uninstalling Tivoli Identity Manager consists of using the Tivoli Identity Manageruninstallation program, which performs the following tasks:v Removes all files in the ITIM_HOME directory that the Tivoli Identity Manager
 installation program created, including certificates in the ITIM_HOME\certdirectory and the itimKeystore.jceks keystore file in the ITIM_HOME\config\keystore directory.
 v Clears all configuration settings that were created for the Tivoli IdentityManager Server on the WebSphere Application Server.
 v Removes the Tivoli Identity Manager Server that was deployed on thesecomputers:– Single-server configuration: Computer that has the WebSphere Application
 Server.– Cluster configuration: Computer that has the deployment manager.
 In a cluster configuration, uninstalling the Tivoli Identity Manager Serverfrom the deployment manager removes the availability of the Tivoli IdentityManager Server to the cluster. The deployed Tivoli Identity Managerapplication files are automatically removed from Tivoli Identity Managercluster members.
 Reboot the Windows operating system after uninstallation to clean up any residualTivoli Identity Manager files which were not able to be removed during theuninstallation process.
 What is not removedUninstalling the Tivoli Identity Manager Server does not modify existing databasetables or the directory server schema and data. The Tivoli Identity Manager logfiles are not removed.
 For more information about manually removing the database tables, directoryserver schema, and log files, see “Manually removing components” on page 122.
 Before you beginBefore you uninstall the Tivoli Identity Manager Server, complete these tasks:v Single-server configuration
 – Back up any certificates in the ITIM_HOME\cert directory and theitimKeystore.jceks keystore file in the ITIM_HOME\config\keystore directory.
 – Ensure that the WebSphere Application Server is running.v Cluster configuration
 – Back up any certificates in the ITIM_HOME\cert directory and theitimKeystore.jceks keystore file in the ITIM_HOME\config\keystore directory.
 – If you are uninstalling the Tivoli Identity Manager Server from a clusterconfiguration, ensure that the node agents are running and that thedeployment manager is also running.
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Steps to uninstall Tivoli Identity ManagerYou can uninstall Tivoli Identity Manager from UNIX, Linux or Windowsoperating systems by using the Tivoli Identity Manager uninstallation programdirectly, or from Windows operating systems by using Add/Remove Programsfrom the Windows Control Panel. If you are planning to reinstall Tivoli IdentityManager, use the Tivoli Identity Manager uninstallation program directly.
 To uninstall Tivoli Identity Manager, complete these steps:1. Uninstall the Tivoli Identity Manager Server using this command:
 ITIM_HOME\itimUninstallerData\Uninstall_ITIM
 v Single-server configurationRun the command on computer on which the Tivoli Identity Manager Serveris installed.
 v Cluster configurationRun the command on each cluster member first, and then run the commandon the computer on which the deployment manager is installed.
 2. Complete the uninstallation wizard panels and confirm that you want touninstall the Tivoli Identity Manager Server.
 3. Reboot the Windows system after uninstallation to clean up any residual TivoliIdentity Manager files that were not able to be removed during uninstallation.
 Verifying that the Tivoli Identity Manager Server is uninstalledTo verify that the Tivoli Identity Manager Server has been uninstalled andremoved as an application from the WebSphere Application Server, complete thesesteps:1. Examine the ITIM_HOME directory and remove any residual Tivoli Identity
 Manager directories, configuration files, and log files.2. Launch the WebSphere administrative console and log in.3. From the navigation tree, navigate to the target node, and click the
 Applications > Enterprise Applications link.A list is displayed of the enterprise applications that are installed on theapplication server.If you see an application named ITIM listed, the uninstallation process wasunable to automatically remove the Tivoli Identity Manager Server from theWebSphere Application Server. You can remove the application manually. Formore information, see “Manually removing the Tivoli Identity Manager Serverfrom the WebSphere Application Server.”
 Manually removing componentsThis section describes manually removing or stopping components that are notremoved by the uninstallation process.
 Manually removing the Tivoli Identity Manager Server from theWebSphere Application Server
 To uninstall the Tivoli Identity Manager Server in a single-server or a clusterconfiguration, complete these tasks:1. On the WebSphere administrative console, take these steps:
 a. Select Applications > Enterprise Applications
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b. Select the ITIM application.c. Click Stop.d. When the ITIM application stops, select the ITIM application again.e. Click Uninstall.
 2. Manually ensure that the ITIM.ear directory is removed. Take these steps:a. Open the applications directory:v Single-server and each cluster member
 WAS_PROFILE_HOME\config\cells\cellname\applicationsv Deployment manager
 WAS_NDM_PROFILE_HOME\config\cells\cellname\applicationsb. If the ITIM.ear directory exists, remove the directory.
 Stopping and removing the Tivoli Identity Manager messagingengine
 To stop and remove the Tivoli Identity Manager Server messaging engine in asingle-server or a cluster configuration, complete these tasks on the WebSphereadministrative console:1. Select Service Integration > Buses.2. Click itim_bus.3. In the Topology section, click on Messaging engines.
 For a single-server installation, you see an engine named nodename.servername-itim_bus.For a cluster installation, you see n+1 messaging engines, where n is thenumber of Tivoli Identity Manager cluster members. An additional messagingengine is used for the Tivoli Identity Manager messaging cluster.
 4. Select one or more messaging engines and click Stop.5. Remove the itim_bus configuration from the WebSphere administrative console.6. In the Tivoli Identity Manager database, drop the tables and schema used by
 the messaging engines. Refer to the documentation for your database systemfor the appropriate commands. The file ITIM_HOME/config/rdbms/dbtype/drop_itim_sib.ddl provides an example.
 Manually removing other files or directoriesTo clean up any residual Tivoli Identity Manager files that were not removedduring uninstallation.1. Restart the operating system after uninstallation.2. Examine the ITIM_HOME directory and remove any residual Tivoli Identity
 Manager directories, configuration files, log, .dll, .so, .a, and .jar files.3. Restart the operating system.
 Reinstalling Tivoli Identity ManagerClean up the database and the LDAP server before running the Tivoli IdentityManager installation program again, for a cleaner installation. Ensure that theTivoli Identity Manager messaging engine is not running and reboot the Windowscomputer after uninstallation and before attempting to reinstall.
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Ensuring that Tivoli Identity Manager objects are removedfrom the Sun Enterprise Directory Server
 Before you reinstall Tivoli Identity Manager, ensure that any previous TivoliIdentity Manager schema objects, object classes, and other attributes are removedfrom the Sun Enterprise Directory Server. Complete these steps:1. Start the Sun Enterprise Directory Server administration console.2. On the Configuration tab, remove the Tivoli Identity Manager suffix.3. On the Directory tab, complete these steps:
 a. Remove the Tivoli Identity Manager domain.b. Click Config > Plugins. Then, open the properties for the referential
 integrity postoperation entry and delete all attributes that begin with thecharacters er.
 4. Stop the directory server.5. Open the ldapServerInstance\config\schema\99user.ldif file. Then, remove all
 Tivoli Identity Manager object classes and attribute types that begin with thecharacters er.
 6. Start the directory server.
 124 IBM Tivoli Identity Manager Server: Installation and Configuration Guide

Page 141
                        

Appendix A. Mapping Tivoli Identity Manager applicationmodules to IBM HTTP Server
 Use the WebSphere administrative console to map Tivoli Identity Managerapplications to the IBM HTTP Web server.1. Log in to the WebSphere administrative console on the WebSphere Application
 Server Network Deployment Manager for the Tivoli Identity Manager clusterusing the WebSphere Application Server administrator credentials.
 2. Click Applications > Application Types > WebSphere enterprise applicationsin the task menu.
 3. Click ITIM in the Enterprise Applications list.4. Click Manage Modules.5. Select the ITIM Application Cluster name (not the JMS cluster name) and select
 the check boxes for these modules:v PasswordSynchv ITIM_Consolev EnRolev ITIM_Self_Servicev ITIM_Self_Service_Helpv ITIM_Console_Helpv ITIM_Message_Helpv EHS3.01v PasswordReset
 6. Click Apply (next to the Clusters and servers field).7. Click OK.8. Click Save configuration in the message box.
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Appendix B. Configuring security for Tivoli Identity Manager
 This section describes how to configure security for Tivoli Identity Manager andmiddleware components. For more security information, see the AdditionalSecurity section of the IBM Tivoli Identity Manager Information Center.
 Configuring security for the directory serverTo have secure socket layer (SSL) communication between an LDAP server andTivoli Identity Manager, the LDAP server must be configured to use SSL for securecommunications. If you are using IBM Tivoli Directory Server or Sun EnterpriseDirectory Server to store Tivoli Identity Manager information, you must set theserver to use SSL, and then configure the SSL certificates that you want to use.
 This task is performed after installing Tivoli Identity Manager, and cannot beperformed before a new installation. If you want to configure LDAP only throughan SSL connection, skip the LDAP configuration during the installation, and runldapConfig after the installation has completed.
 Configuring SSL for IBM Tivoli Directory ServerTo have secure socket layer (SSL) communication between the IBM Tivoli DirectoryServer and Tivoli Identity Manager, IBM Tivoli Directory Server must beconfigured to listen on a port with a certificate defined. The certificate authoritymust be in the signer certificate database on the SSL client.
 Use GSKit to create the key database file and certificates. Make sure to extract theserver certificate (the one created for the LDAP server) for client use. Thecertificate must be copied to the machine where Tivoli Identity Manager isrunning. The location of the server certificate is required to set up a trustedcertificate for Tivoli Identity Manager in a later task.
 For more information about enabling SSL on LDAP for IBM Tivoli DirectoryServer, see the documentation available at the following Web site:
 http://publib.boulder.ibm.com/infocenter/tivihelp/v2r1/topic/com.ibm.IBMDS.doc/admin_gd16.htm
 Configuring SSL for Sun Enterprise Directory ServerFor detailed information about setting up SSL on Sun Enterprise Directory Server,see the documentation available at the following Web site:
 http://docs.sun.com/app/docs/prod/s1dirsrv
 Configuring the SSL client to trust the LDAP server certificateThe Tivoli Identity Manager Server operates as a Java application (not as anembedded part of WebSphere Application Server) and uses Java secure socketextension (JSSE) to implement SSL support. Consequently, SSL certificates and CAcertificates are retrieved from a standard format Java truststore or keystore. Thetruststore and keystore use the same file formats that the Java virtual machine andWebSphere Application Server use for other certificate configuration. You can use
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standard Java tools to maintain the trust and keystores, including the IBM KeyManagement tool and the Java keytool command-line utility.
 To successfully configure the SSL connection between the Tivoli Identity ManagerServer and the LDAP Server, you must import the self-signed certificate (or CAcertificate) created for the LDAP Server into the truststore that is used by JSSE (theIBM JSSE, which is part of WebSphere Application Server). Additionally, you mustfirst configure Tivoli Identity Manager to use SSL (configuring it to use the ldapsprotocol instead of the ldap protocol) when communicating with the LDAP Server.
 Installing the self-signed certificate in the JSSE truststoreFor this task, the default truststore that is present in the JRE of the WebSphereApplication Server is used. Also, the iKeyman utility is used to configure thecertificates. To install the self-signed certificate for the LDAP Server in the JSEEtruststore, complete these steps:1. Start the ikeyman utility (ikeyman.bat or ikeyman.sh) located in the
 WAS_HOME\bin directory.2. From the Key Database File menu, select New.3. In the File Name field, type cacerts. Cacerts is the default name for the JRE
 certificates file.4. In the Location field, type WAS_HOME\java\jre\lib\security\.
 5. In the Password Prompt window, type the password for the keystore in thePassword and Confirm Password window. The default password is changeit.Click OK.
 The next task is to add the certificate you created for the LDAP server into thiscertificate store. Complete these steps:1. In the main window, in the Key database content area, select Signer
 Certificates from the drop-down list, and click Add.2. From the Data Type drop-down list, select Binary Der data.3. In the Certificate file name field, browse and locate the server certificate file
 that was created for the LDAP server. Verify that the appropriate directory isdisplayed in the Location field. Click OK.
 4. In the prompt that is displayed, type a label for this certificate. For example,type LDAPCA. Click OK.
 The certificate is added for the LDAP Server. You can now close the ikeymanutility.
 Configuring Tivoli Identity Manager to use SSL whencommunicating with the LDAP serverTo configure Tivoli Identity Manager to use SSL when communicating with theLDAP server, complete these steps:1. Edit the enRoleLDAPConnection.properties file in the ITIM_HOME\data
 directory, and make the following changes:a. Set the port value on the java.naming.provider.url property to the SSL port
 number configured on directory server [LDAP]. For example,java.naming.provider.url=ldaps://localhost:636
 b. Set the value of the java.naming.security.protocol property to ssl. Thissetting indicates to the Tivoli Identity Manager Server to use SSL tocommunicate to LDAP. Alternately you can change the protocol injava.naming.provider.url from ldap to ldaps. For example,java.naming.security.protocol=ssl
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2. Save the changes.
 Defining the truststore and password as a custom property onthe JVMTivoli Identity Manager Server does not use the WebSphere Application Server SSLConfiguration Repositories settings in the WebSphere Administrative ConsoleSecurity | SSL tab. Instead, you must configure the SSL settings using thefollowing menus to specify the javax properties. Complete these steps:1. Select Servers > Application Servers > server_name > Process Definition > Java
 Virtual Machine > Custom Properties > New.2. Define the name of the javax properties that you have changed using the
 ikeyman key management tool. In “Installing the self-signed certificate in theJSSE truststore” on page 128, you installed certificates into the truststore of theJVM used by WebSphere Application Server. Alternately you can create yourown certificate store location, for which you have to define some additionalproperties.
 The following table provides information about the javax properties you need todefine.
 Table 7. JSSE SSL truststore properties
 Property name Description Default value
 javax.net.ssl.trustStore File path of the truststore file. Youcan use the truststore to install CAcertificates and client certificates. Ifyou do not usejavax.net.ssl.keyStore to specify aclient certificate, you must use thistruststore.
 jre_install_dir\lib\security\cacerts
 Example: C:\ProgramFiles\WebSphere\AppServer\java\jre\lib\security\cacerts
 javax.net.ssl.trustStorePassword
 Password that protects thetruststore.
 changeit
 javax.net.ssl.trustStoreType
 Key database type. This propertyis required for truststore. Thevalue is specified when creating aself-signed certificate.
 None.
 javax.net.ssl.keyStore File path of the keystore file. Thekeystore contains the certificatethat is used by the Tivoli IdentityManager Server. The certificatemust be present either in thekeystore or the truststore if theapplication operating as an SSLserver (for example, anagent-based adapter) is set torequire client authentication. If thisproperty is not defined, thetruststore must contain thecertificate when clientauthentication is required.
 None. The truststore filepath is searched by default.
 javax.net.ssl.keyStorePassword
 Password that protects thekeystore.
 changeit
 Running ldapConfig and runConfig with SSL
 Note: If LDAP is configured to use SSL only, the ldapConfig utility does not workduring a new Tivoli Identity Manager installation. You will have to skip
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ldapConfig during installation and run it after performing the followingsteps, after the Tivoli Identity Manager installation has completed:
 1. Verify that enRoleLDAPConnections.properties, hasjava.naming.security.protocol set to ssl.
 2. Edit ITIM_HOME\bin\ldapConfig.lax and ITIM_HOME\bin\runConfig.lax andadd the following property. Please note that the following property is one line.:lax.nl.java.option.additional=-Djavax.net.ssl.trustStoreType=type_of_truststore-Djavax.net.ssl.trustStore=truststore_location -Djavax.net.ssl.trustStorePassword=truststore_password - Djava.ext.dirs=WAS_HOME\java\jre\lib\ext:WAS_HOME\plugins:WAS_HOME\lib:WAS_HOME\lib\ext
 Note: Skip this step if the CA certificate (which is required to verify theauthenticity of the authority that has issued an LDAP server certificate)is installed in the truststore of the JVM that is used byldapConfig/runConfig.
 Running the utilities that access the LDAP server with SSLTo successfully run the following utilities present in the ITIM_HOME\bin\platformdirectory:v addindexv addintegrityv config_remote_servicesv createLinksv ldapCleanv remove_service_profilesv loadDSMLSchemav serviceability
 you must perform these steps when SSL is configured:1. Verify that enRoleLDAPConnections.properties, has
 java.naming.security.protocol set to ssl.2. Open the utility file (for example, addindex.sh or addindex.cmd) with a text
 editor.3. Add the following properties as Java runtime properties (the following
 property is one line):-Djavax.net.ssl.trustStoreType=type_of_truststore -Djavax.net.ssl.trustStore=truststore_location -Djavax.net.ssl.trustStorePassword=truststore_password- Djava.ext.dirs=WAS_HOME\java\jre\lib\ext:WAS_HOME\plugins:WAS_HOME\lib:WAS_HOME\lib\ext
 For example, ldapClean.sh modified for SSL would look like this example:$JAVA -Djavax.net.ssl.trustStoreType=jks -Djavax.net.ssl.trustStore=/opt/ibm/cacerts -Djavax.net.ssl.trustStorePassword=changeit -Djava.ext.dirs=/opt/IBM/WebSphere61/AppServer/java/jre/lib/ext:/opt/IBM/WebSphere61/AppServer/plugins:/opt/IBM/WebSphere61/AppServer/lib:/opt/IBM/WebSphere61/AppServer/lib/ext -cp $CLASSPATHcom.ibm.itim.systemConfig.LdapSweeper
 4. Save the changes to the utility file.
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Configuring security for WebSphere Application ServerIf you chose to enable administrative security and application security on theWebSphere Application Server, additional security configuration might be required.Each of the following security tasks applies to both single and multi-nodedeployments. You can perform these additional security tasks:v Map the itimadmin administrative user to the ITIM_SYSTEM role to further
 limit access.v If the System User or EJB User are modified outside of Tivoli Identity Manager,
 run the runConfig command to update the Tivoli Identity Managerconfiguration.
 v If you also enabled Java 2 security, modify the library.policy file and verify thatthe was.policy file exists.
 v Modify the token expiration to prevent accidental timeouts in a clusterconfiguration.
 v Enable FIPS compliance for WebSphere Application Server.
 Mapping an administrative user to a roleYou can map an administrative user to a Tivoli Identity Manager role. The installertypically performs this mapping during the installation process. However this taskis required if you change the Tivoli Identity Manager EJB user ID after you installTivoli Identity Manager. Complete these steps:1. On the WebSphere administrative console, click Applications > Enterprise
 Applications.2. Click ITIM.3. In Detail Properties, scroll down and click Security role to user/group
 mapping.4. Select the check box for ITIM_SYSTEM.5. Click Lookup users.6. Click Search.7. Select the EJB User (For example, wasadmin) from the list.8. Click OK.9. To prevent unauthorized access, clear the Everyone? or All Authenticated?
 check boxes.10. Save the configuration changes.
 Updating the system user and the EJB userIf you changed the System User or to the EJB User fields, you must update TivoliIdentity Manager configurations with these new values. Complete these steps:1. Start the system configuration tool. To do so, enter the following command:v Windows
 ITIM_HOME\bin\runConfig
 v UNIXITIM_HOME/bin/runConfig.sh
 2. Select the Security tab.3. Update the System User field and its password with the wasadmin user ID
 that you created in the local OS registry.4. Update the EJB User field and its password with the itimadmin user ID that
 you created in the local operating system registry.
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5. Click OK.
 Enabling Java 2 security by creating and modifying policyfiles
 If you want to turn on Java 2 security, create the library.policy file and modify thewas.policy file to add permissions to access any necessary resources.
 Enabling Java 2 security for the Tivoli Identity Manager application also causesJava 2 security to be enforced on all applications that are running on theWebSphere Application Server. If you enable Java 2 security for the Tivoli IdentityManager application, you should also appropriately configure all other applicationsrunning on the WebSphere Application Server to support Java 2 security.
 Note: Ensure that you are using the IBM Java 2 Platform Standard EditionDevelopment Kit 1.5 Service Release 6 or later. Service Release 6 is needed ifyou intend to enable Java 2 security. You can download the service releaseand follow the instructions to apply the fix at the following WebSphereApplication Server fix pack Web site:
 http://www-1.ibm.com/support/docview.wss?rs=180&uid=swg24017492
 Creating the library.policy file to enable Java 2 securityCreate the library.policy file to add permissions to access any necessary resources.To grant all permissions, complete these steps:1. Create and edit the library.policy file in the following directory location:v WAS_PROFILE_HOME/config/cell/cellname/nodes/nodename
 2. Enter the following statement to the library.policy file:grant {permission java.security.AllPermission;}
 Note: This sample policy file provides blanket access to the Tivoli IdentityManager shared library but does not provide any extra security. Set thepolicy file according to your security requirements by configuring this filecorrectly.
 Ensuring that the was.policy file existsThe Tivoli Identity Manager installation program automatically creates a samplewas.policy policy file with all the permissions that the Tivoli Identity Managerapplication needs to run with Java 2 security enabled.
 Ensure that the was.policy file exists. If the file does not exist, create the file in thefollowing directory on the node:WAS_PROFILE_HOME/config/cells/cellname/applications/ITIM.ear/deployments/application_name/META-INF
 The file contents are like these lines:grant codeBase "file::${application}" {permission java.security.AllPermission;};
 Note: This sample policy file provides blanket access to Tivoli Identity Managerbut does not provide any extra security. Set the policy file according to yoursecurity requirements by configuring this file correctly.
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Running Java 2 security on single-node deploymentsTo run the Java 2 security component after installing and setting up Tivoli IdentityManager in a single-node deployment, use the WebSphere administrative consoleto restart Tivoli Identity Manager and log in when prompted. Complete thesesteps:1. Click Applications > Enterprise Applications.2. Select the check box for ITIM and click Stop. Wait for the Tivoli Identity
 Manager application to stop, then click Start.
 Running Java 2 security on multi-node deploymentsTo run the Java 2 security component after installing and setting up Tivoli IdentityManager on multi-node deployments, synchronize the nodes in the cell.
 Synchronizing the nodes in the cellSynchronize the deployment manager configuration with the nodes in the cell.Restart the Tivoli Identity Manager cluster. Restart Tivoli Identity Manager withthese steps:1. Click Server > Clusters.2. Select the check box next to the cluster name.3. Click Stop. Wait for the cluster to stop, and then click Start.
 Increasing the timeout intervalEnsure that the token expiration value is large enough to prevent accidentaltimeouts in a cluster configuration.
 Security uses a Lightweight Third Party Authentication (LTPA) token that expiresafter an interval of system inactivity. The default is 120 minutes, which might notbe large enough to use with Tivoli Identity Manager. On some systems, the actualtimeout interval might be shorter than the value that is specified. A timeout mightprevent you from logging on. When a timeout occurs, you must recycle thedeployment manager, the cluster, and all node agents.
 Complete these steps:1. Start the WebSphere administrative console.2. Click Security > Secure administration, applications, and infrastructure >
 Authentication mechanisms and expiration > Authentication expiration.3. Set the token expiration interval to a value that exceeds the longest anticipated
 interval of system inactivity at your site.
 Enabling FIPS compliance for WebSphere Application ServerFederal Information Processing Standards (FIPS) are guidelines that set bestpractices for software and hardware computer security products. Products thatsupport FIPS standards can be set into a mode where the product only uses FIPSapproved algorithms and methods. Security toolkits typically support both FIPSapproved and non-FIPS approved functions. In FIPS mode, the product isincapable of using any non-FIPS approved methods.
 To enable FIPS compliance for WebSphere Application Server, complete these steps:1. Add these IBM cryptographic providers as entries in the java.security
 cryptographic provider list, as shown in this example.security.provider.1=com.ibm.crypto.fips.provider.IBMJSSE2security.provider.2=com.ibm.crypto.fips.provider.IBMJCEFIPS
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The java.security file is located atWAS_HOME\java\jre\lib\security
 This step ensures that Java uses these cryptographic providers for allcryptographic functions.
 Note: The order in which you specify the security providers is important. Thesecurity providers are processed in numeric order. The first securityprovider that supports the encryption method being requested is used.On Solaris systems, the first provider must always besun.security.provider.Sun.
 2. Enable FIPS in WebSphere Application Server. To enable FIPS for WebSphereApplication Server, complete these steps:a. On the WebSphere administrative console, click Security > SSL certificate
 and key management.b. Select the check box next to Use the United States Federal Information
 Processing Standard (FIPS) algorithms
 c. Click Apply.d. Save the configuration changes.
 3. To set the environment variable to restrict the IBMJSSE2 provider toFIPS-compliant algorithms, complete these steps:a. On the WebSphere administrative console, click Servers > Application
 servers and click a server, such as server1.b. In the Server Infrastructure field, click the link for Java and Process
 Management > Process Definition
 c. In the Additional Properties field, click the link for Java Virtual Machine
 d. In the Generic JVM Arguments field, set the environment variable byadding the following statement:-Dcom.ibm.jsse2.JSSEFIPS=true
 For more information about enabling FIPS in WebSphere Application Server 6.1,see the documentation available at the following Web site:
 http://publib.boulder.ibm.com/infocenter/wasinfo/v6r1/topic/com.ibm.websphere.base.doc/info/aes/ae/tsec_fips.html
 Running the cipher migration toolA cipher migration utility, changeCipher, is provided to change cipher keys andtransition from non-compliant FIPS algorithms to FIPS-compliant algorithms andkeys. Using the new cipher key, the migration utility re-encrypts all data in theproperty files and in LDAP. The utility is found in the following location:v Windows: ITIM_HOME\bin\win\changeCipher.cmdv UNIX/Linux: ITIM_HOME/bin/unix/changeCipher.shv
 Run the utility once on a single server or at the deployment manager to migratethe data in the LDAP repository and in the property files. Also run the utility oneach managed node (in a clustered environment) to migrate the property files onthat node.
 The following example shows the supported usage and command-line parametersfor the changeCipher command:
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changekey {keystore_name} {keystore_password}[-algorithm AES] [-keysize 128 | 192 | 256][-skiperrors]
 resume [-skiperrors]
 For example, to migrate cipher settings from PBEWithMD5AndDES to AES, runthe following command:changeCipher changekey itimKeystore2.jceks sunshine
 This command performs the following tasks:v Generates a 128-bit AES key and writes it to the specified keystorev Migrates encrypted data in the LDAP repository to the new cipher
 Note: The new encrypted data is longer in length. If the attribute length inLDAP is too small you get an Object Class violation and the script ends.
 v Migrates the encrypted data in the property files to the new cipherv Sets the new cipher settings to enrole.properties
 While running, the tool creates and maintain a file which contains its current stateinformation. This file is written to ITIM_HOME\temp\CipherMigrator.properties.If an error occurs during migration (for instance, if the LDAP server goes down),correct the problem and invoke the tool with the resume parameter. This parametertells the utility to pick up from where it left off before the error occurred.
 The optional –skiperrors parameter tells the tool to continue running even if itencounters data that cannot be decrypted with the old cipher. If specified,undecipherable LDAP data does not cause the tool to fail.
 Back up all LDAP data before running the tool. There are a number of things thatcan go wrong when migrating LDAP data. For example, if the keystore file isaccidentally deleted before the LDAP migration is completed, some of theencrypted LDAP data becomes inaccessible. Backing up LDAP data along with thecurrent keystore ensures you can return to a safe state.
 Before running the tool, stop the Tivoli Identity Manager Server and ensure thatthere are no pending transactions in the database because encrypted data in thedatabase is not migrated.
 For each LDAP object it finds, the cipher migration utility decrypts the attributeusing the old cipher and re-encrypts the attribute using the new cipher. Nochanges are made to attributes that are hashed.
 By default, the Java Cryptography Extension (JCE) is shipped with restricted orlimited strength ciphers. To use 192-bit and 256-bit Advanced Encryption Standard(AES) encryption algorithms, you must apply unlimited jurisdiction policy files.For more information, please see the following Web site:
 http://www.ibm.com/developerworks/java/jdk/security/index.html
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Appendix C. Installation images and fix packs
 This section itemizes the installation images, and provides information on productfix packs.
 Installation imagesRefer to the Tivoli Identity Manager Quick Start Guide for the download location ofthe installation images that Tivoli Identity Manager provides. For more informationabout all supported platforms and their prerequisite applications, refer to the TivoliIdentity Manager Information Center.
 Setting the SOAP timeout interval before installing fix packsTo avoid timeout exception errors during fix pack installation, before every fixpack installation set the SOAP timeout interval to at least 15 minutes (900 seconds).Complete these steps:1. Edit the soap.client.props file located in the WAS_HOME\profiles\profile_name\
 properties directory.2. Set the com.ibm.SOAP.requestTimeout property to 900. For example,
 com.ibm.SOAP.requestTimeout=900
 3. Save the changes to the file.
 Obtaining fix packsA fix pack file for Tivoli Identity Manager has a name like the following example:5.1.0-TIV-TIM-FP000n.pak
 where n is an integer such as 1.
 Tivoli Identity Manager fixes and information about fix pack installation areavailable at this Web site:
 http://www-306.ibm.com/software/sysmgmt/products/support/IBMTivoliIdentityManager.html
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Appendix D. Worksheets
 Before you begin to install and configure Tivoli Identity Manager, you can fill outthese worksheets to identify the configuration parameters needed to complete theTivoli Identity Manager installation.
 The value of path varies for these operating systems.
 For Windows, the default path is drive:\Program Files.
 For UNIX/Linux, the default path is /opt
 Table 8. Tivoli Identity Manager typical database configuration parameters
 Field name DescriptionDefault or examplevalue Your value
 Host name Name of the computer thathosts the database.
 Port number Database service listeningport.
 Examples: 50000,50002, or 60000
 Database name Name of the Tivoli IdentityManager database.
 Example: itimdb
 Admin ID Database administrator userID.
 Example: db2adminNote: If you do notuse the middlewareconfiguration utility,this value is dasusr1by default on UNIXsystems.
 Admin password Password for the databaseadministrator user ID.
 Database user ID The account that TivoliIdentity Manager uses tolog in to the database.
 Example: itimuser
 Database password The password for theitimuser user ID.
 Table 9. Tivoli Identity Manager typical directory server configuration parameters
 Field name DescriptionDefault or examplevalue Your value
 Principal DN The user ID that representsthe principal distinguishedname.
 Example: cn=root
 Password The password of the userID that represents theprincipal distinguishedname.
 Host name The host name of thedirectory server
 Port Directory server listeningport.
 Example: 389
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Table 9. Tivoli Identity Manager typical directory server configurationparameters (continued)
 Field name DescriptionDefault or examplevalue Your value
 Number of hashbuckets
 The number of hashbuckets.
 1
 Name of yourorganization
 The name of theorganization.
 Example: MyOrganization
 Default org shortname
 The short name of theorganization.
 Example: myorg
 Identity Manager DNlocation
 The Tivoli Identity Managersuffix.
 Example: dc=com
 Table 10. Tivoli Identity Manager typical pre-installation configuration parameters
 Field name DescriptionDefault or examplevalue Your value
 ITIM_HOME The installation directory forthe Tivoli Identity ManagerServer.
 Windows:
 path\IBM\itim
 UNIX/Linux:
 path/IBM/itim
 WAS_HOME The installation directory forWebSphere ApplicationServer.
 Windows:
 path\IBM\WebSphere\AppServer
 UNIX/Linux:
 path/IBM/WebSphere/AppServer
 WebSphereApplication Serverprofile name
 The name of the WebSphereApplication Server profile.
 v Single-server:AppSrv01
 v Deploymentmanager: Dmgr01
 v Cluster member:Custom01
 WebSphereApplication Serverserver name
 The name of the WebSphereApplication Server server.
 Example: server1
 Computer host name The host name of thecomputer.
 WebSphereApplication Serveradministrator userID
 User name that is used toadminister WebSphereApplication Server. Used torestart secure WebSphereApplication Servers. Thisfield is optional.
 Example: wsadmin
 WebSphereApplication Serveradministratorpassword
 Password that is used withthe WebSphere user name.This field is optional.
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Table 10. Tivoli Identity Manager typical pre-installation configurationparameters (continued)
 Field name DescriptionDefault or examplevalue Your value
 Keystore password Used to unlock the TivoliIdentity Manager keystorefile which stores theencryption key used toencrypt Tivoli IdentityManager sensitive data.
 ITDI_HOME The directory that containsthe IBM Tivoli DirectoryIntegrator Server code. Also,where adapters are installed.This field is optionaldepending on whether youare using IBM TivoliDirectory Integrator.
 Windows:
 path\IBM\TDI\V6.1.1
 path\IBM\TDI\V7.0
 UNIX/Linux:
 path/IBM/TDI/V6.1.1
 path/IBM/TDI/V7.0
 TIVOLI_COMMON_DIRECTORY
 The central location for allserviceability-related files,such as logs and first-failurecapture data.
 Windows:
 path\IBM\tivoli\common
 UNIX/Linux:
 path/IBM/tivoli/common
 Table 11. Tivoli Identity Manager typical system configuration parameters
 Field name DescriptionDefault or examplevalue Your value
 Heart beat (seconds) Defines how frequently ascheduling thread queriesthe scheduled messagestores for events to process.
 30
 Recycle bin age limit(days)
 Specifies the number of daysthat an object remains in therecycle bin of the systembefore it becomes availablefor deletion by cleanupscripts.
 62
 Maximum pool size Specifies the maximumnumber of connections thatthe LDAP Connection Poolcan have at any time.
 100
 Initial pool size Specifies the initial numberof connections to be createdfor the LDAP ConnectionPool.
 50
 Increment count Specifies the number ofconnections to be added tothe LDAP Connection Poolevery time a connection isrequested after allconnections are in use.
 3
 Database pool initialcapacity
 Specifies the initial numberof JDBC connections.
 5
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Table 11. Tivoli Identity Manager typical system configuration parameters (continued)
 Field name DescriptionDefault or examplevalue Your value
 Database poolmaximum capacity
 Specifies the maximumnumber of JDBC connectionsthat the Tivoli IdentityManager Server can open tothe database at any onetime.
 50
 Logging trace level Specifies the amount ofinformation written to thelog file.
 MIN
 Identity ManagerBase Server URL
 Specifies the published loginUniversal Resource Locator(URL) for the Tivoli IdentityManager Server. This is thefirst part of a URL that issent to the recipient of mailmessages at run time.
 Examples:
 http://hostname:9080/itim/console
 Mail from Specifies the Tivoli IdentityManager systemadministrator e-mail addressfor your site.
 Example:[email protected]
 Mail server name Specifies the SMTP mail hostthat sends mail notificationand functions as the mailgateway.
 Example:smtp.mysite.com
 Customer logo Specifies the path and filename of the logo graphic.
 ibm_banner.gif
 Customer logo link Specifies an optional URLlink activated by clicking thelogo image.
 www.ibm.com
 List page size Specifies how many itemsthat require a search in thedirectory are displayed onlists throughout the userinterface.
 50
 Encryption Option to encrypt thepasswords used for databaseand directory serverconnections and thepassword of the EJB userthat is used for EJBauthentication.
 True (On)
 System user Specifies the system userand the system userpassword.
 System userpassword
 Specifies the system userpassword.
 EJB user Specifies the EJB user ID.
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Table 11. Tivoli Identity Manager typical system configuration parameters (continued)
 Field name DescriptionDefault or examplevalue Your value
 EJB user password Specifies the EJB userpassword.Note: The EJB userpassword is restricted to 12characters.
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Appendix E. Notices
 This information was developed for products and services offered in the U.S.A.IBM may not offer the products, services, or features discussed in this document inother countries. Consult your local IBM representative for information on theproducts and services currently available in your area. Any reference to an IBMproduct, program, or service is not intended to state or imply that only that IBMproduct, program, or service may be used. Any functionally equivalent product,program, or service that does not infringe any IBM intellectual property right maybe used instead. However, it is the user’s responsibility to evaluate and verify theoperation of any non-IBM product, program, or service.
 IBM may have patents or pending patent applications covering subject matterdescribed in this document. The furnishing of this document does not give youany license to these patents. You can send license inquiries, in writing, to:
 IBM Director of LicensingIBM CorporationNorth Castle DriveArmonk, NY 10504-1785U.S.A.
 For license inquiries regarding double-byte (DBCS) information, contact the IBMIntellectual Property Department in your country or send inquiries, in writing, to:
 IBM World Trade Asia CorporationLicensing2-31 Roppongi 3-chome, Minato-kuTokyo 106-0032, Japan
 The following paragraph does not apply to the United Kingdom or any othercountry where such provisions are inconsistent with local law:INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THISPUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHEREXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESSFOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express orimplied warranties in certain transactions, therefore, this statement may not applyto you.
 This information could include technical inaccuracies or typographical errors.Changes are periodically made to the information herein; these changes will beincorporated in new editions of the publication. IBM may make improvementsand/or changes in the product(s) and/or the program(s) described in thispublication at any time without notice.
 Any references in this information to non-IBM Web sites are provided forconvenience only and do not in any manner serve as an endorsement of those Websites. The materials at those Web sites are not part of the materials for this IBMproduct and use of those Web sites is at your own risk.
 IBM may use or distribute any of the information you supply in any way itbelieves appropriate without incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purposeof enabling: (i) the exchange of information between independently createdprograms and other programs (including this one) and (ii) the mutual use of theinformation which has been exchanged should contact:
 IBM Corporation2ZA4/10111400 Burnet RoadAustin, TX 78758U.S.A.
 Such information may be available, subject to appropriate terms and conditions,including in some cases, payment of a fee.
 The licensed program described in this information and all licensed materialavailable for it are provided by IBM under terms of the IBM Customer Agreement,IBM International Program License Agreement, or any equivalent agreementbetween us.
 Any performance data contained herein was determined in a controlledenvironment. Therefore, the results obtained in other operating environments mayvary significantly. Some measurements may have been made on development-levelsystems and there is no guarantee that these measurements will be the same ongenerally available systems. Furthermore, some measurements may have beenestimated through extrapolation. Actual results may vary. Users of this documentshould verify the applicable data for their specific environment.
 Information concerning non-IBM products was obtained from the suppliers ofthose products, their published announcements or other publicly available sources.IBM has not tested those products and cannot confirm the accuracy ofperformance, compatibility or any other claims related to non-IBM products.Questions on the capabilities of non-IBM products should be addressed to thesuppliers of those products.
 TrademarksIBM, the IBM logo, and ibm.com are trademarks or registered trademarks ofInternational Business Machines Corporation in the United States, other countries,or both. If these and other IBM trademarked terms are marked on their firstoccurrence in this information with a trademark symbol (® or ™), these symbolsindicate U.S. registered or common law trademarks owned by IBM at the time thisinformation was published. Such trademarks may also be registered or commonlaw trademarks in other countries. A current list of IBM trademarks is available onthe Web at ″Copyright and trademark information″ at http://www.ibm.com/legal/copytrade.shtml.
 The following terms are trademarks or registered trademarks of InternationalBusiness Machines Corporation in the United States, other countries, or both: IBM,IBM logo, AIX, DB2, Domino, Lotus, SecureWay, Tivoli, Tivoli logo, UniversalDatabase, WebSphere.
 Adobe, Acrobat, Portable Document Format (PDF), and PostScript are eitherregistered trademarks or trademarks of Adobe Systems Incorporated in the UnitedStates, other countries, or both.
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Cell Broadband Engine and Cell/B.E. are trademarks of Sony ComputerEntertainment, Inc., in the United States, other countries, or both and is used underlicense therefrom.
 Microsoft, Windows, Windows NT, and the Windows logo are trademarks ofMicrosoft Corporation in the United States, other countries, or both.
 Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks orregistered trademarks of Intel Corporation or its subsidiaries in the United Statesand other countries.
 UNIX is a registered trademark of The Open Group in the United States and othercountries.
 Linux is a registered trademark of Linus Torvalds in the United States, othercountries, or both.
 ITIL is a registered trademark, and a registered community trademark of the Officeof Government Commerce, and is registered in the U.S. Patent and TrademarkOffice
 IT Infrastructure Library is a registered trademark of the Central Computer andTelecommunications Agency which is now part of the Office of GovernmentCommerce.
 Java and all Java-based trademarks are trademarks of SunMicrosystems, Inc. in the United States, other countries, orboth.
 Other company, product, or service names may be trademarks or service marks ofothers.
 Appendix E. Notices 147

Page 164
                        

148 IBM Tivoli Identity Manager Server: Installation and Configuration Guide

Page 165
                        

Glossary
 Aaccess. (1) The ability to read, update, delete, orotherwise use a resource. Access to protected resourcesis usually controlled by system software. (2) The abilityto use data that is stored and protected on a computersystem.
 access control. In computer security, the process ofensuring that users can access only those resources of acomputer system for which they are authorized.
 access control list. In computer security, a list that isassociated with a resource that identifies all theprincipals that can access the resource and thepermissions for those principals. See also permissionand principal.
 access control item (ACI). Data that (a) identifies thepermissions of principals and (b) is assigned to aresource.
 account. An entity that contains a set of parametersthat define the application-specific attributes of aprincipal, which include the identity, user profile, andcredentials.
 ACI target. The resource for which you define theaccess control items. For example, an ACI target can bea service.
 activity. In a workflow, the smallest unit of work.When a request requires approval, information, oradditional actions, the workflow for that requestgenerates the appropriate activities that are presentedin the appropriate users’ to-do lists. See also workflow.
 adapter. (1) A set of software components thatcommunicate with an integration broker and withapplications or technologies in order to perform tasks,such as executing application logic or exchanging data.(2) A transparent, intermediary software componentthat allows different software components withdifferent interfaces to work together.
 administrative domain. A logical collection ofresources that is used to separate responsibilities andmanage permissions. See also permission.
 adopt. To assign an orphan account to the appropriateowner. See also orphan account.
 adoption rules. The set of rules that determine whichorphan accounts belong to which owners. See alsoorphan account.
 agent. A process that manages target resources onbehalf of a system such that the system can respond torequests.
 aggregate message. A collection of notificationmessages that are combined into a single e-mail, alongwith optional user defined text.
 alias. In identity management, an identity for a user,which might match the user ID. The alias can be usedduring reconciliation to determine who owns theaccount. A person can have several aliases, for example,GSmith, GWSmith, and SmithG.
 application server. A server program in a distributednetwork that provides the execution environment foran application program.
 application user administrator. A type of person whouses Tivoli Identity Manager to set up and administer(a) the services that are managed by Tivoli IdentityManager or (b) the Tivoli Identity Manager users ofthose services.
 approval. A type of workflow activity that allowssomeone to approve or reject a request. See alsoworkflow.
 audit trail. A chronological record of events ortransactions. You can use audit trails for examining orreconstructing a sequence of events or transactions,managing security, and for recovering lost transactions.
 authentication. The process of verifying that an entityis the entity that it claims to be, often by verifying auser ID and password combination. Authenticationdoes not identify the permissions that a person has inthe system. See also authorization.
 authorization. The process of granting a user, system,or process either complete or restricted access to anobject, resource, or function. See also authentication.
 authorization owner. A user who can manage accesscontrol items (ACIs) for a resource.
 Ccertificate. In computer security, a digital documentthat binds a public key to the identity of the certificateowner, thereby enabling the certificate owner to beauthenticated. A certificate is issued by a certificateauthority and is digitally signed by that authority. Seealso certificate authority.
 Certificate Authority (CA). An organization thatissues certificates. The CA authenticates the certificate
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owner’s identity and the services that the owner isauthorized to use, issues new certificates, renewsexisting certificates, and revokes certificates that belongto users who are no longer authorized to use them.
 challenge-response authentication. An authenticationmethod that requires users to respond to a prompt byproviding information to verify their identity whenthey log in to the system. For example, when usersforget their password, they are prompted (challenged)with a question to which they must provide an answer(response) in order to either receive a new password orreceive a hint for specifying the correct password.
 comma separated values (CSV) file. See CSV file.
 Common Criteria. A standardized method, which isused by international governments, the United Statesfederal government, and other organizations, forexpressing security requirements in order to assess thesecurity and assurance of technology products.
 connector. A plug-in that is used to access and updatedata sources. A connector accesses the data andseparates out the details of data manipulations andrelationships. See also adapter.
 credentials. Authentication information that isassociated with a principal. See also authentication andprincipal.
 CSV file. A common type of file that contains datathat is separated by commas.
 DDAML. See Directory Access Markup Language.
 data model. A description of the organization of datain a manner that reflects the information structure of anenterprise.
 data warehouse. (1) A subject-oriented collection ofdata that is used to support strategic decision making.(2) A central repository for all or significant parts of thedata that an organization’s business systems collect.
 delegate (noun). The user who is designated toapprove requests or provide information for requestsfor another user.
 delegate (verb). (1) To assign all or a subset ofadministrator privileges to a user, such that the usercan perform all or a subset of administrator activitiesfor a specific set of users. (2) To designate a user toapprove requests or provide information for requestsfor another user.
 delegate administrator. The user who has all or asubset of administrator privileges over a specific set ofusers.
 delegate administration. The ability to apply all or asubset of administrator privileges to another user (thedelegate administrator), such that the user can performall or a subset of administrator activities for a specificset of the users.
 deprovision. To remove a service or component. Forexample, to deprovision an account means to delete anaccount from a resource. See also provision.
 digital certificate. An electronic document that is usedto identify an individual, server, company, or someother entity, and to associate a public key with theentity. A digital certificate is issued by a certificationauthority and is digitally signed by that authority. Seealso Certificate Authority.
 Directory Access Markup Language (DAML). AnXML specification that extends the functions ofDirectory Services Markup Language (DSML) 1.0 inorder to represent directory operations. In TivoliIdentity Manager, DAML is mainly used for server toagent communications. See also Directory ServicesMarkup Language v2.0.
 directory server. A server that can add, delete, change,or search directory information on behalf of a client.
 Directory Services Markup Language v1.0 (DSMLv1).An XML implementation that describes the structure ofdata in a directory and the state of the directory. DSMLcan be used to locate data into a directory. DSMLv1 isan open standard defined by OASIS. See alsoDirectoryServices Markup Language v2.0.
 Directory Services Markup Language v2.0 (DSMLv2).An XML implementation that describes the operationsthat a directory can perform (such as how to create,modify, and delete data) as well as the results of thoseoperations. Whereas DSMLv1 can be used to describethe structure of data in a directory, DSMLv2 can beused to communicate with other products about thatdata. DSMLv2 is an open standard defined by OASIS.See also Directory Services Markup Language v1.0.
 distinguished name (DN and dn). The name thatuniquely identifies an entry in a directory. Adistinguished name is made up of name-componentpairs. For example:
 cn=John Doe,o=My Organization,c=US
 domain administrator. The owner of anadministrative domain. See also administrative domain.
 dynamic content tags. A set of XML tags (based onthe XML Text Template Language (XTTL) schema) thatenables the administrator to provide customizedinformation in a message, notification, or report. Seealso XML Text Template Language.
 dynamic organizational role. An organizational rolethat is assigned to a person by using an LDAP filter.When a user is added to the system and the LDAP
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filter parameters are met, the user is automaticallyadded to the dynamic organizational role. See alsoorganizational role.
 Eentitlement. In security management, a data structure,service, or list of attributes that contains externalizedsecurity policy information.
 entitlement workflow. A workflow that defines thebusiness logic that is used when provisioning a policy.For example, an entitlement workflow is used to defineapprovals for managing accounts. See also workflow.
 entity. An object about which you want to storeinformation or manage. For example, a person and anaccount are both entities.
 entity type. Categories of managed objects. See alsoentity.
 escalation. The process that defines what happens andwho acts when an activity was not completed in thespecified amount of time.
 escalation limit. The amount of time, for example,hours or days, that a participant has to respond to arequest, before an escalation occurs. See also escalation.
 event. The encapsulated data that is sent as a result ofan occurrence, or situation, in the system.
 Ffailover. An automatic operation that switches to aredundant or standby system in the event of asoftware, hardware, or network interruption.
 FESI. See Free EcmaScript Interpreeter.
 FESI extension. A Java extension that can be used toenhance JavaScript code and then be embedded withina FESI script.
 Free EcmaScript Interpreter (FESI). Animplementation of the EcmaScript scripting language,which is an ISO standard scripting language that issimilar to the JavaScript scripting language.
 Ggroup. A collection of Tivoli Identity Manager users.
 Hhelp desk assistant. A person who uses Tivoli IdentityManager to assist users and managers with managingtheir accounts and passwords.
 Iidentity. The subset of profile data that uniquelyrepresents a person or entity and that is stored in oneor more repositories.
 identity feed. The automated process of creating oneor more identities from one or more common sourcesof identity data.
 identity policy. The policy that defines the user ID tobe used when creating an account for a user.
 IIOP (Internet Inter-ORB Protocol). A protocol usedfor communication between Common Object RequestBroker Architecture (CORBA) object request brokers
 ITIM group. A list of Tivoli Identity Manageraccounts. Membership within an ITIM groupdetermines the access to data within Tivoli IdentityManager.
 ITIM user. A user who has a Tivoli Identity Manageraccount.
 JJava Database Connectivity. See JDBC.
 JDBC (Java Database Connectivity). An industrystandard for database-independent connectivitybetween the Java platform and a wide range ofdatabases. The JDBC interface provides a call-level APIfor SQL-based and XQuery-based database access.
 join directive. The set of rules that define how tohandle attributes when two or more provisioningpolicies are applied. Two or more policies might haveoverlapping scope, so the join directive specifies whatactions to take when this overlap occurs.
 LLDAP (Lightweight Directory Access Protocol). Anopen protocol that uses TCP/IP to provide access todirectories that support an X.500 model and that doesnot incur the resource requirements of the morecomplex X.500 Directory Access Protocol (DAP). Forexample, LDAP can be used to locate people,organizations, and other resources in an Internet orintranet directory.
 LDAP Data Interchange Format. See LDIF.
 LDAP directory. A type of repository that storesinformation on people, organizations, and otherresources and that is accessed using the LDAP protocol.The entries in the repository are organized into ahierawrchical structure, and in some cases thehierarchical structure reflects the structure orgeography of an organization.
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LDAP filter. A search filter that narrows the resultsfrom an LDAP search.
 LDIF (LDAP Data Interchange Format). A file formatthat is used to describe directory information as well aschanges that need to be applied to a directory, suchthat directory information can be exchanged betweendirectory servers that are using LDAP.
 life cycle. Passage or transformation through differentstages over time. For example markets, brands andofferings have life cycles.
 life cycle rules. A set of rules in a policy thatdetermine which operations to use when automaticallyhandling commonly occurring events, such assuspending an account that has been inactive for aperiod of time.
 Lightweight Directory Access Protocol. See LDAP.
 location. An entity that is a subdivision of anorganization, usually based on geographical area.
 Mmail. A type of workflow activity that sends anotification to one or more users about a request.
 managed resource. An entity that exists in the runtimeenvironment of an IT system and that can be managed.
 manager. A type of person who uses Tivoli IdentityManager to manage their own accounts and passwordsor the accounts and passwords of those people thatthey supervise.
 manual service. A type of service that requiresmanual intervention by the service owner to completethe provisioning request.
 Nnamespace. (1) The set of unique names that a servicerecognizes. (2) Space reserved by a file system tocontain the names of its objects.
 nested group. A group that is contained withinanother group. See also group.
 notification. A message that is sent to users orsystems that indicates that a change was made thatmight be of interest to the receiver.
 Oobject class. (1) The specific type of object, orsubcategory of classes, that an access control item canprotect. For example, if the protection category isaccount, then the object class can be the type ofaccount, such as an LDAP user account. See also
 protection category. (2) An entity that defines theschema for a service or an account.
 operation. A specific action (such as add, multiply, orshift) that the computer performs when requested.
 operational workflow. A workflow that defines thelifecycle process for accounts, persons, and otherentities. See also workflow.
 organization. A hierarchical arrangement oforganizational units, such that each user is includedonce and only once. See also organizational unit.
 organization tree. A hierarchical structure of anorganization that provides a logical place to create,access, and store organizational information.
 organizational container. An organization,organizational unit, location, business partner unit, oradministration domain.
 organizational role. In identity management, a list ofaccount owners that is used to determine whichentitlements are provisioned to them. See also dynamicorganizational role and static organizational role.
 organizational unit. A type of organizationalcontainer that represents a department or similargrouping of people.
 orphan account. On a managed resource, an accountwhose owner cannot be automatically determined bythe provisioning system.
 Pparticipant. In identity management, an individual, arole, a group, or a JavaScript script that has theauthority to respond to a request that is part of aworkflow. See also workflow.
 password. In computer and network security, aspecific string of characters that is used by a program,computer operator, or user to access the system and theinformation stored within it.
 password retrieval. In identity management, themethod of retrieving a new or changed password byaccessing a designated Web site and specifying ashared secret. See also shared secret.
 password strength rules. The set of rules that apassword must conform to, such as the length of thepassword and the type of characters that are allowed(or not allowed) in the password.
 password policy. A policy that defines the passwordstrength rules. A password strength policy is appliedwhenever a password is set or modified. See alsopassword strength rules.
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password synchronization. The process ofcoordinating passwords across services and systemssuch that only a single password is needed to accessthose multiple services and systems.
 permission. Authorization to perform activities, suchas reading and writing local files, creating networkconnections, and loading native code.
 person. An individual in the system that has a personrecord in one or more corporate directories.
 personal profile. The data that describes a user withinthe system, such as the user name, password, contactinformation, and so on.
 plug-in. A software module that adds function to anexisting program or application.
 policy. A set of considerations that influence thebehavior of a managed resource or a user.
 post office. A component that collects notificationsfrom the appropriate workflow activities anddistributes those notifications to the appropriateworkflow participants.
 principal. (1) A person or group that has been grantedpermissions. (2) An entity that can communicatesecurely with another entity.
 privilege. See permission.
 profile. Data that describes the characteristics of auser, group, resource, program, device, or remotelocation.
 protection category. The category of classes that anaccess control item can protect. For example, accountsor persons. See also object class.
 provision. (1) In identity management, to set up andmaintain the access of a user to a system. (2) In identitymanagement, to create an account on a managedresource.
 provisioning. In identity management, the process ofproviding, deploying, and tracking a service orcomponent.
 provisioning policy. A policy that defines the accessto various managed resources, such as applications oroperating systems. Access is granted to all users, userswith a specific role, or users who are not members of aspecific role.
 Rrecertification. The process of validating and possiblyupdating your credentials with a system, usually after aspecified time interval.
 recertification policy. A policy that defines the lifecycle rule for automatically validating accounts andusers in the provisioning system after a certain periodof time. See also life cycle rules.
 reconciliation. The process of synchronizing data in acentral data repository with data on a managedresource.
 registration. The process of accessing a system andrequesting an account on that system.
 registry. A repository that contains access andconfiguration information for users, systems, andsoftware.
 relationship. A defined association between two ormore data entities, which is used when defining a FreeEcmaScript Interpreter (FESI) extension or whencustomizing the graphical user interface.
 relevant data. The data that is used to complete aworkflow activity in a workflow operation at runtime.See also workflow.
 repository. A persistent storage area for data andother application resources. Common types ofrepositories are databases, directories, and file systems.
 request. The item that initiates a workflow andinstigates the various activities of a workflow. See alsoworkflow.
 request for information (RFI). A workflow activitythat requests additional information from the specifiedparticipant. See also workflow.
 resource. A hardware, software, or data entity. Seealso managed resource.
 restore. To activate an account that was suspended.
 rights. See permission.
 rule. A set of conditional statements that enablecomputer systems to identify relationships and executeautomated responses accordingly.
 Sschema. The fields and rules in a repository thatcomprise a profile. See also profile.
 scope. In identity management, the set of entities thata policy or an access control item (ACI) can affect.
 Secure Sockets Layer (SSL). A security protocol thatprovides communication privacy. With SSL,client/server applications can communicate in a waythat is designed to prevent eavesdropping, tampering,and message forgery.
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security. The protection of data, system operations,and devices from accidental or intentional ruin,damage, or exposure.
 security administrator. A type of person who sets upand administers Tivoli Identity Manager for users,managers, help desk assistants, and application useradministrators.
 self-registration. See registration.
 service. A representation of a managed resource,application, database, or system.
 service owner. An individual who uses Tivoli IdentityManager to set up and administer the accounts on theservices that are managed by Tivoli Identity Manager.See also service.
 service selection policy. A policy that determineswhich service to use in a provisioning policy. See alsoprovisioning policy.
 service type. A category of related services that sharethe same schemas. See also service.
 shared secret. An encrypted value that is used toretrieve the initial password of a user. This value isdefined when the personal information for the user isinitially loaded into the system.
 single sign-on (SSO). The ability of a user to log ononce and access multiple applications without havingto log on to each application separately.
 static organizational role. An organizational role thatis manually assigned to a person. See alsoorganizational role.
 supervisor. A role that identifies the person whosupervises another set of users and who is oftenresponsible for approving or rejecting requests that aremade by those users.
 suspend. To deactivate an account so that the accountowner cannot access the service.
 system administrator. An individual who isresponsible for the configuration, administration, andmaintenance of Tivoli Identity Manager.
 Ttenant. In a hosted service environment, a virtualenterprise instance of an application. Each tenant canshare directory servers or relational databases whileremaining completely separate service instances.
 to-do list. A collection of outstanding activities. Seealso activity.
 topic. The subject of a notification message, whichallows messages to be grouped together based on thesame task.
 transition. A connection between two workflowelements. See also workflow.
 Uuniversally unique identifier (UUID). The 128–bitnumerical identifier that is used to ensure that twoentities do not have the same identifier. The identifier isunique for all space and time.
 user. (1) Any individual, organization, process, device,program, protocol, or system that uses the services of acomputing system. (2) The individual who uses TivoliIdentity Manager to manage their accounts andpasswords.
 Vview. A collection of various graphical user interfacesfor a product that represent the set of tasks that aparticular type of user is allowed to perform.Administrators can customize views to contain differentcollections of graphical user interfaces.
 Wworkflow. The sequence of activities performed inaccordance with the business processes of an enterprise.See also activity.
 work order. A workflow activity that requires aparticipant to perform an activity outside of the scopeof the system. See also workflow.
 XXML Text Template Language (XTTL). An XMLschema that provides a means for representing dynamiccontent within a message, notification, or report. TheXML tags are also called dynamic content tags. See alsodynamic content tags.
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